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This System overview provides general information about the GeoExplorer 3 data collection 
system, its components, and accessories. System overview is divided into two sections. 
Introduction explains how to use the GeoExplorer 3 and provides an overview of what you can do 
with it. Components and Accessories explains the parts and software that you use with the
GeoExplorer 3 data collection system.

• Introduction

• Components and accessories
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This section introduces you to the GeoExplorer 3 data collection
include:

• What is the GeoExplorer 3 data collection system?

• What can you do with the GeoExplorer 3 data collection 

• GeoExplorer 3c edition

• Using the GeoExplorer 3 data collection system



 3 data 

 receiver and datalogger for 
e used with a real-time source of 
also works with the GPS 
data dictionary creation, data 

 rover receiver or as a base 
rier phase measurements. Using 
ystem status and satellite 

the field. It has an internal 
l GPS receiver. An external 
eoExplorer 3 inside a vehicle.
GeoExplorer 3 Operation Guide System overview
Introduction

What is the GeoExplorer
collection system?
The GeoExplorer 3 data collection system is an integrated GPS
mapping, relocating, and updating GIS and spatial data. It can b
differential corrections such as Trimble’s Beacon-on-a-BeltTM. It 
Pathfinder® Office software for mission planning, data transfer, 
import/export, and postprocessing.

You can operate the GeoExplorer 3 data collection system as a
station. You can also collect high-precision data using GPS car
the intuitive user interface you can navigate, collect data, view s
availability, and control the GPS receiver.

The GeoExplorer 3 datalogger is designed for handheld use in 
antenna and power source, and a high-performance 12-channe
antenna is available as an optional accessory when using the G
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What can you do with the
GeoExplorer 3 data colle
system?
The primary functions of the GeoExplorer 3 data collection syst
data, using and updating existing GIS data, and navigating in th

Use the GeoExplorer 3 to accurately and efficiently collect the a
geographic points, lines, and areas. This information is stored in
can transfer to Trimble’s Pathfinder Office software for postpro
then be exported into a wide range of GIS-compatible formats.

Use the GeoExplorer 3 to update data from an existing GIS or C
review, edit, and update the GPS positions and attributes for fea

Use one of three methods of navigation—a road view, compass
locations. You can use real-time differential GPS to optimize n
differential accuracy.

It is easy to create or edit data dictionaries and setup configurat
Pathfinder Office software. Alternatively, use the GeoExplorer 3
or edit data dictionaries. 
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The GeoExplorer 3 data collection system provides two maps fo

• use Chart to create waypoints and to navigate to features an

• the Map to view and update features

For greater precision, use real-time DGPS to differentially corre
the field. The GeoExplorer 3 data collection system is compatib
(BoB) receiver to provide real-time DGPS, as well as other DGP
positions with even greater accuracy using the Pathfinder Office
data for points, lines, and areas.

You can operate the GeoExplorer 3 data collection system as a
situations where it is impossible or impractical to set up a perma

Applications for the GeoExplorer 3 include forestry mapping, en
management, disaster assessment, utility inventories, and urba
example, a power company could build an asset register of all i
positions, their condition and structure, and any attached hardw
then use the GeoExplorer 3 navigation functions to locate poles
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GeoExplorer 3c edition
This manual describes the GeoExplorer 3 data collection system

If you have purchased the GeoExplorer 3c data collection syste
functionality is not available with your system:

• Map or Chart tabs

• Cable-free communication with the BoB receiver

• Trimble .SSF data file upload

• Uploaded coordinate systems from Pathfinder Office

You can upgrade your GeoExplorer 3c edition to the full GeoExp
do this, contact your local Trimble dealer.
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Using the GeoExplorer 3
collection system
The GeoExplorer 3 software is arranged in three ‘sections’. The

To move to a section press the corresponding section key on th
example, if you are currently in the SYS section and you want t
� .

Each section contains three tabs. These appear at the top of th
press the corresponding section key: �, �, or �
same key, you move to another tab in that section. For example
different tabs in the SYS section, press � three times. As 
(GPS, Status, Setup), the current tab moves to the front. Altern
Main menu to move between sections and tabs.

• THE SYS SECTION • THE DATA SECTION
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This diagram shows the location of the keys on the GeoExplore
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Main menu
Use the Main menu to view all sections and their corresponding
press �� .

For example, to use the Main menu to move from the Chart tab
Status tab and then press �.

NOTE When no data file is open, the only tab available in the DATA
data file is open the New, Update, and Map tabs are availab

U
a
t
l
�
m
t

Current
tab

Section

DATA section tabs

NAV section tabs
SYS section

 keys

 tabs



u move to different levels of the 
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Each tab has multiple levels. As you complete certain tasks, yo
system. To return to a top level screen at any time press �
displayed for that tab. To configure a parameter using the Setup
until the Setup tab is active. This is a top level screen. Select th
now at a second level screen. When you have edited the config
screen by pressing � until the Select screen appears.
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Main menu structure
The next three diagrams show an outline of the GeoExplorer 3 
handy reference until you are familiar with the menus. 
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The GeoExplorer 3 data collection system has the following com

• The GeoExplorer 3 handheld data collector

• GeoExplorer 3 Support Module

• GPS Pathfinder® Office software

• GeoExplorer 3 Operation Guide CD

• QuickStart

• Standard accessories

The GeoExplorer 3 data collection system also contains the foll

Before you unpack the components and accessories see Inspe

• Data collector pouch • Lanyard

• Serial clip • Null mod

• Beacon-on-a-Belt™ (BoB) receiver • GeoExp

• External antenna option
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Inspecting the system
When you receive your GeoExplorer 3 data collection system, i
damage (scratches, dents) and if any instruments appear dama
shipping and packaging material for the carrier’s inspection.

You will need to provide a part number to return a component to
be also be ordered.

All components and part numbers are listed in this manual, alon
goods to Trimble.

If you have purchased the … See …
GeoExplorer 3 data collection system GeoExplorer 3 full eq
GeoExplorer 3 external power kit GeoExplorer 3 extern
GeoExplorer 3 external antenna kit GeoExplorer 3 extern
Beacon-on-a-Belt system Beacon-on-a-Belt (Bo
Beacon-on-a-Belt (BoB) external 
power kit

Beacon-on-a-Belt (Bo



 list
ber for each item included with 
eful for ordering spare or 

Part Number
39100-00-ENG
38376-00
38402-00-ENG
38599
18532
36996
38595-00
38604-00
38598-00-ENG
38596-00
38597-00-ENG
25110-00
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GeoExplorer 3 full equipment
The following table lists the product name and Trimble part num
the GeoExplorer 3 data collection system. This information is us
replacement parts:

Equipment description
GeoExplorer 3 data collection system

GeoExplorer 3 data collector
GeoExplorer 3 standard accessories

GeoExplorer 3 data collector pouch
Null modem cable
GeoExplorer 3 data collector lanyard
GeoExplorer 3 serial clip
GeoExplorer 3 support module
GeoExplorer 3 QuickStart
GeoExplorer 3 Operation Guide CD
GeoExplorer 3 Release Notes
Warranty Activation Card



pment list

39142
39292-00
39628-00-ENG
34191-25-ENG
24177-00
34191-25
34195-25-ENG
34231-00-ENG
34192-25-ENG

Part Number
39100-50-ENG

stem but with different 
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GeoExplorer 3c edition equi

GeoExplorer 3 RTCM/NMEA splitter cable (optional)
GeoExplorer 3 hard carrying case (optional)
GeoExplorer 3 Operation Guide (optional printed manual)
GPS Pathfinder Office software system

Mapping Systems General Reference
GPS Pathfinder Office v2.50 software CD
GPS Pathfinder Office v2.50 Release Notes
GPS Pathfinder Office v2.50 Getting Started Guide
GPS Pathfinder Office manual set (optional)

Equipment description
GeoExplorer 3c data collection system

(this is the same as the GeoExplorer 3 data collection sy
firmware)



 kit
ber for each item included with 
or ordering spare or replacement 

Part Number
39001-00
21754-10
17466
18532
39183
39182
39181
39184
39180
38874
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GeoExplorer 3 external power
The following table lists the product name and Trimble part num
the GeoExplorer 3 external power kit. This information is useful f
parts:

Equipment description
GeoExplorer 3 External Power Kit

Shoulder carrying pouch
12 V camcorder battery
Null modem cable
External power splitter cable
Vehicle adaptor cable
Camcorder adaptor cable
Camcorder charger cable
Wall power cable
Power supply (x2)



a kit
er of the GeoExplorer 3 external 
cement parts:

Part Number
39002-00
GeoExplorer 3 Operation Guide System overview
Components and accessories

GeoExplorer 3 external antenn
The following table lists the product name and Trimble part numb
antenna kit. This information is useful for ordering spare or repla

Equipment description
GeoExplorer 3 External Antenna Kit
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or ordering spare or replacement 

Part Number
38600-00-ENG
38508-00
38603
39180
38874
25110-00
38601-00
38602-00-ENG
18532
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Beacon-on-a-Belt (BoB) receiv
list
The following table lists the product name and Trimble part num
the Beacon-on-a-Belt (BoB) system. This information is useful f
parts:

Equipment description
Beacon-on-a-Belt (BoB) system

BoB receiver
BoB receiver pouch
Walll power cable
Power supply
Warranty Activation Card
PC-BoB software
BoB Receiver Manual
Null modem cable



er external 

ber for each item included with 
 is useful for ordering spare or 

Part Number
39003-00
17466
39181
39182
39184
38874
21756
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Beacon-on-a-Belt (BoB) receiv
power kit
The following table lists the product name and Trimble part num
the Beacon-on-a-Belt (BoB) external power kit. This information
replacement parts:

Equipment description
Beacon-on-a-Belt (BoB) External power kit

Camcorder
Camcorder adaptor cable
Vehicle adaptor cable
Camcorder charger cable
Power supply
Vehicle splitter cable
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The GeoExplorer 3 handh
collector
The GeoExplorer 3 handheld data collector is a high performanc
a battery-powered unit designed for use in the field. With the Ge
points of interest and also store up to 1 MB of position and attrib
and area features.

Maintenance and care of your
To maintain and care for your GeoExplorer 3 handheld data col

• keep the outer surface free of dirt and dust

• keep the connectors free of dirt and dust

• recharge the internal battery when required



odule
ween the GeoExplorer 3 and the 

 Support Module when the
automatically detects that the 
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GeoExplorer 3 Support M
The GeoExplorer 3 Support Module is used to transfer data bet
PC software and also charge the internal battery.

You can put the GeoExplorer 3 handheld into the GeoExplorer 3
GeoExplorer 3 is on or off. The GeoExplorer 3 Support Module 
GeoExplorer 3 is present, and puts it in standby mode.

t
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s that use Trimble GPS 

ful Quick Plan Mission Planning 

ociated with these projects 

trol the data collection operation 
urate, and compatible with your 

ollectors.

ing this data onto a vector or 
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GPS Pathfinder® Office so
The Pathfinder Office software runs under Microsoft Windows 9
Windows NT. It provides all the tools you need to manage a data
from the entire range of Mapping and GIS data collection system
receivers. 

The Pathfinder Office software lets you:

• plan the best times to collect GPS positions, using the power
utility.

• create separate projects, which let you manage the data ass
effectively and conveniently.

• construct and edit data dictionaries, which can be used to con
and which make sure that the collected data is complete, acc
GIS, CAD package, or database.

• transfer files to and from GPS receivers and handheld data c

• process the GPS positional data to improve its accuracy.

• display and edit collected data in the office, optionally overlay
raster background map.



D, or database format.

e to make best use of the data 
fer GPS data to a PC, and then 
ftware also exports the data in a 
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• export the collected, processed, and edited data to a GIS, CA

• produce a scaled plot as a paper record of the data.

• set up configurations for your GeoExplorer 3 data collector

The GeoExplorer 3 data collection system uses Pathfinder Offic
collected in the field. Pathfinder Office software is used to trans
differentially correct, view, and edit the data. Pathfinder Office so
format suitable for your GIS or CAD system.
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GeoExplorer 3 Operation
The standard GeoExplorer 3 data collection system includes the
CD.

The CD is designed to provide you with hands-on learning that 

It contains:

• an interactive tutorial

• a documentation tutorial

• a GeoExplorer 3 reference guide detailing every system func



 with you.
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QuickStart
The GeoExplorer 3 QuickStart is designed to take into the field

It contains information about:

• the GeoExplorer 3 handheld

• the menu structure

• Status bar icons

• Satellite information

• and some basic troubleshooting information



ble as part of your GeoExplorer 3 
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Standard accessories
The following sections describe the standard accessories availa
data collection system.

• Data collector pouch

• Lanyard

• Serial clip

• Null modem cable



r 3 handheld data collector and 
uch fits ergonomically onto your 
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Data collector pouch
The data collector pouch is provided to protect your GeoExplore
enable you to store and transport it easily. The data collector po
GeoExplorer 3 belt as shown:

t



or or to the data collector pouch 
rer 3 as shown:
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Lanyard
The lanyard can be attached to your GeoExplorer 3 data collect
to make it easier to carry. Connect the lanyard to the GeoExplo



xplorer 3 data collector to let you 
to connect to a device that 

ou can also use the serial clip to 
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Serial clip
The serial clip is attached to the swipes on the rear of the GeoE
connect to an RTCM device to receive real-time corrections, or 
receives NMEA data.

If you do not have a GeoExplorer 3 Support Module available, y
connect to your office computer to transfer data.

t



oExplorer 3 Support Module to 

lorer 3 data collector to the office 
 where the cable-free 
rence.
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Null modem cable
The supplied DB-9 null modem cable is used to connect the Ge
the office computer.

The null modem cable can also be used to connect the GeoExp
computer via the serial clip, and to connect to the BoB receiver,
transmission is either not enabled, or not possible due to interfe



ccessories
system are:
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GeoExplorer 3 optional a
The optional accessories for the GeoExplorer 3 data collection 

• Beacon-on-a-Belt™ (BoB) receiver

• GeoExplorer 3 external power kit

• External antenna option (vehicle and range pole mount)



iver
ceiving differential corrections 
rmat. The BoB receiver 
 a standard RS-232 connection.

agement™ software for the BoB 
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Beacon-on-a-Belt™ (BoB) rece
The BoB receiver is a belt-mounted MSK receiver capable of re
from DGPS radiobeacons using the RTCM SC-104 standard fo
retransmits this data both on a low power cable-free link and on

Configure the BoB receiver using the PC-BoB Configuration Man
receiver.



 kit
 a factory-installed Lithium-ion 
0 hours before needing to be 

fe you can purchase the external 
a rechargeable 12 V camcorder 
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GeoExplorer 3 external power
The standard GeoExplorer 3 data collection system comes with
battery. This will provide power for the GeoExplorer 3 for up to 1
recharged (less if the backlight is used). For additional battery li
power kit. This lets you power the GeoExplorer 3 receiver from 
battery, or from a vehicle. The kit includes:

• Shoulder carrying pouch

• 12 V camcorder battery and charging cable

• Vehicle power adaptor



r 3 handheld data collector,

T
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Shoulder carrying pouch
The shoulder carrying pouch can accommodate the GeoExplore
a 12 V camcorder battery, and cable accessories:

T



 cable
 continuous

xplorer 3 to the camcorder 
r recharging using a splitter 
lorer 3 using a cable from a 

 cable to the vehicle cigarette 
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12 V camcorder battery and charging
The rechargeable 12 V camcorder battery provides 20 hours of
GeoExplorer 3 operation, and can be fully recharged overnight.

The external power kit includes a cable that connects the GeoE
battery, and a cable that connects the battery to a wall socket fo
cable. The splitter cable can also be used to power the GeoExp
vehicle’s cigarette lighter socket.

Vehicle power adaptor
The vehicle power adaptor is a cable that connects the charging
lighter socket.



le, in a vehicle) an optional 
ins an antenna with a magnetic 
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External antenna option
In situations where the internal antenna is unusable (for examp
external antenna kit is available. The external antenna kit conta
base and a pole mount. Poles are purchased separately.
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The Tutorial provides step-by-step instructions for some of the t
using the GeoExplorer 3 data collection system. Two of the prim
3 are data collection and data update. Of the five parts to the tu
collection and two to real-time data update. They are:

NOTE It is important that you read the Introduction before you proc
to know about the menu structure of the GeoExplorer 3 data
use the keypad on the GeoExplorer 3 handheld.

Data Collection Data Update

• Preparing for collection • Preparing

• Data collection • Data upda

• Processing the data



utorial is based on the following 

s and resources. These include 
cets, lakes, and other resources 

 indicating its condition and other 
re responsible for collecting new 

or Waterstone Park. Then you 
inder® Office software. When the 
n system, you go out to the park 
ou postprocess the data to 
tional Park GIS.

 data using the GeoExplorer 3 
d existing data to the 
ou use the GeoExplorer 3 data 

ferential GPS source to navigate 
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To help you master the main concepts and tasks involved, the t
scenario: 

The Waterstone National Park requires an inventory of its asset
gates, roads, signs, campgrounds and their amenities, water fau
in the park. Information needs to be collected about each entity,
specific information. As a Park Ranger, you and your field crew a
data, as well as updating the existing GIS data.

Data collection: In this part of the tutorial you create a project f
create a data dictionary, or list of features, using the GPS Pathf
data dictionary is transferred to the GeoExplorer 3 data collectio
and use it to record features and attributes. Back in the office, y
achieve better results and export the data to the Waterstone Na

Data update: In this part of the tutorial you update existing GIS
data collection system. Before going back to the park you uploa
GeoExplorer 3 and prepare for an update session. In the field, y
collection system and the Beacon-on-a-Belt (BoB) real-time dif
back to features and then update the attributes.
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ate a project and a data 
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Before going to Waterstone Park to collect data, you need to cre
dictionary. When the data dictionary is complete, transfer it to th
system.

Preparing for collection provides step-by-step instructions to he
field and collect data. Topics are:

• Creating a project

• Creating a data dictionary using Pathfinder Office

• Data transfer

• Checking the equipment



ol for processing and managing 
ction session and process the 

s. Dividing the work in this way 
es, and assign separate folders 

mple, you could create a project 
 park, or for each month. 

.
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Creating a project
The Pathfinder Office software is a powerful Windows-based to
GPS data. Pathfinder Office lets you easily plan your data colle
GPS data successfully.

Use the Pathfinder Office software to organize work into project
helps you manage files. You can give all projects meaningful nam
for base, export, and backup files. 

You can also set up projects for different groups of data. For exa
for each major monitoring task, as well as for each region of the

For this tutorial create a project named Geo 3 Tutorial

For more information refer to the Pathfinder Office online Help.



y using 

butes relevant to a particular 
feature and its attributes.

ortant. Design a data dictionary 
icular, be familiar with any format 
 to import the data you collect.

reate a data dictionary to collect 

es’. These include gates, roads, 
 you record for each type of 
be an attribute, or condition, of a 

More...

GeoExplorer 3 Operation Guide Tutorial

Preparing for collection

Creating a data dictionar
Pathfinder Office
A data dictionary contains a description of the features and attri
project or job. It is used in the field to control the collection of a 

Understanding how to put together a data dictionary is very imp
with your Geographic Information System (GIS) in mind. In part
restrictions imposed by the GIS, otherwise you may not be able

The Waterstone National Park already has a GIS. You need to c
new data, and update existing data, for import to the GIS. 

The different park components that you need to map are ’featur
water faucets, and lakes. The different types of information that
feature are ’attributes’. For example, the name of a road would 
gate.
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In this part of the tutorial the following tasks are explained:

• Starting a data dictionary

• Creating a point feature

• Creating a menu attribute

• Creating a numeric attribute

• Creating a line feature

• Creating a text attribute

• Creating a menu attribute with a default value

• Creating an area feature

• Creating a point feature with a date attribute

• Creating the numeric attributes

• Creating a date attribute

• Saving the data dictionary



t Utilities / Data Dictionary Editor.

e data dictionary that appears on 

More...
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Starting a data dictionary
1. To start the Data Dictionary Editor in Pathfinder Office, selec

2. In the Name field type Waterstone. This is the title of th
the GeoExplorer 3 handheld.



 good reference. The dialog box 
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3. In the Comment field type your name. This is optional, but a
looks similar to the following:



be used to do an inventory of 

More...
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Creating a point feature

The first type of feature you are going to create is a gate. It will 
where all the gates are and what condition they are in. 

To create a point 
feature:

1. Click New Feature. 
Make sure that the 
Properties tab is 
selected.

2. In the Feature 
Name field, type 
Gate.

This is the name 
that appears on the 
GeoExplorer 3 
handheld when you 
use this data 
dictionary in the 
field.



efault. A gate is at a single 
priate classification for this 

of features. A symbol indicates 

here are two attributes for the 
ttribute).
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3. In the Feature Classification group, the Point option is the d
location on the earth’s surface, so a point is the most appro
feature. Leave this setting as is.

4. Click OK.

The Data Dictionary Editor screen displays ‘Gate’ in the list 
that it is a point feature.

First create the gate point feature and then add the attributes. T
gate feature: Condition (menu attribute) and Lock ID (numeric a

• Creating a menu attribute

• Creating a numeric attribute



re is a defined set of options. 
 to enter values in the field.

is attribute are good, repair, or 
ld, a menu with these three 

More...
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Creating a menu attribute

Menu attributes are useful when the information you need to sto
This standardizes the entry of information and makes it quicker

The first attribute of the gate is Condition. The only values for th
repaint, so making this a menu attribute is appropriate. In the fie
values appears when you are entering the Condition attribute.

To create a menu attribute:

1. Click New Attribute. The following dialog appears:

2. Select the Menu option and click OK.

The New Menu Attribute dialog appears.



ute Name field, type 

More...
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3. We need to know the condition of the gates, so in the Attrib
Condition:



ears.

More...
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4. Click New. The New Attribute Value – Menu Item dialog app

5. In the Attribute Value field, type Good. Click Add.

6. In the Attribute Value field type Repair. Click Add.

7. In the Attribute Value field type Repaint. Click Add.



splays the new menu attribute 

he New Attribute Type dialog.
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8. Click Close to return to the New Menu Attribute dialog. It di
values:

9. Click OK to create this attribute. Then click Close to close t



he minimum and maximum 
alue can save time. 

lock ID number identifies which 
mber between 1 and 200.

ic Default Values Required 
 numeric attributes without 

meric Default Values Required. 
re information refer to the 

and click OK. 

this, as the lock ID numbers do 

More...
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Creating a numeric attribute

Use a numeric attribute type to enter numeric values in fields. T
values help eliminate incorrect entries, and a sensible default v

The next attribute you need to create for the gate is Lock ID. A 
key corresponds to which lock in the park. It is recorded as a nu

NOTE Before creating this numeric attribute, make sure the Numer
command is turned off. This is necessary if you are to create
default values. To turn off this command select Options / Nu
There must be no check mark beside the command. For mo
Pathfinder Office online Help.

To create a numeric attribute:

1. In the New Attribute Type dialog, select the Numeric option 

2. In the Attribute Name field, type Lock ID.

3. In the Decimal Places field, the default is 0. Do not change 
not have any decimal places.



00, as all lock ID numbers are 
 can enter:

butes you created now appear in 

um range, an error message 
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4. In the Minimum field type 1 and in the Maximum field type 2
between 1 and 200. This limits the range of values that you

5. Click OK to create this attribute.

6. Click Close to close the New Attribute Type dialog. The attri
the attribute field.

NOTE In the field, if you enter a value outside the minimum / maxim
appears on the screen of the GeoExplorer 3 handheld.



 

r this feature.

ns. The default logging interval 
rt logging a line feature, the 
ntil you end the feature logging. 
 logging interval to 1 second for 
t more data is collected and a 

More...

GeoExplorer 3 Operation Guide Tutorial

Preparing for collection

Creating a line feature

You need to map the roads in the park, so create a line feature.

To create a line feature:

1. Click New Feature.

The New Feature dialog appears.

2. In the Feature Name field, type Road.

3. In the Feature Classification group, select Line.

4. Select the Default Settings tab to view the logging interval fo

The logging interval is the time between feature GPS positio
for line features is 5 seconds. This means that when you sta
GeoExplorer 3 logs one GPS position every five seconds, u
In Waterstone Park you will be driving slowly, so change the
the Road feature. An increased logging rate makes sure tha
more detailed map of the roads is provided.



terval to 1 second:

More...
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5. Use the Logging Interval list boxes to change the logging in

6. Click OK to create this feature.



3 data collection system to edit 

tes. There are two attributes for 
 attribute).
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NOTE When you are in the field, you can also use the GeoExplorer 
the Feature settings.

Now that you have created the road line feature, add the attribu
this feature: Road Name (text attribute) and Speed Limit (menu

• Creating a text attribute

• Creating a menu attribute with a default value



es for different occurrences of a 
rial you want to record the name 
 so a text attribute is appropriate. 
d name. To make sure that the 
that, in the field, a name must be 

an be entered for the attribute. 
u can change this, but for this 

More...
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Creating a text attribute

Text attributes are useful when the information to be stored vari
feature and when a defined menu list is impractical. For this tuto
of each road. There are too many road names to make a menu,
It lets you enter letters, numbers, and punctuation, for each roa
road name is entered, set the attribute as required. This means 
entered before the road feature can be saved.

To create a required text attribute:

1. Click New Attribute.

The New Attribute Type dialog appears.

2. In the Type field, select Text and click OK.

3. In the Attribute Name field, type Name.

4. The Length field determines the number of characters that c
By default, the length of a text attribute is 30 characters. Yo
tutorial leave as is.
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5. In the Field Entry group, select the Required option:

6. Click OK to create this attribute.



e

d the speed limit for each of the 
o a menu attribute is appropriate. 
ph, so make 10 the default 
eds to be entered only if it is not 

d click OK.

mph) after the attribute name 

More...

GeoExplorer 3 Operation Guide Tutorial

Preparing for collection

Creating a menu attribute with a default valu

The next attribute for the road is Speed Limit. You want to recor
roads. The values are defined numbers within a certain range, s
Most of the roads in Waterstone Park have a speed limit of 10 m
value. This saves time in the field, as the speed limit attribute ne
10 mph.

To create a menu attribute with a default value:

1. In the New Attribute Type dialog, select the Menu option an

The New Menu Attribute dialog appears.

2. In the Attribute Name field, type Speed Limit. Type (
to show the units. 

3. Click New.

The New Attribute Value – Menu Item dialog appears.

4. In the Attribute Value field, type 5 and click Add.



e default. To do this, select the 

r 20 and 25.

o the New Menu Attribute dialog. 
l appears in front of 10 to show 
GeoExplorer 3 Operation Guide Tutorial
Preparing for collection

5. In the Attribute Value field, type 10 and set this value as th
Default check box and click Add.

6. In the Attribute Value field type 15 and click Add. Repeat fo

7. When you have entered all the values, click Close to return t
It now displays the attribute values you created. An * symbo
that it is the default.

8. Click OK to create this attribute.

9. Click Close to close the New Attribute dialog.



a feature. You do not need to 
utes for this feature. Create the 
, but this time in the New Feature 
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Creating an area feature

You need to map the lakes in Waterstone Park, so create an are
record any information about the lake, so you do not need attrib
Lake feature in the same way that you created the Gate feature
dialog select Area in the Feature Classification group.

For more information see Creating a point feature.



re to record the location of water 
ay that you created the Gate 

er (numeric attribute), Test Tube 
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Creating a point feature with a date attribute

The last feature to create is a water faucet. Use this point featu
faucets in the park. Create the Water Faucet feature the same w
feature. For more information see Creating a point feature.

There are three attributes for the Water Faucet feature: ID Numb
Number (numeric attribute), and Date (date attribute).

• Creating the numeric attributes

• Creating a date attribute



ber. You will record this number 

ck ID attribute. Use the following 

More...

GeoExplorer 3 Operation Guide Tutorial

Preparing for collection

Creating the numeric attributes

All water faucets in the park are labeled with an identification num
when collecting data.

Create the ID Number attribute the same way you created the Lo
values:



he park to make sure water is 
st tubes. This test tube number is 
e correctly entered into the GIS.

ed the Lock ID attribute. Use the 
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Monthly water samples are collected from the water faucets in t
safe for drinking. The samples are collected in pre-numbered te
recorded in the GeoExplorer 3 so that results from the lab can b

Create the Test Tube Number attribute the same way you creat
following values:

For more information see Creating a numeric attribute.



. You can create this attribute so 
 faucet feature is collected, the 

click OK.

More...
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Creating a date attribute

The last attribute for the Water Faucet feature is the date visited
that it is automatically generated for each faucet. When a water
current date is automatically entered as the Date attribute.

To create a Date attribute:

1. In the New Attribute Type dialog select the Date option and 

2. In the Attribute Name field, type Date.



cted. Select the Auto Generate 

xisting one, the GeoExplorer 3 

e New Attribute Type dialog.
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3. By default, the Auto Generate on Creation check box is sele
on Update check box, as well.

When you create a new water faucet feature or update an e
automatically generates the date

4. Click OK to create this attribute, then click Close to close th



rtant to save the new data 

ta dictionary is automatically 
3 Tutorial\waterstone.ddf.

der Office online Help.

ld, use the GeoExplorer 3 data 
, or to add features, attributes, 
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Saving the data dictionary

Once you have added all features and their attributes, it is impo
dictionary. 

To save the data dictionary:

1. Select File / Save As.

The Save As dialog appears. By default, the name of the da
used to generate the file name, for example, C:\Pfdata\Geo

2. Click Save.

3. From the menu bar select File / Exit.

For more information about data dictionaries refer to the Pathfin

NOTE Create a data dictionary in the office or in the field. In the fie
collection system to create a new customized data dictionary
and values to an existing data dictionary.

For more information see Data dictionaries.



xplorer 3 data collection system, 
ransfer utility in the Pathfinder 
orer 3 and the office computer.

uter to the GeoExplorer 3 data 

pport Module. Make sure that 

nder Office software.

a.

tilities / Data Transfer.

lick Add to move it to the 

More...
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Data transfer
You need to transfer the Waterstone data dictionary to the GeoE
so that you can use it in the field to collect data. Use the Data T
Office software to efficiently transfer data between the GeoExpl

To transfer the Waterstone data dictionary from the office comp
collection system:

1. Place the GeoExplorer 3 handheld in the GeoExplorer 3 Su
the support module is connected to the office computer.

The GeoExplorer 3 is ready to communicate with the Pathfi

NOTE You do not have to turn on the GeoExplorer 3 to transfer dat

2. To start the Data Transfer utility in Pathfinder Office, select U

The Data Transfer dialog appears.

3. In the Data Type field select Data Dictionary.

4. The Waters~1.ddf file appears in the Available Files field. C
Selected Files list.



roup (on the right):

Explorer 3.
lp.

t o  
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5. The Send option is automatically selected in the Direction g

6. Click Transfer. The data dictionary is transferred to the Geo
For more information refer to the Pathfinder Office online He

C o n n e c t e d  



ke sure that you have enough 
xplorer 3 handheld is in the 
by screen to check the internal 

ck the level of the internal power. 
.

t it in the support module, the 

u turn off the GeoExplorer 3 
it in the support module, the 
 screen appears. Check that 
al power source is fully 
and that data is being 
ed. When the level of the 
ower is at its highest, the 
ower icon appears full (black).
GeoExplorer 3 Operation Guide Tutorial
Preparing for collection

Checking the equipment
Before going into the field, check the internal power level to ma
power to complete the data collection session. When the GeoE
GeoExplorer 3 Support Module and turned off, use the Stand
power level.

TIP When the GeoExplorer 3 is turned on, use the Status bar to che
To view the percentage of remaining power use The Status tab

NOTE If the GeoExplorer 3 handheld is still turned on when you pu
Standby screen does not appear. The handheld stays on.

When yo
and put 
standby
the intern
charged 
transferr
internal p
internal p

Data transfer icon
Internal power icon



u are ready to go to Waterstone 
s that you should complete. Data 
ctions required to collect point, 

ics include:

u need to know about the main 
w to use the keypad on the 
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%��������	�����
This part of the tutorial uses the data dictionary just created. Yo
National Park and collect features. But first there are some task
collection explains these tasks and gives the step-by-step instru
line, and area features, with a variety of different attributes. Top

• Initial tasks

• Collecting data

• Closing a file

NOTE Read the Introduction before proceeding with this tutorial. Yo
structure of the GeoExplorer 3 data collection system and ho
GeoExplorer 3 handheld.



 tasks:
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Initial tasks
Before starting a data collection session, complete the following

• Turning on the GeoExplorer 3 handheld

• Getting a clear view of the sky

• Checking the GPS status

• Creating a new file



 handheld
rer 3 handheld. 

reen appears for a few seconds 

isplayed.
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Turning on the GeoExplorer 3
When you get to the park, press � to turn on the GeoExplo

When the GeoExplorer 3 is turned on a Trimble identification sc
while a short self-test is performed.

The GPS tab always appears after the identification screen is d



 where you have a clear view of 
eoExplorer 3 handheld with the 

u. The internal antenna of the 
cated above the screen. The 
eed to be held perfectly level, 
na facing upwards, not 
ways.

eived from any direction but if 
nna the GeoExplorer 3 will no 
tellites and will stop computing 
 signals can be blocked by 
heavy tree cover, large vehicles, 
itters. Anything that blocks light 
. GPS signals can go through 
 glass, but these all weaken the 
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Getting a clear view of the sky
Move to a location
the sky. Hold the G
screen towards yo
GeoExplorer 3 is lo
receiver does not n
but keep the anten
downwards or side

Signals can be rec
you cover the ante
longer track the sa
positions. Satellite
people, buildings, 
or powerful transm
also blocks signals
leaves, plastic, and
signal.



 begins to track visible satellites 
ck if the GeoExplorer 3 is 
metry of the satellites that are 
out this icon see the Status bar.

se that are being used to 
how accurate the GPS positions 

n affect your GPS data 

More...
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Checking the GPS status
When you turn on the GeoExplorer 3 handheld, it automatically
and to calculate its current position. Use the satellite icon to che
computing GPS positions. It provides information about the geo
being used to compute GPS positions. For more information ab

Use the GPS tab to view the satellites currently tracked and tho
calculate the current position. You can also get an indication of 
are.

NOTE For further explanation of satellite geometry, and how this ca
collection refer to the Mapping Systems General Reference.



en appears:

 3 is currently tracking.

sing to compute its current GPS 
lorer 3 is getting signals from, but 
ample, eight satellites are being 

ns.

but that the GeoExplorer 3 is 

Satellites being used to
compute positions

Satellite geometry indicator

Current position

Minimum level
Skyplot

More...
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To view the GPS screen:

1. Press � until the GPS tab is active. The following scre

2. Use the skyplot to check the satellites that the GeoExplorer

Black boxes represent satellites that the GeoExplorer 3 is u
position. Unfilled boxes represent satellites that the GeoExp
not using because the signals are too weak. In the above ex
tracked, and seven are being used to compute GPS positio

NOTE Numbers with no box represent satellites that are available, 
not receiving signals from.

GPS tab

Signal strength
bar graph

Minimum level



. It indicates what direction the 

screen.

signal strength of the satellites. If 
m level, there may be some 

e overall quality of the GPS 
s. When the bar is above the 
 computed.
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NOTE The skyplot rotates as you change direction (like a compass)
GeoExplorer 3 is pointing to.

Your current GPS position is displayed at the bottom of the 

3. Use the signal strength bar graph (on the left), to check the 
the strength of a GPS signal is below the configured minimu
obstruction blocking the signal. 

4. Use the satellite geometry indicator (on the right), to view th
positions. This is determined by the geometry of the satellite
configured minimum level indicator GPS positions are being

For more information see The GPS tab.



te a new file:

ters a name in the File field. You 
 tutorial leave as is.

ary that you created in the office 

ed to the GeoExplorer 3 

More...
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Creating a new file
Before you can start a data collection session, you need to crea

1. Press �. The File tab appears:

The GeoExplorer 3 data collection system automatically en
can change the name of the file, but for the purposes of this

2. In the Dictionary field, check that the Waterstone data diction
appears.

NOTE The latest data dictionary and the configuration file transferr
automatically becomes the default.



ways associated with that file. 
dictionary.

file is created and the New 

 contains all the features in the 
ou created in the office.
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NOTE The data dictionary you select when creating a data file is al
Once the file is created, it is not possible to change its data 

3. All information in the form is correct, so press �. The 
feature list appears:

You are now ready to collect data.

The New feature list
data dictionary that y



nd you have created a new file, 
 gives step-by-step instructions 
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Collecting data
The GeoExplorer 3 data collection system is tracking satellites a
so you are ready to start collecting data. This part of the tutorial
for the following tasks:

• Collecting a point feature

• Collecting a line feature using the Later button

• Collecting a point feature using the Later button

• Collecting an area feature



 is already highlighted in the New 
he GeoExplorer 3 starts logging 

e GeoExplorer 3 will record a 
figured logging interval set when 
differential correction of the 
ce) to produce an accurate 

orer 3 starts logging GPS 
g icon appears at the bottom of 
 number above the icon 
 positions have been logged for 

e.

More...
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Collecting a point feature
1. The first point feature that you want to collect is a gate. Gate

feature list, so press � . The Gate form appears and t
positions.

You can remain stationary at a point for a period of time. Th
number of GPS positions during this time, based on the con
the feature was defined in the Data Dictionary Editor. After 
positions, they are averaged together (using Pathfinder Offi
position for the point feature.

When the GeoExpl
positions the loggin
the status bar. The
indicates how many
the selected featur

Logging 
icon



 is already highlighted, so press 
ta dictionary appears:

 highlight Good, then press 
attribute in the form.

More...
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2. Enter the Condition attribute for the gate. The Condition field
� . A Pop-up list of values that was defined in the da

3. The condition of the gate looks good. Use the arrow keys to

� . The GeoExplorer 3 automatically goes to the next 



meric attribute, so a

is highlighted. Press	 to scroll 
 left. Press 	 to scroll the 
r the Lock ID.

More...
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4. To enter the Lock ID number press �. Lock ID is a nu
Numeric entry field appears:

The number on the lock is 43. By default, the rightmost cell 
the displayed number to 3. Press 
 to move one cell to the
displayed number to 4. Press � to accept the value fo



n needed for the gate.

 bottom of the screen to confirm 
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 You have collected all the positions and attribute informatio

5. To close the gate feature press � .

The message Feature stored appears briefly at the
that you have saved the feature.



the Later button

S positions.

e Road form appears:

e logging icon to let you know 

ne feature, travel along the line. 
oExplorer 3 will log a GPS 
ured interval set when the 
in the Data Dictionary Editor. 
joined together to form a line.

More...
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Collecting a line feature using 
1. From the New feature list, press � to highlight Road.

You can record the attributes of the road without logging GP

2. Press � to highlight the Later button,and press �. Th

NOTE When you use the Later button, a pause icon flashes over th
that the GeoExplorer 3 is not logging GPS positions.

In order to record a li
As you do so, the Ge
position at the config
feature was created 
These positions are 



e the Text entry field to type the 

E (at the bottom of the screen) 

keys on the GeoExplorer 3 
hlight the letter P and then 

 A “P” appears in the edit bar 
 the screen. Continue 
priate letters until you have 
word PINE. Use the SPACE 
 function bar) to add a space 
 in the edit bar. To do this, 
E and press � . Then 
 ROAD. 

More...
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3. The Name field is already highlighted, so press �. Us
name of the road, PINE ROAD:

4. When finished, press �. Alternatively, highlight CLOS
and press � .

Use the arrow 
handheld to hig
press � .
near the top of
selecting appro
completed the 
function (in the
between words
highlight SPAC
enter the word

Edit bar 
Function
bar

Close
bar



cified that it was required. So if 
e, the GeoExplorer 3 warns you 

d the data dictionary in the office 
ed to change the value. 

ld. A pop-up list appears. From 

eature.

 the road feature.

essage from the screen,
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When you created the Name attribute in the office, you spe
you attempt to close the road feature without entering a nam
that it is required and will not let you go any further:

5. The speed limit for Pine Road. is 10 mph. When you create
you set 10 mph as the default, so in this case you do not ne

NOTE If you do need to change the value, select the Speed Limit fie
the list select the correct value.

6. Press 
 to begin logging GPS positions for the road f

7. When you reach the end of the road, press � to close

To clear an “Error” m
press � .



g the Later 

have not yet reached the water 
le on the way to it.

cet

n to start recording the 
ure before you actually get to it.

More...
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Collecting a point feature usin
button
The next feature you are going to collect is a water faucet. You 
faucet, but you can enter the sample test tube and the date whi

1. From the New feature list, press � to highlight Water Fau

2. The Later button is already highlighted, so press �. 

Later button

Use the Later butto
attributes for a feat



u set the date to auto-generate 
 the value select the Date field. A 

is is near the bottom of the 
for this feature and the pause 

feature and store it.

Pause
icon 
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3. The Water Faucet form appears: 

NOTE When you use the Later button, a pause icon 
flashes over the logging icon to let you know that 
GeoExplorer 3 is not logging GPS positions.

4. Enter the attributes for the water faucet now, so 
that when you arrive at the feature, you can start 
logging GPS positions. 

5. Select the Test Tube number field and enter 132. 
For more information see Numeric entry.

6. The date attribute automatically appears. This is because yo
when you created it in the office. If you need to you can edit
numeric entry field appears.

7. When you reach the water faucet feature, press 
. Th
handheld. The GeoExplorer 3 starts logging GPS positions 
icon disappears.

8. Select the ID Number field and enter 15.

9. Record sufficient positions, then press � to close the 



re.

d this feature in the office, no 

rea feature, you travel around 
ea. As you do so, the 
 a GPS position at the 
t when the feature was created 
 Editor. These positions are 
 the perimeter of the area.

 positions are joined together to 
re is no need to return to the 

More...
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Collecting an area feature
1. From the New feature list, press � to highlight Lake featu

2. Press 
 to highlight the Now button, and press �.

The GeoExplorer 3 starts to log positions. When you create
attributes were assigned.

In order to record an a
the perimeter of the ar
GeoExplorer 3 will log
configured interval se
in the Data Dictionary
joined together to form

The first and last GPS
close the area, so the
start point.



 this, press � until the Map 
n the map, along with the lake 

ay look different to the map 

an view the map at different 
. To do this, press �. 

t the Zoom in/Zoom out option.

More...
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3. You can view the DATA map while collecting features. To do
tab is active. The features that you collected are displayed o
perimeter that you are currently collecting.

NOTE Depending on the scale you are using to view your map, it m
shown above. 

You c
scales
Selec

Point

Line

Point 

Current 

Current
position

Feature



lake and you want to stop and 
ould stop logging positions for 

rer 3 stops logging positions and 
ollecting the lake feature, press 
rs.

till active and the GeoExplorer 3 

ss � to close the feature.

e a data collection session more 
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4. You can pause logging if required.

For example, if you are driving around the perimeter of the 
examine a picnic shelter some distance from the lake, you w
the lake boundary. To do this, press 
 . The GeoExplo
a pause icon flashes over of the logging icon. To continue c

 again to resume logging. The pause icon disappea

For more information see Pause and resume logging.

5. Press � to go back to the New tab. The Lake form is s
is still logging positions for the lake.

6. When you have driven around the perimeter of the lake, pre

TIP There are several advanced data collecting techniques that mak
efficient. For more information see Advanced data collection.



Explorer 3 handheld. This 

ss � until the File tab 
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Closing a file
When the data collection session is completed, turn off the Geo
automatically closes the data file.

To turn off the GeoExplorer 3 handheld:

• Press � .

The data file is closed, and the handheld is turned off.

TIP To close the data file that you are using and start a new file, pre
appears.



ark, use the Pathfinder Office 

.

 view the data. Topics are:
GeoExplorer 3 Operation Guide Tutorial
Processing the data
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Back from your data collection session in Waterstone National P
software to process the data collected and transfer it to the GIS

This part of the tutorial shows you how to transfer, process, and

• Transferring data

• Differentially correcting data

• Viewing data

• Exporting data to a GIS



Explorer 3 to the office computer. 
 to the office computer is easy.

g Utilities / Data Transfer.

More...
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Transferring data
You need to transfer the data collected in the field, from the Geo
Transferring data from the GeoExplorer 3 data collection system

1. In Pathfinder Office, start the Data Transfer utility by selectin

Pathfinder Office tries to connect to the GeoExplorer 3.



les field. Highlight the filename 

More...
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2. Select one or more files to be transferred in the Available Fi
and click Add to move them to the Selected files list:



or.

be automatically selected.

 to will default to the current 

rer 3.

 files.
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NOTE The files that appear are the current files on the data collect

In the Direction group (on the right), the Receive option will 

3. The Destination Directory that the files are to be transferred
project folder.

4. Click Transfer. The files are transferred from the GeoExplo

5. Click Close to close the Data Transfer dialog.

NOTE Use the Data Transfer utility to transfer waypoint or almanac

For more information refer to the Pathfinder Office online Help.



g small satellite clock errors and 
. Department of Defense. The 
ifferential correction. 

 the accuracy of GPS positions 
iver.

 selecting Utilities / Differential 
 3 appears in the Selected Files 

More...
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Differentially correcting data
The data collected by GPS receivers is subject to errors, includin
larger errors intentionally introduced into the system by the U.S
vast majority of these errors can be removed from the data by d
Postprocessed real-time differential GPS correction improves
from approximately 100 m to the specified accuracy of the rece

1. In Pathfinder Office, start the Differential Correction utility by
Correction. The last file(s) transferred from the GeoExplorer
field.



More...
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The following dialog apears:



ns available: Local Search for 
ult, base files are stored in the 
ed to change the Folder path for 
nfirm Selected Base Files dialog 

More...
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2. Specify the location of your base files.

Depending on the source of base files, there are three optio
base files, Internet Search for base files, or Browse. By defa
current project’s base file folder on your local drive. If you ne
the Local Search for base files option, click Browse. The Co
appears:



e selected base files provide 
on dialog appears:

More...
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3. Use the Confirm Selected Base Files dialog to make sure th
coverage for the rover files. Click OK. The Reference Positi

4. Click OK to confirm the reference position.



 current project folder.

lected.

ifferential correction. Click OK to 
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5. Specify the output folder. By default, the output folder is the

6. Select a processing option.

By default, Smart Code and Carrier Phase Processing is se

7. Click OK to differentially correct the selected files.

8. The Differential Completed dialog details the results of the d
close this dialog.



 you can display, edit, and plot it. 
data. Use it to make graphical 
ify the colors, symbols, and line 

 to verify the integrity of the field 

ect the data file(s) that you want 
ata\Geo 3 Tutorial).

More...
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Viewing data
When the data has been transferred and differentially corrected
The Pathfinder Office Map window is the best way to view field 
queries and measurements on the collected data. You can spec
styles for each feature. The Map window provides an easy way
data.

To view the data:

1. From the Pathfinder Office menu bar select File / Open. Sel
to view. The current project folder is the default path (C:\Pfd



More...
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2. From the Pathfinder Office menu bar, select View / Map:

The Map window displays the selected file.

Lake feature



lick the feature. The Feature 
bout the selected feature.

 at the bottom of the screen.

isplay, refer to the View menu 

a, remember to export the data 
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3. To display the attributes of any feature on the map, double-c
Properties dialog appears. It provides attribute information a

4. Change the color of the Lake feature. Right-click 
the Lake feature on the map. From the shortcut 
menu select Lake Layer Style. The Lake style 
dialog appears.Use this dialog to change the color 
of the lake area to blue.

5. You can also measure between positions and 
features, and compute areas. For example, you 
can compute the distance between the Road 
feature and the Lake feature. To do this, select 
Data / Measure from the Pathfinder Office menu 
bar. The cursor becomes a ruler when the Map 
window is displayed. Click a point on the Road 
feature. Then click a point on the Lake feature. The 
distance between the two points is computed and displayed

For more information about the Pathfinder Office Map window d
topic in the Pathfinder Office online Help.

NOTE When using the Map window in Pathfinder Office to edit dat
back to your GIS.



 files into a format that can be 
rea features, their attributes, raw 
.

More...
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Exporting data to a GIS
The Export Utility  in Pathfinder Office converts .SSF file format
read by a GIS or CAD system. It lets you export point, line, and a
GPS positions, and velocity records to a variety of other formats



ies / Export:

More...
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To export data to a GIS:

1. In Pathfinder Office, start the Export utility by selecting Utilit



n the Selected Files field.

s is the export folder in the 

rmat.

t. Click Close to close this dialog.

now open it in your GIS.

you automate repetitive tasks 
e back from the field, simply 
port Module. The Connection 
r 3 is in the support module 

o meet your data requirements.

 Office online Help.
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By default, the last file(s) differentially corrected appear(s) i

2. Select the output folder in the current project. By default, thi
current project.

3. Select the Export setup.

4. Click OK to export the selected file(s) to the specified GIS fo

5. The Export Completed dialog details the results of the expor

6. The file is now in the format required by your GIS. You can 

NOTE The Batch Processor utility increases productivity by letting 
that you do when you return to the office. When you can com
place the GeoExplorer 3 handheld in the GeoExplorer 3 Sup
Manager utility automatically recognizes that the GeoExplore
and runs the Batch Processor. Set up the Batch Processor t

For more information about these utilities refer to the Pathfinder



he GeoExplorer 3c edition.

 faucets in Waterstone National 
Explorer 3 data collection system 
nd the Waterstone data 

se faucets. This part of the 
 when preparing to take the 

e field to update data. Topics are:
GeoExplorer 3 Operation Guide Tutorial
Preparing for update
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NOTE Data update, using uploaded .ssf files, is not available with t

A month has passed and it is necessary to re-sample the water
Park. A different Park Ranger is going to be doing this. The Geo
and a real-time source will be used to navigate to each faucet, a
dictionary will be used to verify and update the attributes for tho
tutorial gives step-by-step instructions that should be performed
GeoExplorer 3 and the Beacon-on-a-Belt (BoB) receiver into th

• Using real-time differential corrections

• Checking the memory

• Deleting files

• Transferring GIS data

• Locking the configuration and tasks

• Transferring a configuration file

• Checking the equipment before going into the field



al 

atures and waypoints using the 
s you can accurately navigate to 

r real-time source to receive 
eoExplorer 3 then applies the 
his gives greater accuracy and 

ed to use RTCM. If necessary, 
 (in the field) or the Configuration 

an use an alternative real-time 

, the accuracy of the 
availability (S/A) errors of up to 
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Using real-time differenti
corrections
To update existing data, back in the field, you can navigate to fe
Road, Compass, or Chart tabs. Using RTCM real-time correction
any specific location.

In this tutorial, you use the Beacon-on-a-Belt™ (BoB) receive
RTCM and transmit the information to the GeoExplorer 3. The G
differential corrections to GPS positions computed in the field. T
saves postprocessing time in the office.

By default, the GeoExplorer 3 data collection system is configur
you can change the Real-time settings using the GeoExplorer 3
Manager (in the office).

NOTE If you do not have the Beacon-on-a-Belt (BoB) receiver, you c
differential correction source.

NOTE If you do not use real-time differential corrections in the field
GeoExplorer 3 data collection system is subject to selective 
100 m 2DRMS.



S data in the field, transfer these 
 the memory level to make sure 
 make space for the GIS data.

e Status bar.

ase there is not much remaining 
. For this project, you need to 
ome files to create space before 
g the GIS. See Deleting files.
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Checking the memory
Before using the GeoExplorer 3 to verify and update existing GI
data files. Before transferring them to the GeoExplorer 3, check
that sufficient space is available. If necessary, delete old files to

To check the memory levels using the Status tab:

1. Press � to turn on the GeoExplorer 3 handheld.

2. Press � until the Status tab is active:

NOTE When the memory level is low, the memory icon flashes in th

Memory gauge

In this c
memory
delete s
uploadin



n system so that you can transfer 
ds on the project.

t appears:

displays information about the 
e list and shows the free space 
r 3 data collection system.

More...
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Deleting files
Deleting files creates space on the GeoExplorer 3 data collectio
data and collect new data. The amount of space required depen

To delete files:

1. Press � . The File tab appears.

2. Press � and select Delete file(s). The Delete file(s) lis

The message box 
highlighted file in th
on the GeoExplore

Message
box



ete and press � . You are 

 computer, the Please confirm 
sferred to the PC: 
o to cancel the deletion.
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3. Use the Delete file(s) list to select the file(s) you want to del
prompted to confirm deletion. Select Yes to delete the file:

4. Press �  to close the Delete file(s) list.

NOTE If the selected data file has not been transferred to the office
message appears: File ‘x’ has not been tran
Delete anyway?. Select Yes to delete the file. Select N



e required information from the 
ility in Pathfinder Office converts 
y the GeoExplorer 3. The Data 
ta between the office computer 
ransfer GIS data to the 

More...

GeoExplorer 3 Operation Guide Tutorial

Preparing for update

Transferring GIS data
Before going into the field for a data update session, transfer th
GIS to the GeoExplorer 3 data collection system. The Import ut
data from a GIS data format into the .SSF file format required b
Transfer utility in Pathfinder Office lets you efficiently transfer da
and the GeoExplorer 3. This part of the tutorial outlines how to t
GeoExplorer 3 data collection system.



 select Utilities / Other / Import:

More...
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To convert GIS data to .SSF format:
1. Start the Import utility. From the Pathfinder Office menu bar



h specified for the output file is 

 Settings to make changes.
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2. Click Browse and select the input file(s). By default, the pat
the current project folder. 

3. Click Output File to change the output file.

4. Make sure that all import settings are correct. Click Change

5. Click OK to import the file(s).

For more information refer to the Pathfinder Office online Help.



eoExplorer 3 

he GeoExplorer 3c edition.

 software, use the Data Transfer 

lorer 3, the associated data 

:

enu bar select Utilities / Data 

ult, the source folder for sending 
rectory to change the source 

iles field highlight the filename 

More...
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Transferring GIS data to the G
data collection system

NOTE Data update, using uploaded .ssf files, is not available with t

Once the data from the GIS is imported into the Pathfinder Office
utility to transfer it to the GeoExplorer 3.

NOTE When you transfer files from Pathfinder Office to the GeoExp
dictionary is automatically transferred with the file.

To transfer data files to the GeoExplorer 3 data collection system

1. Start the Data Transfer Utility. From the Pathfinder Office m
Transfer.

2. In the Data Type field, select Data.

3. Select the source folder where the files are located. By defa
files is the last folder used to transfer a file. Click Source Di
folder if necessary.

4. Select one or more files to be transferred. In the Available F
and click Add to move them to the Selected Files list.



rred. Now transfer the 
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5. In the Direction group (on the right) select the Send option.

6. Click Transfer. All files in the Selected Files field are transfe
configuration file.



n and tasks
rotect it to make sure that it is not 
ets your specifications. You can 

changed in the field. Use the 
 a password to the configuration 

les personally. A member of your 
 3 data collection system so that 

r / Configuration Manager.

n features field. You do not need 
 not required for this project. 

ture is being recorded.

More...
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Locking the configuratio
When you set up a configuration in the office, you may want to p
changed in the field. This makes sure that the data collected me
also protect certain tasks to prevent files from being deleted or 
Configuration Manager in the Pathfinder Office software to apply
and specific tasks.

This month you will be unable to go and collect the water samp
field crew will be collecting them. You can lock the GeoExplorer
data files cannot be deleted. To do this:

1. Start the Configuration Manager by selecting Utilities / Othe

2. Select File / New. A configuration dialog appears.

3. In the Configuration field type Waterstone1. 

4. Make sure the Data tab is selected. Highlight the Log betwee
to log any GPS data between features because such data is
Lock this field so that no GPS data is collected unless a fea



 dialog). This locks the Log 

More...
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5. Select the Password locked check box (at the bottom of the
between features field.



pears.

rd in the Password field:

More...
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6. Click Password Settings. The Password Settings dialog ap

7. Select the Date files: Delete check box and type the passwo



(s).

eoExplorer 3 once in the field.

nfiguration file to the same folder 
utorial).

ettings to be changed. If you 
, lock it by applying a password.
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8. Click OK to accept the password and lock the selected task

NOTE You will need this password to delete any data files on the G

9. Save the new Waterstone configuration. You can add the co
as the data dictionary files. (For example, C:\Pfdata\Geo 3 T

10. Select File / Exit to close the Configuration Manager.

 For more information refer to the Pathfinder Office online Help.

TIP Locking and unlocking is useful when you do not want certain s
create a configuration for a certain job and do not want it altered



ion file
 transfer the new configuration to 
nsfer the configuration file, you 

ction system:

ng Utilities / Data Transfer.

ed). By default, this is the last 
urce Directory to change the 

ilename in the Available Files 

More...
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Transferring a configurat
When you create a new configuration or lock tasks, you need to
the GeoExplorer 3 using the Data Transfer utility. When you tra
can also transfer the files that are associated with it.

To transfer the configuration file to the GeoExplorer 3 data colle

1. In Pathfinder Office, start the Data Transfer Utility by selecti

2. In the Data Type field select Configuration File.

3. Select the source folder (the folder where the files are locat
folder that was used to transfer a configuration file. Click So
source folder if necessary. 

4. Select the configuration file to be transferred. Highlight the f
field and click Add to move it to the Selected Files list.



he Send option is automatically 

More...
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5. When Configuration File is selected in the Data Type field, t
selected in the Direction group (on the right).



 3
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6. Click Transfer. The files are transferred to the GeoExplorer

7. Click Close to close the Data Transfer dialog.

For more information refer to the Pathfinder Office online Help.



 before 

quipment and that it is working 

rt module. You can check if the 
ld out of the support module. If 
orer 3 is on, use the Status bar. 

ve the BoB receiver or the cable 
if necessary.

ing to the data collection start 
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Checking the equipment
going into the field
Before going into the field, check that you have the necessary e
correctly.

For the previous tasks the GeoExplorer 3 has been in the suppo
internal power source is fully charged without taking the handhe
the GeoExplorer 3 is off, use the Standby mode. If the GeoExpl

Check that the real-time source is fully charged and that you ha
to connect the real-time source to the GeoExplorer 3 handheld 

NOTE Turn off the GeoExplorer 3 data collection system before go
point. This saves battery power.



he GeoExplorer 3c edition.

llect the monthly water samples. 
 GeoExplorer 3 data collection 
re are some tasks that you need 
ime source to navigate back to 

dating existing GIS data, using 
GeoExplorer 3 Operation Guide Tutorial
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NOTE Data update, using uploaded .ssf files, is not available with t

Your supervisor has sent you to Waterstone National Park to co
The configuration and data files have been transferred onto the
system for you, but before starting the data update session, the
to complete. You can then use the GeoExplorer 3 and the real-t
the water faucets and update the attributes.

This part of the tutorial contains step-by-step instructions for up
real-time corrections, and navigating. Topics are:

• Initial tasks

• Navigating to and updating features

• Creating a waypoint

• Closing the file



llowing tasks:
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Initial tasks
Before starting a real-time data update session, complete the fo

• Checking the GPS status

• Configuring the GPS slider bar

• Checking the real-time status



d geometry, in order to compute 
ollection system, it automatically 
on. Use the satellite icon in the
positions. If the satellite icon and 
uting GPS positions.

ailable to compute GPS 
ore favorable. 

height). The GeoExplorer 3 can 
you must supply an accurate 
GeoExplorer 3 Operation Guide Tutorial
Data update

Checking the GPS status
The GeoExplorer 3 needs a minimum of four satellites, with goo
a 3D GPS position. When you turn on the GeoExplorer 3 data c
starts to track visible satellites and to calculate its current positi
Status bar to check if the GeoExplorer 3 is computing satellite 
the number below it are not flashing, the GeoExplorer 3 is comp

If the satellite geometry is poor or there are too few satellites av
positions, adjust the GPS slider bar or wait until conditions are m

NOTE GPS positions are three-dimensional (surface, location, and 
compute a 2D GPS position with only three satellites, however, 
height.



r
ction system that you should 
and logging intervals). Configure 
ther (non-critical) settings to suit 

ar to best suit the environment of 

ironment has several areas 
re, adjust the GPS slider bar to 
rded may have lower quality, but 
 in the data collected.

hen you adjust the GPS slider 
t they are less precise.

More...
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Configuring the GPS slider ba
There are some critical settings in the GeoExplorer 3 data colle
configure before collecting data (for example, the GPS settings 
these before leaving the office, or in the field. You can also set o
your application or preferences. 

The following steps show you how to configure the GPS slider b
Waterstone National Park. 

Waterstone National Park is mostly forest area. This type of env
where the tree canopy can obstruct the view of the sky. Therefo
allow more positions to be recorded. Some of the positions reco
recording more positions makes sure that there are fewer gaps

NOTE By default, the GPS slider bar is set at the highest setting. W
bar, you can obtain positions in less favorable conditions bu



guration screen appears.

More...
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To configure the GPS slider bar:

1. Press � until the Setup tab is active.

2. Highlight Configurations and press � . The Edit confi



 you collect more positions, but 
 in a forest area where trees can 
sults. If the slider bar is set too 
nough positions will be collected 

figuration Manager, refer to the 

 setting on the GPS slider bar 
a project requires the highest 
cision.
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3. Select the GPS button. The GPS slider bar appears:

4. Press 
 to lower the GPS slider bar four notches. This lets
some may be less precise. Because you are collecting data
block your view of the sky, this may provide better overall re
high, the precision of the positions collected is high, but not e
to map the entire park. For more information see GPS.

NOTE To adjust the GPS slider bar using the Pathfinder Office Con
Pathfinder Office online Help.

TIP Use a high
whenever 
level of pre



 real-time corrections, always 
se the Status tab to view the 

 GeoExplorer 3 data collection 
lorer 3 is receiving corrections, 
blem with the real-time source 

n to check that the 
 is receiving corrections from 
-a-Belt (BoB) receiver. When 
er 3 is receiving differential 
e real-time icon appears. This 
the type of RTCM source. For 
 Beacon-on-a-Belt (BoB) icon 
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Checking the real-time status
When using the Beacon-on-a-Belt™ (BoB) receiver to provide
check the real-time status before recording data or navigating. U
real-time status.

Press � until The Status tab is active.

NOTE You can also use the Status bar on the right to check that the
system is receiving real-time corrections. When the GeoExp
the real-time icon appears. This icon flashes if there is a pro
connection.

Real-time
information

Use this scree
GeoExplorer 3
the Beacon-on
the GeoExplor
corrections, th
icon indicates 
this tutorial the
appears.



ng features
atures recorded previously. The 
o navigate—a road, a compass, 
r personal preference.

ot know where they are. Use the 
 navigate to them.

 this section the following tasks 
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Navigating to and updati
When updating GIS data, use the NAV section to navigate to fe
GeoExplorer 3 data collection system provides three methods t
and a chart view. Select the method that suits your application o

You did not record the original water faucet features, so you do n
GeoExplorer 3 data collection system and a real-time source to

There are different ways to select a feature and navigate to it. In
are explained:

• Opening a data file

• Selecting a target

• Navigating to a target using the Chart tab

• Updating a feature

• Selecting a target using the cursor

• Navigating to a target using the Road tab



ins the GIS data. Use the File tab 

lly selected in the File field as 

More...
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Opening a data file
Before starting the data update session, open the file that conta
to do this.

To open an existing file:

1. Press � . The File tab appears.

2. Press � to highlight Open selected file.

The data file that you transferred from the GIS is automatica
this was the last data file transferred to the GeoExplorer 3.



 list appears:

ection to navigate to the first 
GeoExplorer 3 Operation Guide Tutorial
Data update

3. Press � to open the selected file. The Update feature

You have opened a data file, so you can now use the NAV s
water faucet.



e list of waypoints and features.

More...
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Selecting a target
To navigate to a feature, select it as your target. Do this using th

To select a target using the List option:

1. Press � until the Chart tab is active.



More...
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2. Press �. The Select target screen appears:

3. Press 
 to highlight List.



want to navigate to.

relative to the location of the 
ture selected as the target.

ad, Compass, or Chart) to select 
elect target screen.
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4. Press� to highlight the first water faucet feature that you 

5. Press �. The chart appears and shows your position 
target. A crossed-flag symbol indicates the water faucet fea

TIP When you are navigating, you can use any of the NAV tabs (Ro
a target. From any of the NAV tabs press � and use the S



e Chart tab

lected target.

 to the target. The Info windows 
al information. By default, the 
b is the Current time and 
or personal preference.

 travel

More...
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Navigating to a target using th
The chart is useful for navigating on foot.

Use the information displayed on the chart to navigate to the se

The chart displays all the information that you need to navigate
at the bottom of the screen display different types of navigation
information that is displayed in the Info windows on the Chart ta
Coordinates. Configure this information to suit your application 

Target 

Info windows

North indicator

Target name

Waypoint

Scale

Current position
and direction of



bol. Your current position is 
w points in the direction that you 
ou move closer to the target, the 

mbol. You have reached the 
bol.

creen.

he target is displayed as an 
 the target, line up your current 
 see Using the Chart tab.

ayers displayed on the chart. 

You are heading towards 
the left of the screen away 
from the target. Turn 
(180° ) to reach the target.

You are heading directly 
towards the target.
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To navigate to the selected target, move towards the target sym
displayed by a cross and a small, solid arrow symbol. This arro
are heading. The GPS trail indicates where you have been. As y
current position symbol on the chart gets closer to the target sy
target when the position symbol is over the top of the target sym

The following examples show how to navigate using the chart s

NOTE When the target is not visible on the screen, the bearing to t
arrow from your current position to the target. To navigate to
heading with the bearing to the target. For more information

TIP Use the Chart option list to zoom in or out and to change the l

You are heading towards 
the bottom of the screen. 
Turn left to reach the 
target.

You are heading towards 
the top of the screen. 
Turn right to reach the 
target.



cet feature, now use the Update 

ars in front of the feature 
 the number in front of the 
s the target. Select the same 
date feature list as you did in 

en.

e selected as a target, it is 
ted when you display the 

electing a target.

More...

GeoExplorer 3 Operation Guide Tutorial

Data update

Updating a feature
You have opened the existing file and navigated to the water fau
feature list to edit the attributes.

To update a feature:

1. Press �. The Update feature list appears:

The number that appe
name corresponds to
feature you selected a
water faucet in the Up
the Select target scre

If you have this featur
automatically highligh
Update feature list.

If necessary, refer to S



ta collection system. Press 
ate feature list.

re list. When a feature is 
ox is empty.
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2. Press � to display the attribute entry form for this 
feature. Use it to update the attributes for the water 
faucet.

3. The first attribute is the ID Number. Use this attribute to 
verify that you are updating the correct water faucet. 
The number on the faucet matches the ID number of 
the feature you have opened on the GeoExplorer 3 
handheld, so select the Test Tube Number attribute. A 
Numeric entry field appears. 

4. Use the Numeric entry field to enter the test tube 
number. The number on the test tube is 234. 

5. The Date is automatically updated by the GeoExplorer 3 da
� to save the attribute changes and return to the Upd

For more information see Updating attribute values. 

NOTE A check box appears next to the features in the Update featu
updated, a ✓  appears in the check box. Until then the check b



rsor

or appears:

More...

GeoExplorer 3 Operation Guide Tutorial

Data update

Selecting a target using the cu
You can use the cursor to select a target to navigate to.

To select a target using the cursor:

1. Press � until the Chart tab is active.

2. Press one of the arrow keys to activate the cursor. The curs

Cursor

Feature

Scale

North indicator

Your current
position

Target name

Info windows



eature that you want to navigate 
. The name appears, and the 

d on the chart automatically 

t.

ag symbol, and the feature name 
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3. Use the arrow keys to move the cursor to the water faucet f
to. When the cursor is on the feature, the feature is selected
feature symbol is highlighted.

4. Press � .

The Select target screen appears. The feature you selecte
appears highlighted in the target list.

5. Press � to accept the highlighted feature as the targe

The selected water faucet feature appears as the crossed-fl
is displayed in the To field.

For more information see Using the cursor.



e Road tab
m a vehicle. You can also use it 
 easier to use.

o not attempt to drive to a target 

More...
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Navigating to a target using th
Use The Road tab when navigating to a feature or waypoint fro
to navigate while walking, but the Compass or Chart tab may be

WARNING The Road tab displays a straight line bearing to the target. D
using this tab as a source of direction.



 the screen moves as you 

nimation of the road to navigate 

symbol. The direction you are 
o move toward the target symbol 
e width of the road increases.

 the screen. When you are off 
creen. The angle (clockwise or 
ow far off course you are.

rline

indows

More...
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To navigate to a feature using the Road tab:

1. Press � until the The Road tab is active. The road on
navigate to the selected water faucet feature.

2. Use the information displayed in the Info windows and the a
to the target.

The road screen displays your current position as a person 
moving is always towards the top of the screen. You need t
until the distance is zero. As you move close to the target th

When you are on course, the road is displayed vertically on
course, the road is displayed skewed (at an angle) on the s
counterclockwise) at which the road is turned depends on h

Target

Cente

Info w

Your current
position

Target name



loser to the target, the Distance 
ion see Using the Road tab.

you did for the first water faucet 
ture.

oad sign, and Velocity. You can 
 preference.
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As you follow the directions in the Info windows and move c
decreases and the road width increases. For more informat

3. When you reach each water faucet, update its attributes as 
that you revisited. For more information see Updating a fea

TIP By default, the Info windows on the Road tab show Distance, R
configure the Info windows to suit your application or personal



allen tree. Mark it as a waypoint, 

 (in the field) or using the 
f interest that is not part of your 

s recorded for a waypoint and 
rily used for navigation, and can 

e. You can use the Option list to 

More...
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Creating a waypoint
While in the field collecting water samples, you come across a f
so that the field crew can navigate back to it and clear the path.

A waypoint is a single position created using the GeoExplorer 3
Pathfinder Office software. Use it to record a geographic point o
data file. 

A waypoint is different from a feature. No attribute information i
the GPS position is not linked to a data file. Waypoints are prima
be transferred to Pathfinder Office as a separate waypoint file.

A waypoint has a number, name, latitude, longitude, and altitud
create and edit waypoints.
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To create a waypoint at your current location:

1. Press � . The option list appears:

2. Select New waypoint.
3. The GeoExplorer 3 automatically names the new 

waypoint. The Name field is already highlighted, so press 
� to change the name. Use the Text entry field to 
clear the assigned name and enter TREE as the new 
name for the waypoint.

4. The GeoExplorer 3 automatically assigns your current 
GPS position as the position of the waypoint. Press 
� .

TIP Waypoints can be created in the office using Pathfinder Office. 
For more information refer to the Pathfinder Office online Help.



e GeoExplorer 3 handheld.

e GeoExplorer 3.
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Closing the file
When you have competed your data update session, turn off th

To do this, press �. This closes the data file and turns off th
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When using the GeoExplorer 3 data collection system to collect and update data, you can use a 
variety of advanced functions to provide more accurate and efficient results. The following topics 
are discussed here:

• Advanced data collection

• Carrier phase data collection

• Coordinate systems



�����
es for efficient data collection. 
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Advanced data collection techniques offer time-saving techniqu
Step-by-step instructions are provided for:

• Advanced datalogging options

• Recording positions only

• Continuing line and area features

• Segmenting line features

• Offsets

• Repeating features



ptions
-related options for logging GPS 

relative to the start of a feature.

ure.

re.

er.
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Advanced datalogging o
The GeoExplorer 3 data collection system provides three closely
data. These options differ in their timing of GPS data collection 

• Before – start collecting GPS positions before starting a feat

• Now – simultaneously collect GPS positions and start a featu

• Later – start a feature, then start collecting GPS positions lat



a large number of feature types. 
scroll through the list to find the 
re. The GPS positions collected 

ou select. This means that you 
eature type.

lect the start and end of line 
f a bridge, press 
 to start 
ress 
 to pause logging. 

e, and enter the attributes. Press 
corded before starting the 

More...
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Before
This option is useful when using a data dictionary that contains 
For example, if a data dictionary has 50 features and you must 
feature to record, you can start logging and then select the featu
and stored are automatically assigned to the next feature that y
can collect extra GPS data while searching for the appropriate f

You can also use the Before option to quickly and efficiently col
features. For example, if you are driving and come to the start o
logging GPS positions. When you reach the end of the bridge, p
Then scroll through the feature list, select the bridge feature typ
� to close the feature and assign all GPS data that you re
feature.



he GeoExplorer 3 data collection 
ears in the Status bar.

inimum configured logging 
al select Edit feature settings.

 Before option, select the feature 


 to stop logging if no 
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To use the Before option:

1. Press � until The New tab is active. Press 
 . T
system starts to log GPS positions and the logging icon app

NOTE When using the Before option, the logging interval used is the m
interval (for all features). To change the minimum logging interv

2. To assign the GPS positions to a feature collected using the
from the New feature list. The attribute entry form appears.

3. Press � to stop logging and store the feature. (Press 
feature is selected.)

Logging icon

New feature list



ollection system is recorded in 
tinuously. If you do not want to 
ollecting feature and attribute 
 all features. To change this 

ere you do not need to record 
ant to record a breadcrumb trail 

t feature or attribute information, 

ionary. The data dictionary 
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Recording positions only
Most of the GPS data you collect with the GeoExplorer 3 data c
files rather than as waypoints. A file lets you store positions con
use a data dictionary, you can collect positions in a file without c
data. Positions are recorded at the minimum logging interval for
interval select Edit feature settings.

Recording just GPS positions is a useful technique in cases wh
feature and attribute data. A utility company, for example, may w
of the day’s activities. In this case, you would not want to collec
only the positions.

To record GPS positions only:

1. Create a new file using The File tab.

NOTE The Dictionary field must have a value. Use the generic dict
selected does not matter, as it will not be used.

2. Press 
 to start logging GPS positions.

3. Press 
 to pause logging GPS positions.

4. Press � to stop logging.



 features
 point feature that you need to 

 it may be some distance away. 
counter a gate (point feature). 
rd the gate. Simply end the path 

on to continue the path feature 

ting.

as you want. The number is 
.

cting . The New feature list 

 entry form appears and logging 

 logged sufficient GPS positions, 
ears again.

More...

GeoExplorer 3 Operation Guide Advanced functions

Advanced data collection

Continuing line and area
When recording a line or area feature, you could come across a
record. The point feature may be along the line/area feature, or
When collecting a path (line feature), for example, you might en
You do not have to record the entire path and then return to reco
feature, collect the gate feature, and then use the Continue opti
you were collecting.

NOTE Other Trimble GIS products refer to this functionality as Nes

NOTE You can collect as many point features within a line or area 
limited only by storage space in the GeoExplorer 3 handheld

To use Continue:

1. Press � to close the line or area feature you are colle
appears.

2. Select the point feature that you want to collect. The attribute
starts.

3. When you have recorded attributes for the point feature and
press � to store the feature. The New feature list app



rea feature name>. The 
 or area feature that you were 
ature.

r, press � to store the 
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4. Press �. From the option list, select Continue <line/a
GeoExplorer 3 returns to the attribute entry form for the line
logging before and continues to log GPS positions for that fe

5. When you complete the traverse of the line or area perimete
feature.



ne into a number of segments. 
 values for parts of the same 

y start another of the same type, 
s where it is difficult (or illegal) to 

ment. 

f the same type is immediately 
The last GPS position of the first 
ature, so that adjacent segments 

attributes of the first line 
gment to store one feature and 

More...
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Segmenting line features
When collecting line features, it is often convenient to divide a li
Segmenting line features allows you to specify different attribute
physical line. You can also end one line feature and immediatel
while still moving. This is useful when mapping roads or highway
stop at the point where one feature ends and the next starts.

To segment a line feature:

1. Start collecting the line feature.

2. From the attribute entry form, press � and select Seg

The current line feature is stored and another line feature o
started with the same attribute values as the previous one. 
feature is identical to the first GPS position of the second fe
join end-to-end in the GIS.

NOTE When you select Segment, the GeoExplorer 3 validates the 
feature. Always complete attribute entry before selecting Se
start another. 



ble (due, for example, to poor 
e last GPS position of the 
m the first GPS position that 

 segments.
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CAUTION If you select Segment and no current GPS position is availa
satellite geometry), the GeoExplorer 3 does not start with th
previous line feature. Instead, the new line feature starts fro
becomes available. In this case, a gap occurs between the



u can enter an offset and record 
xample, it is typically easier to 
ee and record its attributes. This 
 assess its condition. Specify an 
ositioned correctly in the GIS. 

on. Select Offset to view or enter 
zero constant offset for the class 
e is as configured. For 
ings.

More...
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Offsets
If you cannot travel over the top of, or right next to, a feature, yo
it at the specified distance. When collecting a tree feature, for e
stand some distance (such as 10 paces to the North) from the tr
ensures good GPS reception, and lets you see the tree clearly to
offset to the tree of “10 m South”. This ensures that the tree is p
This is an example of an offset point feature. 

The attribute entry form for each feature type has an Offset opti
the offset for the feature being collected. If you configure a non-
of feature being collected, the default offset value for that featur
information about configuring constant offsets see Feature sett



ting a line feature such as a 
 and record the positions of the 
area feature such as a lake, you 
imeter using an offset. This 

More...
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You can also use offsets for line and area features. When collec
fence, it may be easier to drive along the road beside the fence
fence an offset feature. Another example is when collecting an 
could walk some distance from the lake edge and record its per
diagram shows these examples.

Area offset
distance

Line offset
distance

Path traveled
around lake 



ociated with it. This means that 
e offset during the line feature, 
e feature has its own offset. To 
ust apply to the whole area 

e sure that you can remain a 

et. An Offset form appears:

a entry field to enter the value.

n the Offset form depend on 
are collecting (point, line, or 
ows the fields for a line or area 
ture the fields are: Bearing, 
rt. distance.

More...
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NOTE Any feature (point, line, or area) can have only one offset ass
to record a line feature with a given offset and then change th
you must segment the line at that point. Each segmented lin
collect an area feature using offsets, the same offset value m
feature. This may require a test run around an object to mak
consistent distance from it.

To offset a feature:

1. Start the feature.

2. From the attribute entry form, press � and select Offs

3. Enter a value for each field. Select the field and use the dat

The fields that appear i
the type of feature you 
area). This example sh
feature. For a point fea
Horz. distance, and Ve



ute entry form reappears. 

d sufficient GPS positions, press 
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4. When the Offset form is complete press � . The attrib

5. When you have recorded attributes for the feature and logge
� to store the feature. The New feature list appears.

NOTE To remove an offset press � and select Reset.



 You do not have to re-enter 
ribute value is correct for the 

the last recorded feature of that 

t Repeat. Press � to close 
 check box.

 appears. The attribute values 
e. Edit them if necessary. Press 

e Repeat mode.

ermined by the data dictionary. 
te belonging to a feature where 
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Repeating features
Use Repeat to efficiently record a sequence of similar features.
values for all attributes. Just flip through, checking that each att
selected feature. Change only those that need to be changed.

When you use Repeat, default attribute values are copied from 
type.

To Repeat attributes for similar features:

1. When the New feature list is active, press � and selec
the option list. When Repeat is selected a ✓ appears in the

2. Select a feature from the New feature list. The attribute form
that appear are those of the last recorded feature of that typ
� to save the attribute values and store the feature.

3. Select another feature. Continue until you want to turn off th

To turn off the Repeat mode:

• Press � and select Repeat. The ✓ disappears.

NOTE When Repeat is not selected, default attribute values are det
The data dictionary specifies a default value for each attribu
appropriate.



���	�����
a, configure the GeoExplorer 3 

n describe in detail how to collect 
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To collect a feature with a precision better than regular GPS dat
data collection system to log carrier phase data.

The following topics introduce you to the basic concepts and the
and use carrier phase data.

• Before you begin

• Configuring the GeoExplorer 3 data collection system

• In the field

• Back in the office



ith using carrier phase data.

dent GPS positions. If enough 
g reliable positions.

 collected in the field can be 
 back at the office. Because 
ositions generated during 
ld.

More...
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Before you begin
The following topics discuss some of the concepts associated w

Why use carrier phase data?
In a conventional GPS session, the GeoExplorer 3 logs indepen
satellites are visible and the geometry is good, it continues to lo

When the GeoExplorer 3 also logs carrier phase data, positions
postprocessed to generate more precise positions once you are
measurements are collected from each individual satellite, the p
postprocessing are more precise than positions logged in the fie



arrier phase data, so avoid 
me of day when you can expect 
geometry.

 in the field.

enough time to provide sufficient 

More...
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Planning
You require a clear view of the sky at all times when collecting c
obstacles such as trees, bridges, and tall buildings. Choose a ti
to track a maximum number of satellites with the best possible 

NOTE Always make sure that you collect sufficient useful data while

Collecting sufficient data
Always make sure that at least four satellites remain visible for 
useful data for postprocessing.



recision, the GeoExplorer 3 data 
for the required minimum time. 
fore the postprocessing software 
satellites together provide the 
use more.

ops below four.

during a session, you greatly 

, the GeoExplorer 3 data 
s four or more satellites are 
d, all of the carrier phase data 
.

More...
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Number of satellites
To provide sufficient carrier phase data to achieve the required p
collection system needs to log data from at least four satellites 
However, you will need to log data from at least five satellites be
can compute the precision of the generated positions. The five 
necessary redundancy for the precisions required, but you can 

“Loss of lock” occurs when the number of available satellites dr

NOTE If you minimize the number of times that loss of lock occurs 
increase the precision of the postprocessed results. 

When you start a file that has any features configured to carrier
collection system starts to record carrier phase data. As soon a
available, a counter starts. When the minimum time has elapse
recorded during that period can be used during postprocessing



ilable is 10 minutes. The 
 than 10 minutes in length.

 as soon as four or more 

played in the message box. It 
.

llected until then may not provide 
 counter is automatically reset to 
ined.

rrier phase data from four or 
lapsed since the beginning of 

More...
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Time
The minimum time for which four or more satellites must be ava
Differential correction software will not process data blocks less

Counter
A counter in the GeoExplorer 3 handheld starts to measure time
satellites are available.

When the counter reaches the minimum time, a message is dis
indicates that the current “block” contains sufficient useful data

If you lose lock before the end of the minimum time, the data co
the required precision during postprocessing. Consequently, the
zero when loss of lock occurs. It only restarts when lock is rega

NOTE The counter is active only if the GeoExplorer 3 is logging ca
more satellites—it does not simply record the time that has e
the file.



ends on a combination of the 
, and the period of time for which 
 generally gives more precise 

re shows the relationship 
nd the precision of the positions 

More...
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Time and precision
The precision of positions generated during postprocessing dep
number of satellites used, the distance between base and rover
data is recorded from those satellites. Collecting data for longer
positions.

Assuming that enough satellites are available, the following figu
between the time taken to collect carrier phase measurements a
generated during postprocessing.

Time

Er
ro

r

longer baseline

short baseline



, the GeoExplorer 3 handheld 
 stored as one continuous 

er of available satellites. As soon 
his block continues until lock is 

ut the file. These blocks together 

of each other, so carrier phase 

eed to collect sufficient data 
 file or reopen an existing one. 

More...
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What is a “block” of data?
When you start a file that has any features configured to carrier
starts to record carrier phase measurements. Useful data is not
stream, however, but as a series of “blocks”.

The beginning and end of each block is determined by the numb
as four (or more) satellites are available, a new block begins. T
lost. When lock is regained, a new block begins.

The GeoExplorer 3 continues to create blocks of data througho
constitute the measurement data for the entire session.

Opening and reopening files
The files that you create in the GeoExplorer 3 are independent 
data collected in one file is of no use to another.

If you use the GeoExplorer 3 to collect carrier phase data, you n
every time you open a file—this is true whether you open a new
Always make sure that you collect sufficient data for each file.



 blocks of carrier phase data as 

A  = 4 or more satellites – 
useful carrier phase data 

B  = lock is lost –
unusable carrier phase 
data

C = lock is regained (4 or 
more satellites) –
useful carrier phase data 

D = lock is again lost –
unusable carrier phase 
data

More...
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The figure below shows how the GeoExplorer 3 creates distinct
the number of satellites changes. 

Time in minutes
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 at 35 minutes when lock is lost 
um time required for the 
ssfully is 10 minutes, so the first 
in time, the greater the precision 

 not met. The counter does not 
ot used.

creates a new block and the 
e, this happens 38 minutes after 
er 7 minutes worth of data has 
, this block does not contain 
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In the previous figure, the counter begins at time zero and stops
(B). This creates the first block of carrier phase data. The minim
differential correction utility to process carrier phase data succe
block contains sufficient useful data. The longer the blocks are 
achieved.

Between B and C, the required minimum number of satellites is
start, and the carrier phase data collected during this period is n

When four satellites are again available (C), the GeoExplorer 3 
counter begins to measure again from time zero. In this exampl
the start of the session. Lock is lost again at 45 minutes (D), aft
been collected. Since the required minimum time is 10 minutes
sufficient continuous data.



phase measurements in the 
lines, or areas.

Look for obstructions that may 
fficient satellites (that is, trees).

atellites are available. Once 
eoExplorer 3 counter starts.

e is reached
 and stay where you are until the 
d, you can move to the next 
fficient data to generate precise 

ove to the next feature before 

More...
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Recording features
While the GeoExplorer 3 data collection system collects carrier 
background, you start to record features—these can be points, 

Decide carefully when to start and stop recording feature data. 
slow down the ability of the GPS receiver to maintain lock or su

Before starting the first feature in a file, wait until four or more s
carrier phase data from at least four satellites is received, the G

Ending a feature before minimum tim
Once the counter is running, you can choose to end the feature
minimum time is up. When the minimum carrier time is achieve
feature. Using this method, you can make sure that you have su
positions.

Alternatively, if you think you are unlikely to lose lock, you can m
sufficient carrier phase data is collected.



u can generate precise positions 

 carrier phase data stored at the 

eature A was started after the 
, but during postprocessing it 

ul data was recorded. You 

e

C

BLOCK 3

More...
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As long as a block eventually contains sufficient useful data, yo
for any feature that falls within it.

This figure shows how individual features benefit from blocks of
time they were recorded.

In this example, Block 1 contains sufficient carrier phase data. F
counter started for Block 1 and ended before the success beep
derives the full benefit of all data recorded for Block 1.

Feature B was unwisely recorded during a period when no usef
probably need to record this feature again.

Blocks of carrier phase data

Individual features logged during this tim

BLOCK 1 BLOCK 2

A B



ging to this feature continued 
 loss of lock and a new block of 
nimum carrier time was achieved 
ortion of the feature collected 
) should achieve the desired 

with Block 3 may not achieve the 

 if loss of lock is unlikely.

y should be high rather than low 

ou move

icate how useful the current data 
 you can measure that feature 
data, recapture any features that 

More...
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Feature C was started when the counter started for Block 2. Log
after the minimum carrier time was achieved. Then there was a
carrier phase data started. The feature was ended before the mi
for this block of data, and the file was closed. In this case, the p
before the loss of lock occurred (indicated by the end of Block 2
precision. However, the second portion of the data, associated 
desired precision.

CAUTION Move to the next feature before the minimum time is up only

As you record features, be aware of the following:

• the number of satellites available

• the position of these satellites—if they are to stay visible, the
on the horizon

• any obstruction likely to cut off your view of the satellites as y

Read any messages that appear in the message box. They ind
is. The message box also shows if loss of lock has occurred, so
again if necessary. If it is clear that a block contains insufficient 
are affected before leaving the site.



ential Correction utility of the 

ion system also logs code phase 

 the carrier phase data to 
 stores these results over the top 
th the arrangement of the new 

nerated positions. This helps you 
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Postprocessing
Postprocess all data using an office computer running the Differ
GPS Pathfinder® Office software. 

In addition to carrier phase data, the GeoExplorer 3 data collect
data in the field.

During postprocessing, the Differential Correction software uses
generate positions of high precision. It computes positions, and
of the code phase data. The code phase data simply assists wi
positions.

Finally, the software computes the estimated precision of the ge
to evaluate the GPS results.



orer 3 data 

rer 3 data collection system as 

e data collection.

ears.

More...
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Configuring the GeoExpl
collection system
If you decide to use carrier phase data, configure the GeoExplo
follows:

1. Decide which features you want to collect using carrier phas

2. Press � until the Setup tab is active.

3. Select Feature settings. The Select feature settings list app



More...
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4. Select the name of the data dictionary to be using during 
the carrier phase data collection session. The Edit 
feature settings screen appears:

NOTE This list shows all features contained in the selected data 
dictionary. The specified logging interval for each feature 
is also shown.

5. To configure an individual feature, select it from the list. 
The corresponding <feature> settings form appears:

NOTE Use this form to edit the logging interval and minimum 
number of positions required, and to change the 
accuracy.

By default, the accuracy is set to Code. Change this to 
Carrier. Press � to close the form and save all 
changes.



data.

.
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6. Press � to configure all points, all lines, or all area 
features. The Edit feature settings option list 
appears:

NOTE Use these options to make the same change to all 
features of a particular type.

Select one of the options. The corresponding Set all 
<feature type> form appears. By default, the accuracy is 
set to Code. Change this to Carrier. Press � to 
close the form and save all changes.

You are now ready to go into the field and collect carrier phase 

TIP To close a form without saving the changes, press ��



ightly different from those used 
er phase data collection session 
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In the field
The techniques used when collecting carrier phase data are sl
when collecting code phase (C/A code) GPS positions. A carri
includes the following tasks:

• Opening a new file using The File tab

• Collecting carrier phase data



rmined by the data dictionary 
 created.

More...
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Collecting carrier phase data
When a data file is open, the New feature list appears:

Features in this list are dete
specified when the file was



More...
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To collect carrier phase data:

1. Start a feature by selecting it from the New feature list. If 
the feature is configured for carrier, the GeoExplorer 3 
begins logging carrier phase data. The Carrier 
started message appears briefly in the message 
box.

NOTE The logging icon will change to the carrier phase logging 
icon when carrier phase logging starts.

2.  Check the carrier time. As you log carrier phase data, the 
GeoExplorer 3 displays the time elapsed since the current 
block of data started. This is referred to as “carrier time”. 
The carrier time appears in the message box at the 
configured feature logging interval and shows, in minutes 
and seconds, the amount of data collected.



 continuously for at least 
ier time achieved 

se data.

 full time before moving on to 
efore minimum time is 

lose the file.

ve logged sufficient carrier 
ve the precision required for 

ed since the counter was last 
 be used until the counter is 

More...
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3.  Stay at the feature until you have logged carrier phase data
10 minutes or until the desired time has elapsed. The Carr
message appears in the message box.

4. Press � to close the feature and save the carrier pha

NOTE Trimble recommends that you occupy the first feature for the
other features. For more information see Ending a feature b
reached.

5. Repeat Steps 1 through 4 for the next feature.

6. When you are finished collecting features press � to c

This means you ha
phase data to achie
the features collect
reset. This data will
reset again.



xplorer 3 warns you whenever 
 A message appears in the status 

essage tells you how long (in 
st continuous block was at the 

e Carrier time message 

More...
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If you try to close the feature before the minimum time 
is up, the GeoExplorer 3 asks for confirmation that you 
want to store the feature.

While you are logging 
carrier phase data, the GeoE
the GPS receiver loses lock.
line.

The Carrier lost m
minutes and seconds) the la
time that lock was lost.

When the counter is reset, th
shows 00:00. 



y time the counter is reset. This 
rier phase data collected for the 
thfinder Office timeline. 

reoccupy the affected features or 
eve the desired precision.
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In addition, the GeoExplorer 3 writes a note to the data file ever
records when the carrier time was reset, and the amount of car
previous block. Review this note back at the office using the Pa

If the minimum time is not reached, you can choose whether to 
move on. If you move on, the affected feature is unlikely to achi



 the GeoExplorer 3 handheld in 
r utility that is part of the 

ion Utility. For instructions on 
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Back in the office
To transfer data from the handheld to the office computer, place
the GeoExplorer 3 Support Module and use the Data Transfe
Pathfinder Office software. 

Process the files using the Pathfinder Office Differential Correct
processing data files, refer to the Pathfinder Office online Help.



GPS data, you can configure the 
splay coordinates using the 

orking in. The following topics 

 collection system

eoExplorer 3c edition.
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When using the GeoExplorer 3 data collection system to collect 
coordinate system, zone, and datum. This lets you enter and di
coordinate system that best suits you and the location you are w
are discussed:

• Coordinate systems and datums

• Coordinate systems available on the GeoExplorer 3 data

• Using Coordinate System Manager

• Transferring coordinate systems

• Configuring coordinate systems

• Resetting coordinate systems

NOTE Uploading of Coordinate systems is not available with the G



 datums
ed to describe the location of 
vides you with your position 
stem you have configured.

t sources, the data must be 
ecause different datums and 
gle geographic location.

es relative to a mathematical 
rld Geodetic System 1984 datum 
 ellipsoid and an origin point. An 
 sphere, which approximately 
icular part of the earth). The 

 data capture applications, 
IS will represent the coordinates 
r grid (running North and East) 
n be defined to provide a good 
 transformation and a map 
l ellipsoid to the GIS’s flat-earth 
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Coordinate systems and
Coordinate systems are three-dimensional reference frames us
objects in space. The GeoExplorer 3 data collection system pro
anywhere on the earth’s surface in relation to the coordinate sy

Before you can compare geographic data obtained from differen
referenced to the same datum and coordinate system. This is b
coordinate systems provide different coordinate values for a sin

GPS positions are normally expressed as latitudes and longitud
model called a datum. The datum used by GPS is called the Wo
(or WGS-84). A datum is defined by the relationship between an
ellipsoid is a three-dimensional surface shaped like a squashed
models the shape of the earth (either as a whole, or over a part
WGS-84 datum is defined in terms of the GRS80 ellipsoid.

For most land-based GPS applications, and particularly for GIS
latitudes and longitudes are much less convenient. Typically, a G
of geographic features in a locality of interest using a rectangula
and will presume that the earth is locally flat. A local ellipsoid ca
approximation to the shape of the earth in that locality. A datum
projection are then used to transform coordinates from this loca
model.



r a local ellipsoid, or an 
 surface over which the earth’s 

cations:

 well

earth’s surface locally

 earth’s surface as a whole
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Heights can be displayed by the GeoExplorer 3 relative to eithe
empirically defined surface known as the geoid. The geoid is a
gravity is constant. (The geoid represents mean sea level.)

In summary, there are three models for describing geographic lo

• the flat North, East model of the GIS, possibly with heights as

• the curved local ellipsoid, used by the GIS as a model of the 

• the curved GRS-80 ellipsoid, used by GPS as a model of the

The earth’s surface

The geoid

The local ellipsoid

The GRS-80 ellipsoid (WGS-84 datum)



ce the WGS-84 datum) and then 
es and longitudes need to be 

tudes on the WGS-84 datum into 
ration is called a datum 

 on the local datum, they must 
g an operation called a map 
need to be transformed from 
r reference level. The most 

to as mean sea level. The 
tware both contain a geoid 
ative to GRS-80 into heights 

More...
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These models can describe heights as being relative to either:

• an ellipsoid

or

• the geoid (mean sea level)

In order to collect the positions of features using GPS (and hen
send them to a GIS as North, East coordinates, the GPS latitud
processed in a number of ways.

They need to be transformed from latitudes, longitudes, and alti
latitudes, longitudes, and altitudes on the local datum. This ope
transformation.

Once the coordinates are expressed as latitudes and longitudes
then be projected into North and East values on a flat grid, usin
projection. Finally, if altitudes are to be stored by the GIS, they 
heights above the GRS-80 ellipsoid to heights above some othe
common reference level is the geoid, more commonly referred 
GeoExplorer 3 data collection system and Pathfinder Office sof
separation model which enables them to transform altitudes rel
relative to mean sea level.



thfinder Office differ in accuracy. 
r Office is more accurate. If you 
 to a more accurate (perhaps 

ts in Pathfinder Office before 

 a map projection, so that you 
y have recorded) in your local 
sition or navigate using a map 
 will be shown relative to your 

 bundles up the complexities of 
mplexities behind the common 
ar. Each named coordinate 
id) and a number of zones (each 

e Coordinate System Manager 
oordinate systems supplied by 
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The geoid separation models used by the GeoExplorer 3 and Pa
The GeoExplorer 3 is necessarily approximate, while Pathfinde
require altitudes relative to a different reference level, or relative
local) mean sea level mode, you will need to process the heigh
exporting them to your GIS.

The GeoExplorer 3 lets you specify a datum transformation and
can see your GPS position (and the position of features you ma
coordinate system. This makes it easy for you to check your po
produced by your GIS. It also allows you to specify that heights
local ellipsoid, or relative to mean sea level.

For your convenience, the GeoExplorer 3 data collection system
datum transformations and map projections, and hides these co
names for the coordinate systems with which you may be famili
system has an associated datum (which encapsulates an ellipso
of which is a named instance of a particular map projection).

You can create your own coordinate systems and sites using th
utility program in Pathfinder Office. With the set of pre-defined c
Trimble this should rarely be necessary.



lable on the 
ction system
are supplied with two coordinate 

evel or Height Above Ellipsoid)

Most National Coordinate 
e Data Transfer utility in the 

bal) model. This is different from 
SL heights on the GeoExplorer 

.

ice software to a
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Coordinate systems avai
GeoExplorer 3 data colle
The GeoExplorer 3 and GeoExplorer 3c data collection system 
systems: 

• Lat/Long – latitude, longitude, and height (above Mean Sea L

• UTM – northing, easting, and elevation

There are also over 100 datums already on the GeoExplorer 3. 
Systems are supported, and you can easily load these using th
Pathfinder Office software.

NOTE You cannot use local sites.

NOTE The default geoid on the GeoExplorer 3 is the DMA 10x10 (Glo
the default used by the Pathfinder Office software. As a result, M
3 may differ to those displayed in the Pathfinder Office software

NOTE You cannot load coordinate systems from the Pathfinder Off
GeoExplorer 3c edition.



 Manager
, to create and edit custom 

er utility from Pathfinder Office.

 systems and zones.

ort.

d the related support files, use 
 the GeoExplorer 3.
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Using Coordinate System
Use the Coordinate System Manager utility, in Pathfinder Office
coordinate systems for use with the GeoExplorer 3.

To use Coordinate System Manager:

1. On the office computer, start the Coordinate System Manag

2. Use the tabs in the main window to select or edit coordinate

3. Export the coordinate system database file. Select File/Exp

The Export dialog appears.

4. Select the Select records only option in the Export dialog. 

5. Click OK.

The Save As dialog appears.

6. Specify the new file name and click Save.

When you have saved the coordinate system database files, an
the Data transfer utility to transfer the coordinate system files to

For more information refer to the Pathfinder Office online Help.



ystems
, to transfer coordinate systems 
 and the office computer.

ake sure that the support module 
3 is in the
 files.

athfinder Office.

 case, select Coordinate System 

d). By default, this will be the last 
rce Directory to change the 
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Transferring coordinate s
Use the Data Transfer utilities, in the Pathfinder Office software
and grid files between the GeoExplorer 3 data collection system

To transfer coordinate systems and grid files:

1. Place the GeoExplorer 3 handheld in the support module. M
is connected to the office computer. Once the GeoExplorer 
GeoExplorer 3 Support Module, it is ready to transfer data

2. On the office computer, start the Data Transfer utility from P

3. Select the appropriate file type in the Data Type field. In this
or Grid Files.

4. In the Direction field choose Send.

5. Select the source folder (the folder where the files are locate
folder used to transfer (send) a file. If necessary, press Sou
source folder.



ht the name(s) of the file to be 

More...
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6. Select one or more files to be transferred. To do this, highlig
transferred in the Available Files field and then click Add.



ferred. (When the size of the a 
e transfer, as it will use up a 

cify which zone is to be 
 Configuration Manager can 

s configuration, the appropriate 
 Use Coordinate System 

d CSE files containing 
 example, America.CSE 
 the Data Transfer utility, select 
lay a list of pre-defined 
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7. Press Transfer. All files in the Selected Files field are trans
file(s) is greater than 200KB, you are prompted to confirm th
considerable portion of the GeoExplorer 3’s memory.)

NOTE You can also use the Configuration Manager software to spe
transferred to the GeoExplorer 3 data collection system. The
only transfer one zone. If you specify a zone and transfer thi
Coordinate System Export file (.CSE file) is also transferred.
Manager to transfer more than one zone.

For more information refer to the Pathfinder Office online Help.

NOTE Trimble GPS Pathfinder® Office software contains pre-define
coordinate systems for a number of regions of the world (for
contains all the coordinate systems for the Americas). Using
Coordinate system in the Data Type drop down menu to disp
coordinate system files.



ystems
, zone, and datum parameters. 
tum transformation and a map 
on of features you collect, in your 
ur position or to navigate using a 

rs.
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Configuring coordinate s
You can use the Coordinates form to edit the coordinate system
The GeoExplorer 3 data collection system lets you specify a da
projection so that you can see your GPS position, and the positi
local coordinate system. This makes it easy for you to check yo
map produced by your GIS.

To configure the Coordinates form:

1. Press � until the Setup tab is active.

2. Select Configurations. The Edit configuration screen appea

3. Select Coordinates. The Coordinates form appears:

4. Use this form to specify the coordinate system, zone, 
datum, altitude reference, and geoid. You can also specify 
the units used to display the coordinates and altitude. For 
more information see Coordinates.



tems
Explorer 3. To do this reset the 
de/Longitude and UTM, are 
GeoExplorer 3 Operation Guide Advanced functions
Coordinate systems

Resetting coordinate sys
You can remove the uploaded coordinate systems from the Geo
list of coordinate systems. All coordinate systems, except Latitu
removed.

To reset the list of coordinate systems:

1. Press � until the Setup tab is active.

2. Select Configurations.

The Edit configuration screen appears.

3. Select Coordinates. The Coordinates form appears:

4. Highlight the System field and press �.

5. Select Reset coordinate systems. You are prompted to 
confirm the reset.

6. Select Yes to remove the coordinate system file from the 
GeoExplorer 3. Latitude/Longitude becomes the new 
current system. Select No to cancel the reset operation. 

NOTE You cannot delete Latitude/Longitude or UTM from the 
list.
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Introduction

��'���&��
This Reference provides detailed information about screens that appear when you use the 
GeoExplorer 3 data collection system. 

General operation describes different ways to interact with the GeoExplorer 3. It also explains 
how to use the keys and screens. Other topics correspond to different areas of the software.

The GeoExplorer 3 software is arranged in three “sections”:

• THE SYS SECTION • THE DATA SECTION • THE NAV SECTION



xplorer 3 user interface and data 
GeoExplorer 3 Operation Guide Reference
General operation
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General operation contains detailed information about the GeoE
entry methods. Topics are:

• Turning the GeoExplorer 3 handheld on and off

• Adjusting the display

• Rebooting the GeoExplorer 3 handheld

• Main menu

• The GeoExplorer 3 display

• Status bar

• Interacting with the GeoExplorer 3 data collection system

• Password control



 3 handheld 

ff.

 key). A Trimble identification 
orms a self-test. This is replaced 
ys returns to the GPS tab when 

he On/Off key) for one second.
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Turning the GeoExplorer
on and off
This explains how to turn the GeoExplorer 3 handheld on and o

On
To turn on the GeoExplorer 3 handheld press � (the On/Off
screen appears for a few seconds while the GeoExplorer 3 perf
by the GPS tab. The GeoExplorer 3 data collection system alwa
turned on.

Off
To turn off the GeoExplorer 3 handheld press and hold � (t



ode.
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Adjusting the display
This explains how to adjust the screen contrast and backlight m

• Backlight

• Screen contrast



reen. The screen is easiest to 

nditions. The backlight is always 
hanged to one of three states by 
When the backlight is in the 
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Backlight
The GeoExplorer 3 handheld displays information on an LCD sc
read when viewed directly from the front.

The screen can be backlit to make viewing easier in poor light co
off when the GeoExplorer 3 is turned on. The backlight can be c
pressing ��. The states are Off, Normal, and Bright. 
normal or bright state, an icon appears in the Status bar.

CAUTION Operating the backlight uses more power.



creen contrast. To lighten the 
.
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Screen contrast
Depending on viewing conditions, you may need to adjust the s
screen contrast press ��. To darken it, press ��



rer 3 

 key presses you need to 
 to shut down.

e GeoExplorer 3 handheld to 

 hold down for 10 seconds. The 

rm a warm boot. No data loss 
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Rebooting the GeoExplo
handheld
If the GeoExplorer 3 handheld locks up and does not respond to
perform a warm boot. This causes the GeoExplorer 3 hardware

NOTE Whenever possible, before rebooting, transmit any data in th
an office computer.

Warm boot
To perform a warm boot on the GeoExplorer 3, press � and
GeoExplorer 3 turns off. Press � again to turn it on.

NOTE This procedure causes the GeoExplorer 3 hardware to perfo
should occur as a result of performing this procedure.



e Trimble logo starts spinning. 
ously.

d, it is too late to attempt a cold 

ill remove any data file, 
tems you may have loaded onto 
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Cold boot
To perform a cold boot turn the GeoExplorer 3 handheld on. Th
While the logo is spinning, press � and � simultane

NOTE Once the logo stops spinning and the first screen is displaye
boot. Repower the unit and try again.

WARNING This procedure clears the memory of the GeoExplorer 3. It w
configurations, data dictionary, waypoints, or coordinate sys
the GeoExplorer 3.



ns and their corresponding tabs. 

the arrow keys to highlight the 

section is File. When a data file 

r 3c edition.

 arrow keys to move around 
n menu. The tab that is 
y active is the highlighted tab. 

 to close the Main menu 
to the current tab.
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Main menu
Use the Main menu to move around the system and view sectio
Press ��  to display the Main menu.

For example, to move from the Chart tab to the Status tab, use 
Status tab and then press �.

NOTE When no data file is open, the only tab available in the DATA 
is open the New, Update, and Map tabs are all available.

NOTE The Map and Chart tabs are not available in the GeoExplore

Use the
the Mai
currentl
Press �
and go Current

tab

Section

DATA tabs
NAV tabs

SYS tabs

 keys



he satellites that the 
 and their relative positions in 
current position.
he GeoExplorer 3 hardware, 
l connections.

tionaries and feature settings. 
 the configuration. You can 
 data collection system to the 

 open an existing one.
 attributes.
ibutes.
 them for update.
 waypoints using the Road.
 waypoints using the 

 waypoints using the Chart.
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This table summarizes each of the tabs:

                        Use this tab … To …

SYS

GPS View information about t
GeoExplorer 3 is tracking
the sky, and to see your 

Status View information about t
accessories, and externa

Setup Create and edit data dic
Also, use this tab to edit
reset the GeoExplorer 3
factory defaults.

DATA

File Create a new data file or

New Collect new features and
Update Update features and attr
Map View features and select

NAV

Road Navigate to features and

Compass Navigate to features and
Compass.

Chart Navigate to features and



y
 the GeoExplorer 3 firmware.
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The GeoExplorer 3 displa
Some common displays are shown here to describe features of

Active section 

Status

Field 

Tabs

Buttons

Title

Field 
prompt

List

Message
box

value

 bar



isible, but the icons displayed 
formation about the status of the 

n
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Status bar
The status bar appears in the column on the right. It is always v
depend on the current status of the system. It provides basic in
GeoExplorer 3 data collection system.

Internal power icon

Satellite icon

Real-time icon
External antenna ico
Lock icon
Memory icon

Logging icon

Backlight icon



try of the satellites is good or 
 configuration settings. This 
 status bar. When the 

tion system is computing GPS 
 the satellite icon indicates 

ing used to compute positions. 
 warn you that the geometry of 
umber flashes to indicate that 
ble. You need a minimum of 
PS positions.

er 3 is computing real-time 
con flashes when the RTCM 
ils are displayed on
ure the real-time settings use 
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Icon Name Description
Satellite icon Shows whether the geome

bad depending on the GPS
icon is always visible in the
GeoExplorer 3 data collec
positions the number below
how many satellites are be
The satellite icon flashes to
the satellites is poor. The n
too few satellites are availa
four satellites to compute G

Real-time icon Show that the GeoExplor
positions. The real-time i
signal is lost. RTCM deta
The Status tab. To config
the Real-time button.

4



nal antenna is properly 
rnal antenna is connected this 
ot appear, there is a problem 
antenna (internal and 
layed on the Status tab. 

n setting or task is locked. To 
assword control.

evel is low (< 100 kB). This 
aining memory is critically 

ory details are shown on the 
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External antenna 
icon

Shows whether the exter
connected. When an exte
icon appears. If it does n
with the connection. The 
external) details are disp

Lock icon Shows that a configuratio
unlock it you must have P

Memory icon Shows that the memory l
icon flashes when the rem
low (< 10 kB)). The mem
Status tab

Icon Name Description



 is on. The backlight has two 
nd Bright. When the backlight 
 change the state of the 

.

ernal power source. This icon 
atus bar. The battery icon 
el of the power source is high. 
 source decreases, the level 
 decreases. The icon flashes 

l is low. The battery icon 
 the internal power is being 

etails are displayed on
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Backlight icon Shows that the Backlight
different states: Normal a
is off no icon is visible. To
backlight press ��

Internal power 
icon

Shows the level of the int
is always visible in the st
appears full when the lev
As the level of the power
shown by the battery icon
to warn you that the leve
appears to be filling when
charged. Power source d
The Status tab.

Icon Name Description

Normal 

Bright



xplorer 3 is successfully 
is icon appears to be drawing 

g GPS data. The number 
 indicates how many positions 
 current feature. The icon will 
meet the specified GPS 
g icon has three different 

lorer 3 is logging
e) measurements.
lorer 3 has paused while 
s. When logging is paused, 
ps recording GPS positions 
When you start logging again, 
sumes logging GPS positions 
o the logging icon.
eoExplorer 3 is logging carrier 

for Carrier phase data 
e station. Use the
n to configure a feature for 
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Logging icon Shows whether the GeoE
logging GPS positions. Th
when successfully loggin
displayed above the icon
have been logged for the
flash if conditions do not 
configuration. The loggin
states:

• Normal – the GeoExp
code phase (C/A cod

• Paused – the GeoExp
logging GPS position
the GeoExplorer 3 sto
and this icon flashes. 
the GeoExplorer 3 re
and the icon reverts t

• Logging carrier – the G
phase measurements 
collection or for a bas
Feature settings butto
carrier accuracy.

Icon Name Description

Normal

Paused

Logging 
carrier



xplorer 3  

n a variety of ways. The following 
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Interacting with the GeoE
data collection system
You can interact with the GeoExplorer 3 data collection system i
topics describe the keypad and the different types of displays:

• Keys

• Screens

• Lists

• Forms

• Option lists

• Pop-up messages

• Data entry



held.

rer 3 handheld on and off. 
 the GeoExplorer 3 when in 
 GeoExplorer 3 Support 

NAV sections to an active tab 
N.
the SYS section then pressing 
gh the SYS tabs.

AV sections to an active tab in 
.

 the DATA section then 
les through the DATA tabs.
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Keys
This table explains the various keys on the GeoExplorer 3 hand

Key Name Use this key to …

� Power On/Off power the GeoExplo
Also used to activate
standby mode in the
Module.

� SYS section move from DATA or 
in THE SYS SECTIO
If you are already in 

� cycles throu

� DATA section move from SYS or N
THE DATA SECTION
If you are already in
pressing � cyc



ATA sections to an active tab 
N.
the NAV section then pressing 
gh the NAV tabs.

ighlight.

ighlight.
ric digits in a numeric entry 

play.
 and saving features and data 

 to move up sub levels.

More...
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� NAV section move from SYS or D
in THE NAV SECTIO
If you are already in 

� cycles throu

 
� � Arrow keys move the cursor or h

	 
� 

Arrow keys move the cursor or h
Scroll through nume
field.

� Close close the current dis
This includes closing
files. Also press �

Key Name Use this key to …



d item.
ver you want to choose an 
en a field to edit.

me GPS logging.
 to control logging from almost 
t the GeoExplorer 3 data 

y is explained in
Advanced datalogging 

vanced options that are 
urrent screen.
ne or more advanced options 
.

More...
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� Enter select the highlighte
Press � whene
item from a list or op


 Log start, pause, or resu


 can be used
any place throughou
collection system.
Use of the 
 ke
Collecting data and 
options.

� Option display the list of ad
available from your c
Most screens have o
available via �

Key Name Use this key to …



y function of certain keys.
shown in blue on the keypad. 
function, press � and then 
 function key. You do not need 
s at the same time.
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� Function access the secondar
These functions are 
To use a secondary 
press the secondary
to hold down the key

Key Name Use this key to …



reen and cancel any changes.
es to GPS or feature 
be prompted to confirm the 

.
to select the tab you want to 

.

�, �, or � to 
propriate screen.

ast.

.
ings—Bright, Normal, and Off.

More...
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Function Use this key 
combination …

To …

Cancel ��� close the current sc
This includes chang
attributes. You may 
cancel operation.

Menu ��� go to the Main menu
Use the arrow keys 
go to, then press �
Alternatively, press 
go directly to the ap

Decrease contrast �� lighten display contr

Backlight �� control the backlight
There are three sett



ast.

he top of the current display. 
 cursor half a screen upwards.

he bottom of the current 
 the Map cursor half a screen 

ing of a list or form.
nd forms. Also moves the Map 
 to the left.

More...
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Increase contrast �� darken display contr

Page up �� page up.
Move the cursor to t
Also moves the Map

Page down �� page down.
Move the cursor to t
display. Also moves
downwards.

Home �� return to the beginn
Useful in long lists a
cursor half a screen

Function Use this key 
combination …

To …



ection system.

a list or form.
nd forms. Also moves the Map 
 to the right.
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NOTE For more information see Using the GeoExplorer 3 data coll

End �� return to the end of 
Useful in long lists a
cursor half a screen

Function Use this key 
combination …

To …



nerally graphical and provide 
ou view the information in a text 
ss other displays. 

S screen in the GPS tab. You 
nt modes. This example shows 

Advanced mode, and again to 
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Screens
In the GeoExplorer 3, the top level “screens” for each tab are ge
quick visual feedback. They have an advanced mode that lets y
format. Alternatively, a screen contains buttons that let you acce

This example shows the GP
can view this screen in differe
the Standard mode.

Press � to change to 
return to Standard mode.



reen in the Setup tab.

 that provide access to other 
ou cannot edit the information 

ther areas of the
n system. To select a button 
 keys to highlight it and then 
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This example shows a screen with buttons. This is the Select sc

Use screens to view information graphically or to select buttons
areas in the firmware. You cannot enter data in a screen, and y
displayed. 

Buttons provide access to o
GeoExplorer 3 data collectio
from a screen, use the arrow
press � .



nts the GeoExplorer 3 provides a 
available in the GeoExplorer 3 
e items.

elow the list. The message box 
 in the list. To close a list press 

 the list, one page at a time.

 list.

ate feature list, as shown in the 
st displays all features stored in 
a file. To select an item from a 
ow keys to highlight the item 

.
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Lists
When selecting data files, data dictionaries, features, or waypoi
“list”. A list contains the information that is currently stored and 
data collection system. A list always has a title that describes th

Often a message box is displayed at the bottom of the screen, b
provides useful information about the item currently highlighted
� .

Press �	 or �� to move the highlight up or down

Press �
 or �� to move to the first or last item in the

This is the Upd
title bar. This li
the current dat
list, use the arr
and press �

Title bar

Message box



ace in “forms”. These are like 
 fields.

lue. A prompt is followed by a 
ator fields, which have no value 

being highlighted. Any editing 
lect it by highlighting it and 

se a form to enter information. 

More...
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Forms
Data entry in the GeoExplorer 3 data collection system takes pl
paper forms, in that they have a title and a sequence of lines or

Each field generally has two parts, a prompt (or name) and a va
colon (:) that separates it from the value. Some fields are separ
and serve simply to divide a form into sections.

One field in every form is the current field. It is distinguished by 
operations on a form apply to the current field. To edit a field, se
pressing � .

Title

ValuePrompt

Current field

U



t as soon as the change is made. 

 page at a time. This is 
 to move to the first or last field in 

shed editing a field in the form, 
ture attribute entry form is open, 
GeoExplorer 3 Operation Guide Reference
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There are three ways to enter data into a form:

• Text entry

• Numeric entry

• Pop-up list

A form is “live”. When you edit a field, the new value takes effec

Press �	 or �� to move up or down the form, one
equivalent to page up and page down. Use �
 or ��
the form. This is equivalent to Home and End.

When you have finished browsing through the form, or have fini
press � to return to the previous screen or list. When a fea
you can also press �� to abandon the feature.



e firmware you can press the 
when the Road tab is active. The 

l bar appears on the right. Use 

 the option list, one page at a 
n in the list. To close an option 

nt option in a list is highlighted. 
 a different option, press 	 or 
ove the highlight and then press 

More...
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Option lists
Option lists display additional functionality. In some places in th
� key to display the options. For example, press � 
following options appear:

If an option list has more options than fit on one screen, a scrol
	 or � to scroll up and down the list.

Press �	 or �� to move the highlight up or down
time. Press �
 or �� to move to the first or last optio
list press � again, or press � .

Current 
The curre
To select
� to m

� . 

option
Option
list



. For example, if you select the 
list appears:

 the sublist, one page at a time. 
 sublist. To close a sublist press 

urrent option in a sublist is 
ghted. To select a different 
, press 	 or � to move the 

ght and then press � . 

More...
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Sublists
Some options open into a sublist. A sublist relates to that option
Filter option from the Update feature option list, the Filter by sub

Press �	 or �� to move the highlight up or down
Use �
 or �� to move to the first or last option in the
� .

Update feature

Current

Filter by

Filter 

The c
highli
option
highli option

 sublist

option list



ical fashion. If you position the 
 highlight moves to the last 
 last option and press � the 

Scroll bar

Checklist
title
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Checklists
Some option lists open into a checklist. If 
you select Info windows from the Road 
option list, for example, the Info windows 
checklist appears:

To select an item in a checklist, use the 
arrow keys to highlight it and then press 
� . When it is selected a 
✓ appears in the box on the left. To clear 
a ✓ , use the arrow keys to highlight the 
item and press � . The ✓ is 
removed.

To close a checklist and save your 
changes press � . To cancel any 
changes press �� .

NOTE All option lists, sublists, forms, and checklists scroll in a cycl
highlight on the first (top) option in the list and press 	 the
(bottom) option. Similarly, if you position the highlight on the
highlight moves to the top option.



s up”.   When the GeoExplorer 3 
ops up with two buttons, one of 
To do this, press 
 or � to 
en press � .

 for Yes/No questions.

ample of a pop-up message. 
essages should be noted, 

t information about the task you 

creen press �.

Explorer 3 messages.
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Pop-up messages
Occasionally, a message “pop
asks a question, a message p
which you select in response. 
highlight your response and th

TIP Press � to select No

The Error screen is another ex
Warning! and Error! m
because they contain importan
are trying to perform.

To clear a message from the s

For more information see Geo



end on the type of data to be 
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Data entry
There are three ways to enter data. The methods available dep
entered:

• Text entry

• Numeric entry

• Pop-up list



d contains the following:

• Function bar

ess � to view the
ption list.
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Text entry
You can enter text using the text entry field.

Use the Edit bar and characters to enter text. The text entry fiel

• Attribute/Field name • Edit bar

• Characters • Close bar

Attribute/Field name

Function bar

Characters

Edit bar

Close bar

Cursor
Pr
O



ibute or field.
 cursor flashes to indicate its 

rs to the left of the cursor. To 
 highlight the BKSP � 

.

the Edit bar. Use the arrow keys 
and then press � .

 characters from uppercase to 
 the arrow keys to highlight the 

.
ntry. To insert a character in 
 highlight the desired 

More...
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General operation

Use this area … To …
Attribute/Field name View the name of the selected attr
Edit bar Enter or change the text value. The

current location in the Edit bar.
Function bar • Use BKSP � to delete characte

backspace use the arrow keys to
function and then press �

• Use SPACE to insert a space in 
to highlight the SPACE function 

• Use the A➜ a function to change
lowercase (and vice versa). Use
A➜ a function and then press �

Characters Select the characters for the text e
the Edit bar, use the arrow keys to
character and then press � .



 any changes. To save the 
 keys to highlight Close (at 
 press � . You can also 

e form to save the new text 
. To cancel any changes and 
� .
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Close bar Close the text entry field and save
entry in the Edit bar, use the arrow
the bottom of the keypad) and then
press �  from anywhere in th
and go to back to the previous form
restore the original value, press �

Use this area … To …
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Option list

Press � , from the text entry field, to view the options.

 The options are:

• Clear • Change style



ly entered in the Edit bar.
 that you can select. Choose 
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General operation

Use this option... To...
Clear Clear (delete) the text that is current
Change style Change the layout of the characters

from ABCDEF and QWERTY.



ata into.
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Numeric entry
There are two types of numeric entry fields that you can enter d

• Single numeric entry

• Multiple option numeric entry



try, a field similar to this appears:

s highlighted press 	 or� to 
t of each other. Press � to 
 becomes the new value for the 
entry “field” and save changes.

anged it) press �� .

ll is 9, press � to change the 
ge the value to 9.
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Single numeric entry

When you select a numeric field that requires single numeric en

It contains a title, units and numeric cells. 

To enter a value, press 
 or � to highlight a cell. When a cell i
scroll the value in the cell from 0 to 9. The cells are independen
save the new value. When you press � the value entered
selected field. You can also press � to close the numeric 

To cancel changes and restore the original value (before you ch

NOTE The cells scroll in a circular fashion. When the value in the ce
value to 0. When the value in the cell is 0, press 	 to chan

Title

Units

Cell



d similar to one of these appears:

umeric cells, and three options. 
ption has a highlighted radio 
rn is the selected option.

e corresponding radio button is 

More...
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Multiple option numeric entry

When you select a numeric field that has multiple options, a fiel

In the Warning distance field shown here, there is a title, units, n
Each option has a corresponding “radio button”. The selected o
button surrounded by a shaded box. In this example, Always wa

To change the option that is selected, press 	 or � until th
highlighted.

Cell

Title

Units

“Radio button”

Options

Title

Selected
option



ighlight a numeric cell. When you 
button disappears to indicate that 
� to scroll the number in that 
he cells are independent of each 

 the value of the selected 

� to close the numeric 

fore your changes) press 

e cell is 9, press� to change 
change the value to 9. 
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To change the value for the selected option, press 
 or � to h
highlight a cell, the shaded box around the corresponding radio 
a numeric cell is selected. With a cell highlighted press, 	 or 
cell from 0 through 9. To move between cells, press 
 or �. T
other. Press � to save the new setting. When you press �
option becomes the new value for the field. You can also press 
entry field and save changes.

To cancel changes and restore values to the original setting (be
�� .

NOTE Values in a cell scroll in a cyclical way. When the value in th
the value to 0. When the value in the cell is 0, press 	 to 



p list appears:

rent value, press 	 or � to 

More...
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Pop-up list
When you select a field that has many possible values, a pop-u

The current value in a pop-up list is highlighted. To select a diffe
move the highlight and then press � . 

Field name

List of values for
the selected field



 bar appears on the right. Use 

light on the first (top) value in 
 value. Similarly, if you position 
ighlight moves to the top value.
GeoExplorer 3 Operation Guide Reference
General operation

If a pop-up list has more options than fit on one screen, a scroll
	 or � to scroll up and down the list.

NOTE A pop-up list scrolls in a cyclical way. If you position the high
the list and press 	 the highlight moves to the last (bottom)
the highlight on the last value in the list and press � the h

Scroll bar



ta collection system, you can set 
der® Office software to indicate 
re information refer to the 

ettings to be changed. If you 
e settings to be altered, lock 

ears in the Status bar.

More...
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Password control
To lock configuration settings and tasks on the GeoExplorer 3 da
a password. Use the Configuration Manager in the GPS Pathfin
which configuration settings and tasks are to be locked. For mo
Pathfinder Office online Help.

Locking and unlocking is useful when you do not want certain s
create a configuration for a certain job and you do not want som
them by applying a password.

When configuration settings or tasks are locked, a lock icon app

Lock icon



ld value as well as in the status 

.) You are prompted to enter 
rd the field unlocks and you can 

 data collection system remains 
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When a field is locked, the lock icon appears to the left of the fie
bar.

To edit a locked field, select it. (Highlight the field and press �
the password using Text entry. If you enter the correct passwo
edit the field. 

NOTE If a configuration setting or task is locked, the GeoExplorer 3
password locked when turned off.

Lock icon in field

Lock icon in status bar



etting, you can remove the lock. 
 this, press � from the top 
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Re-lock option
If you need to make changes to a locked task or configuration s
To prevent further changes, lock the field again afterwards. To do
level of The Setup tab (the Select screen) and select Re-lock.



GeoExplorer 3 Operation Guide Reference
SYS section – Introduction

�*������������&
Use the SYS section to view GPS satellite information, check your current position, check the 
hardware status, and determine the quality of the GPS signal being received. Use it to configure 
the GeoExplorer 3 data collection system settings, create or edit data dictionaries, and alter 
feature settings.

Press � to move between the tabs in the SYS section. They are:

• The GPS tab • The Status tab • The Setup tab



e. The Standard mode screen 

PS status. It contains:

• Signal strength

e GPS tab to view information 
the satellites that the 
xplorer 3 is tracking, and their 
e positions.

 � to view the 
ced mode.
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��	�
#����+
� / GPS

To display the GPS tab, press � until the GPS tab is activ
appears:

The Standard mode of the GPS tab is a graphical view of the G

• Skyplot • Current GPS position

• Satellite geometry

Skyplot

Signal  
Use th
about 
GeoE
relativ

Press
Advan

strength

Current

Satellite
geometry

position



tellites available to the receiver:

 represents the configured 
r circle of the skyplot moves 
ets smaller and only those 
If the elevation mask is 
e horizon are used to compute 

k

r

More...
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Skyplot
The skyplot provides a graphical display of the position of the sa

The outer circle represents the horizon (at 0° ). The inner circle
Elevation mask. When the elevation mask is changed, the inne
accordingly. If the elevation mask is increased, the inner circle g
satellites higher in the sky are used to compute GPS positions. 
decreased, the inner circle gets larger and satellites closer to th
GPS positions.

Skyplot

Horizon

Elevation mas

North indicato

Satellites
overhead



he GeoExplorer 3 data collection 
 the sky (overhead), while those 
ne satellite can be determined by 
e skyplot.

xes are currently being used by 
te GPS positions. Satellites with 
d, but are not being used to 
 with no boxes are available, but 
 GeoExplorer 3.

mpass) to indicate what direction 
 in.

 speed or faster, or if you have 
 Calibration.
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Numbered boxes represent the satellites currently available to t
system. The satellites near the center of the circle are higher in
toward the edge are closer to the horizon. The location of any o
noting its direction (N, S, E, W) and approximate elevation in th

Satellites shown as black bo
the GeoExplorer 3 to compu
clear boxes are being tracke
compute positions. Satellites
are not being tracked by the

The skyplot rotates (like a co
the GeoExplorer 3 is pointing

NOTE The skyplot only rotates if you are moving at a brisk walking
calibrated the internal digital compass. For more details, see



. It displays the coordinates, 

nate system and datum. If the 
nfiguration use the Coordinates 

, open a data file and start a 

es the sky for satellite signals. It 
se to compute the current GPS 
figured GPS settings. The 
nimum of four satellites to 
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Current GPS position
The current GPS position is shown at the bottom of the GPS tab
altitude, and datum:

Values are displayed in terms of the currently configured coordi
datum name is too long, it appears truncated. To change this co
form.

For more information see Coordinate systems.

NOTE Positions viewed on the screen are not saved. To save them
feature or create a waypoint.

The GeoExplorer 3 search
then determines which to u
position, based on the con
GeoExplorer 3 needs a mi
compute GPS positions.

Altitude and datum
Coordinates



ptive message when the 
ting GPS positions.

atellites and to calculate the 
osition. While the first position is 

splayed once per second.

e computed, look for 
 might be blocking satellite 
ay from any possible 
e GeoExplorer 3 is still not 

ons, see Troubleshooting.

More...
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Message box
The message box at the bottom of the screen displays a descri
GeoExplorer 3 data collection system is not successfully compu

When you turn the GeoExplorer 3 on, it begins to track visible s
current position. It takes up to 45 seconds to calculate the first p
computed, a ? appears in place of the current GPS position.

Once the first position is displayed, subsequent positions are di

TIP If no positions ar
obstructions that
signals. Move aw
obstructions. If th
computing positi



 satellites are available, two 
ges indicate that the GPS 
atellites to compute a new one.

 the number below the satellite 
en when the GPS tab is not 

More...
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If the GeoExplorer 3 stops computing positions because too few
warning messages alternate in the message box. These messa
position displayed is an old position and that there are too few s

NOTE When there are too few satellites to compute GPS positions,
icon in the Status bar flashes. This icon is always visible, ev
active.



e geometry is poor, two warning 
ate that the GPS position 

es is poor.

 in the Status bar flashes. This 
GeoExplorer 3 Operation Guide Reference
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If the GeoExplorer 3 stops computing positions because satellit
messages alternate in the message box. These messages indic
displayed is an old position and that the geometry of the satellit

NOTE When the geometry of the satellites is poor, the satellite icon
icon is always visible, even when the GPS tab is not active.

For more information see Satellite geometry.



e signal quality of each satellite 
 of a satellite must be sufficient 
 a satellite with a signal strength 
 satellite that is not being used to 
gured minimum level.)
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Signal strength
The signal strength bar graph is a graphical representation of th
that the GeoExplorer 3 is currently tracking. The signal strength
before it can be used by a GPS receiver. A black bar represents
above the configured minimum level. An empty bar represents a
compute GPS positions. (The signal strength is below the confi

To change the minimum level, use the GPS slider bar.

Strength
of signal
bar graph

Minimum
 level



el on the indicator is high. If 
mputed positions is reduced. 

Explorer 3 stops computing GPS 
To change it, use the GPS slider 

Level of quality
Minimum level

Satellite geometry
indicator
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Satellite geometry
The satellite geometry indicator is a 
graphical representation of the overall 
quality of the GPS positions 
computed.

The quality of the computed positions 
is a function of the geometry of the 
visible satellites (how they are 
positioned in the sky relative to each 
other). When the satellites are well 
spaced, and cover a large portion of 
the sky, the GeoExplorer 3 data 
collection system is able to compute accurate positions. The lev
satellites are grouped together in the sky, the accuracy of the co
The level on the indicator is low.

When the level of quality falls below the minimum level, the Geo
positions. The minimum level accepted is a configurable value. 
bar.



elect Advanced mode.

on:

 PDOP mask.

lev

lmanac

en to view information about 
text. The message bar at the 
 screen displays Almanac 
nd the current PDOP.

the Standard mode press 
 select Standard mode.
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Advanced mode 

� / GPS / � / �Advanced mode

To display the GPS tab in Advanced mode, press � and s

Advanced mode of the GPS tab displays the following informati

NOTE Use the GPS slider bar to configure the elevation, SNR, and

• PRN • SNR • E

• Br(T) or Br(M) • PDOP • A

Use this scre
satellites as 
bottom of the
information a

To return to 
� and

Message box



e. This number is used to 
e is currently being used by 

appears to the left of the 

ellite. The signal strength of a 
tent of the signal, relative to 
llite at 30° elevation is 

S position is degraded if the 
lation falls below 6.0.
ts you set the SNR mask. 
signal strength of a satellite is 
GPS receiver. If a satellite’s 
t satellite is not used to 

hy' by the GPS Control 
ear in the SNR column for 

More...
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This 
column...

Lists...

PRN The pseudorandom number of each satellit
uniquely identify each satellite. If the satellit
the GeoExplorer 3 to compute positions, a ✓
PRN.

SNR The current signal-to-noise ratio of each sat
satellite is a measure of the information con
the signal’s noise. The typical SNR of a sate
between 10.0 and 15.0. The quality of a GP
SNR of one or more satellites in the constel
The GeoExplorer 3 data collection system le
This value is used to determine whether the 
sufficient for that satellite to be used by the 
SNR is below the configured SNR mask, tha
compute positions.

NOTE If a satellite is marked as 'unhealt
Segment, the characters 'U/H' app
that satellite. 



ach satellite. A satellite that is 
used to compute positions.
earing is shown relative to 
as determined by the currently 
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SYS section – The GPS tab

Elev The current elevation above the horizon of e
below the configured Elevation mask is not 

Br(T) or 
Br(M)

The current bearing to each satellite. This b
either true north (T) or magnetic north (M), 
configured North reference. 

This 
column...

Lists...



ction of the geometry of the GPS 
tellites are well separated in the 
 more satellites are close 
erent in measuring their signals 

 with GPS. These factors give an 
stem (GPS). DOP factors are 
 best. The best overall indicator 
n, or PDOP.

More...
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PDOP
The accuracy of a position computed by a GPS receiver is a fun
constellation visible at that moment in time. When the visible sa
sky, the GPS receiver can compute accurate positions. If two or
together at the time the position is recorded, the small errors inh
compound, reducing the accuracy of computed positions.

There are several Dilution of Precision (DOP) factors associated
indication of the expected accuracy of the Global Positioning Sy
linear multipliers on the expected error, so a small DOP value is
of satellite constellation geometry is Position Dilution of Precisio



 shows how PDOP values are 

mask as an upper bound on 
accuracy, and makes sure that 
imbs above this mask, the 
d by the satellite icon in the 
GeoExplorer 3 Operation Guide Reference
SYS section – The GPS tab

The PDOP value is a measure of positional accuracy. This table
categorized.

The GeoExplorer 3 lets you specify a PDOP mask. It uses this 
PDOP values. You can configure the desired level of positional 
the positions logged are of a certain quality. When the PDOP cl
GeoExplorer 3 stops computing GPS positions. This is indicate
Status bar.

PDOP level Quality
1 to 4 Excellent
4 to 6 Good
6 to 8 Fair
8 to 12 Poor
12 to 100 Very poor
100 and above Unusable



 over a moderately long period of 
ation and information about the 
r time).

 new almanac. It can also collect 

f the Advanced mode screen 
ate of the current almanac.
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Almanac
An almanac is a set of data that is used to predict satellite orbits
time, usually about a month. The almanac contains clock inform
orbital path for each satellite (where it is in the sky at a particula

The GeoExplorer 3 takes approximately 15 minutes to collect a
an almanac and compute positions at the same time.

An almanac is required by Trimble’s Quick Plan software.

For more information refer to the Pathfinder Office online Help.

The bottom o
displays the d

Almanac date



ctive. It appears in Standard 

rmation about the GeoExplorer 
nd external connections.

tatus tab in DGPS mode.
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��	����������+
� / Status

To display the Status tab, press � until the Status tab is a
mode.

In Standard mode, the Status tab displays:

• Hardware

• Accessories and external connections

Use this screen to view info
3 hardware, accessories, a

You can also display the S



hown on the inside of the 

Number of files to transfer
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Hardware
Information about the status of the GeoExplorer 3 hardware is s
GeoExplorer 3 diagram.

This screen displays the following hardware information:

• Memory gauge • Power level •

Number of
kilobytes free

Number of 
files to
transfer

Power 
remaining Power gauge

Memory
gauge



rtion of the GeoExplorer 3 
ailable. The lower the level on 
ilable. The higher the level on 
able. The number of kilobytes 

 indicated by the power gauge 
played on the bottom right of 

e level on the gauge, the more 
el, the less internal power 
wer is indicated on the left of 

an office computer is indicated 
gram. This number indicates 

that have not been transferred 
stem to an office computer.
GeoExplorer 3 Operation Guide Reference
SYS section – The Status tab

Display Description
Memory gauge The memory gauge is shown in the top po

diagram. It shows the level of memory av
the gauge, the more memory there is ava
the gauge, the less memory there is avail
(KB) free is also displayed.

Power level The amount of internal power remaining is
and a percentage. The power gauge is dis
the GeoExplorer 3 diagram. The higher th
internal power remains. The lower the lev
remains. The percentage of remaining po
the power gauge.

Number of files 
to transfer

The number of files not yet transferred to 
in the bottom left of the GeoExplorer 3 dia
the number of data files, base and rover, 
from the GeoExplorer 3 data collection sy



l 

tions is shown in the four panels 

• Power
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Accessories and externa
connections
Information about accessories and the status of external connec
surrounding the GeoExplorer 3 diagram.

This screen displays the following information:

• Real-time • Antenna • Transfer

 
 

Real-time 

Power

Antenna

 Transfer



 the GeoExplorer 3 data 
ns is displayed:

xplorer 3 data collection 
elt (BoB) receiver. The current 

 panel. The possible states are 
le. The current frequency 
yed below the beacon icon. 
n indicates the SNR (signal-to-

 beacon signal being received. 
t locked onto a frequency, then 
ing to track is displayed, and 

lorer 3 is using an external 

lorer 3 is not configured to 

More...
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This 
panel …

Shows …

Real-time The current real-time status. Depending on how
collection system is configured, one of three ico

Beacon – Indicates that the GeoE
system is using the Beacon-on-a-B
status is indicated at the top of the
Locked, Tracking, Searching, or Id
being tracked/locked onto is displa
The histogram on the left of the ico
noise ratio) of the differential GPS
If the differential GPS beacon is no
the frequency that it is currently try
the SNR histogram is empty.

Other – Indicates that the GeoExp
radio for real-time corrections.

None – Indicates that the GeoExp
receive real-time corrections.

None



oExplorer 3 data collection 
l antenna.

plorer 3 is using the internal 

More...
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Antenna The type of antenna in use.

This 
panel …

Shows …

Connected – Indicates that the Ge
system is connected to an externa

Built-in – Indicates that the GeoEx
antenna.

Built-in



ble states:

rer 3 is not sending or 

icates that the GeoExplorer 3 
. Movement along the cable 
rred. A message Complete 
en data transfer is done, 

transfer was unsuccessful. The 
ferred is indicated on the 

lorer 3 is outputting NMEA 

More...
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Transfer The data transfer status. There are three possi

This 
panel …

Shows …

IDLE – Indicates that the GeoExplo
receiving data.

IDLE

Connected and transferring – Ind
is connected to an office computer
indicates that data is being transfe
appears above the transfer icon wh
Failed indicates that the data 
number of bytes successfully trans
bottom of this icon.

NMEA – Indicates that the GeoExp
messages.



pe of power source, one of 

xplorer 3 is using the internal 

 an external power source.

ected to an external power 
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Power The type of power source. Depending on the ty
three icons is displayed:

This 
panel …

Shows …

Internal – Indicates that the GeoE
power source.

Internal

External – Indicates that it is using

Charging– Indicates that it is conn
source and is charging.



 select DGPS mode:

• Beacon mode

• Input level

• BoB receiver battery level

time information status of the 
ed format.
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DGPS mode
� / Status / � / �DGPS mode

To display the Status tab in the DGPS mode, press � and

In DGPS mode, the Status tab displays information about:

• DGPS status • Frequency

• SNR • Error rate

• Last RTCM • Beacon state

• Filter applied

Use this screen to view real-
GeoExplorer 3, in a text bas



al-time corrections. There are 

 When the GeoExplorer 3 uses 
s, one of these values appears 
es the status of the real-time 

 source rather than the BoB 

 real-time corrections.

 Off, the other fields show N/A.
 is being tracked/locked onto. 
3.5 kHz and 325 kHz.

More...
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Field Description
DGPS status Whether the GeoExplorer 3 is receiving re

three states:

• Locked / Tracking / Searching / Idle –
the BoB receiver for real-time correction
in the DGPS status. Each value describ
corrections currently being received.

• On –The GeoExplorer 3 is using a radio
receiver for real-time corrections.

• Off – The GeoExplorer 3 is not receiving

NOTE When the DGPS status is On or
Frequency The current frequency of the satellite that

The available frequencies are between 28



ode it will trace the best 
uencies if its current frequency 

 mode it will track one 
ency unless you alter the 

cibels (dB), of the differential 
 6.0 indicates that the signal is 

umber of RTCM words with 
tion. An error rate of below 0.1 

 field, measured in decibels 
). An input level between 10 
.
 seconds) since the last 

Explorer 3. The Last RTCM 
r correction values yield greater 

More...
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Beacon mode Best – when the BoB receiver is in Best m
frequency that it can, and will change freq
becomes unsatisfactory.
Fixed – when the BoB receiver is in Fixed
frequency and will not alter from this frequ
frequency manually on the BoB receiver.

SNR The signal-to-noise ratio, measured in de
GPS beacon frequency. An SNR of above
usable.

Error rate The RTCM Word Error Rate. This is the n
parity errors, expressed as a decimal frac
is acceptable.

Input level The intensity level of the electro-magnetic
above one microvolt per meter (dMµ V/M
dBµ V/M and 100 dBµ V/M is acceptable

Last RTCM The Last RTCM field indicates the time (in
RTCM message was received by the Geo
value should be less than 30 seconds. Newe
precisions than older values.

Field Description



elds can appear as N/A.

 BoB receiver. Possible 
nd Unmonitored. The 
rential GPS beacon 
al-time.
ys the remaining battery 
a percentage.
a filter has been applied to the 
GeoExplorer 3 Operation Guide Reference
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NOTE Depending on how the GeoExplorer 3 is configured, these fi

Beacon state The health of the signal received from the
settings are Healthy, Unhealthy, a
GeoExplorer 3 will not use unhealthy diffe
corrections to correct GPS positions in re

BoB receiver 
battery level

The BoB receiver battery level field displa
power of the BoB receiver, expressed as 

Filter applied The Filter applied field indicates whether 
frequency list on the BoB receiver.

Field Description



tive. The Select screen appears:

• Feature settings

ate and edit data dictionaries, 
 to edit the configuration. You 
xplorer 3 data collection 
faults and find out about the 

ght it and press �.
 the Re-lock option.
GeoExplorer 3 Operation Guide Reference
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��	��	������+
� / Setup

To display the Setup tab, press � until the Setup tab is ac

The buttons are:

• Configurations • Data dictionaries

• About • Reset

Use the Setup tab to cre
edit feature settings, and
can also reset the GeoE
system to the factory de
unit.

To select a button, highli
Press � to display



ets the parameters that 
unicated to external devices.
on screen appears.
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Configurations
� / Setup / Configurations

Select the Configurations button to edit the configuration. This s
determine how data is collected, entered, displayed, and comm
Select Configurations from the Setup tab. The Edit configurati



iguration form appears:

• Real-time

• Formats

a configuration form to view 
 some critical configurations 
r example, GPS is a critical 
o set non-critical 
 application or preferences. 
 Edit configuration screen.
GeoExplorer 3 Operation Guide Reference
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Edit configuration
� / Setup / Configurations

The Edit configuration screen displays configuration buttons:

When you select a configuration button, the corresponding conf

• Data • GPS

• Coordinates • Units

• COMMS • Other

Use this screen to select 
or edit. You can configure
before collecting data. Fo
configuration. You can als
configurations to suit your
Press � to close the



ata form appears:

• Log velocities

• Warning distance

igure how the data is collected. 
e GeoExplorer 3 pops up a list 
prompts you to enter data. 
 Data form.
GeoExplorer 3 Operation Guide Reference
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Data

� / Setup / Configurations / Data

Select the Data button from the Edit configuration screen. The D

These fields are available in the Data form:

• Log between features • Log PPRT data

• Antenna height • Allow GPS update

• Filename prefix

Use the Data form to conf
When you select a field, th
of entries for that field, or 
Press � to close the



Default value

sitions when 
ail that shows 
session. (Log 
et the logging 

collection 
s a feature is 
n a feature is 
logging 

referred to as 
finder Office 
ing software.

Off

More...
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Use this 
field …

To …

Log between 
features

Specify the interval between feature GPS po
you are between features. This provides a tr
where you travelled during a data collection 
between features is a Numeric entry field. S
interval in time or distance units.)

NOTE By default, the GeoExplorer 3 data 
system does not log positions unles
selected. To log GPS positions whe
not selected refer to Advanced data
options.
Positions between features may be 
‘Not in feature’ positions in the Path
software and other Trimble datalogg



al-time data 
s real-time 
rce other 
xtra 
PPRT) 
data for 
corrections, 
PPRT data 
s in the

No

he items in No

Default value

More...
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Log PPRT 
data

Log the extra data needed to postprocess re
when you return to the office. To postproces
data using differential corrections from a sou
than that used in the field, you need to log e
information. This postprocessing real-time (
information is used to prepare the real-time 
postprocessing. Then, using the differential 
the data is postprocessed in the office. The 
can provide even greater accuracy. The item
Pop-up list are:

• Yes

• No
Log 
velocities

Select whether or not to log velocity data. T
the pop-up list are:

• Yes

• No

Use this 
field …

To …



 height is the 
e you are 
y field.

1.00 m

e updated 

u can log new 
 positional 

 cannot 
tored for that 
 the 

Yes

Default value

More...
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Antenna 
height

Enter the height of the antenna. The antenna
height of the GPS antenna above the featur
collecting. Antenna height is a Numeric entr

Allow GPS 
update

Specify whether or not positional data can b
(replaced). The items in the Pop-up list are:

• Yes – When you are updating a feature yo
GPS positions. This new data replaces the
information stored for the feature.

• No – When you are updating a feature you
update (replace) the position information s
feature. You can update attributes, but not
position(s).

Use this 
field …

To …



iginal feature 
e is 
 a warning 
if you try to 
than 5 m 
 This is a 

orrections, 
 m. A warning 
itable unless 
orrections in 

Always warn

Default value

More...
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Warning 
distance

Specify the warning distance between the or
and your current position. When this distanc
exceeded, a warning appears. For example,
distance of 5 m means that you are warned 
log GPS positions for a feature that is more 
away from the previously collected position.
Numeric entry field.

NOTE When you are not using real-time c
positions are accurate to within 100
distance of less than 100 m is not su
you are using real-time differential c
the field.

Use this 
field …

To …



 record. This 
tically 
enerated 
 This is a

The filename 

R

Default value
GeoExplorer 3 Operation Guide Reference
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Filename 
prefix

Specify a single letter to identify the files you
is the first letter of the name of each automa
generated file. The rest of the file name is g
using the date and UTC time it was created.
Text entry field.

NOTE This field does not affect base files. 
prefix for base files is always “B”.

Use this 
field …

To …



PS slider bar appears:

ghted cell represents the current 

ation changes accordingly.) As 
 as a filter that accepts positions 

r 3 data collection system filters 
el of quality. Use a high setting 

lider bar to configure the 
lity) required for GPS positions. 
isplay the GPS slider bar in 
de.

 to close the GPS slider bar.

More...
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GPS
� / Setup / Configurations / GPS
Select the GPS button from the Edit configuration screen. The G

The GPS slider bar has nine settings from High to Low. A highli
setting.
To change the GPS slider bar setting, press 
 or �. (The anim
you move the setting from High to Low, the GPS slider bar acts
that are less precise.
When the GPS precision is set to a high value, the GeoExplore
out, and will not use positions that do not meet the specified lev
when a project requires high precision.

Slider

Animated

9

1
Use the GPS s
precision (qua
You can also d
Advanced mo
Press �

 bar

symbol 

Current
setting



l of quality is lower. The 
tting to collect more positions, 

 tree canopy can obstruct your 
s to be recorded. Some positions 
 makes sure that there are fewer 
ision of the positions collected is 
e able to map the entire area.
sents the current GPS slider bar 
es to indicate that the tolerance 

t you configure the slider bar to 

 flashes to warn that the satellite 
llite geometry. Alternatively, stay 
 adjust the GPS slider bar.

etting is adjusted.
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When the GPS precision is set to a low value, the specified leve
GeoExplorer 3 does not filter as many positions. Use a lower se
including those that are slightly less precise.
If you are working on a project in a forest area, for example, the
view of the sky. Adjust the GPS slider bar to allow more position
may be of a lower quality but the increased number of positions
gaps in the data collected. If the setting is too high, and the prec
high, positions may not be collected as often and you may not b
At the bottom of the screen is an animation that graphically repre
setting. As the setting moves from High to Low, the circle enlarg
for accepting positions lessens. 

NOTE This GPS setting is a critical parameter so it is important tha
suit the environment.

TIP If you are collecting data and the satellite icon in the Status bar
geometry is bad, try changing your position to improve the sate
where you are and wait for the satellite geometry to improve, or

NOTE A change to the GPS slider bar takes affect as soon as the s



 and select Advanced mode.

 the GPS fields instead of an 

• Elevation mask

der bar to configure the 
r quality required for GPS 

Custom box to use the
ption.

 to change back to the 
ode.

More...
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Advanced mode

� / Setup / Configurations / GPS / � 

To display the Advanced mode of the GPS slider bar, press �

Advanced mode is similar to the Standard mode, but it displays
animation. The following fields are shown:

• PDOP mask • SNR mask  

• Minimum satellites • 2D altitude

Use the sli
precision o
positions. 
Select the 
Custom o
Press �
Standard m

9

1
5

Current
setting

Custom
check box

GPS
 form



 this setting, the GPS fields 
ar acts as a filter that accepts 

ation mask, Minimum satellites, 
s:

ge a setting in one, this is 
s the same in the two modes.

Minimum 
satellites

2D altitude

4 N/A
4 N/A
4 N/A
4 N/A
4 N/A
4 N/A
4 N/A
4 N/A
4 N/A
GeoExplorer 3 Operation Guide Reference
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To change the slider bar setting press 
 or �. As you change
change accordingly. As you move from High to Low, the slider b
more or less precise positions.
Each position on the slider bar has a specific PDOP, SNR, Elev
and 2D altitude associated with it. This table shows these value

NOTE The Standard and Advanced modes are related. If you chan
reflected in the other. The position on the slider bar is alway

Position on 
slider bar

PDOP mask SNR mask Elevation 
mask

1 (far left) 20 2 5
2 12 2.5 10
3 8 3 12
4 7 3.5 13
5 6 4 14
6 5.5 4.5 14
7 5 5 15
8 4.5 5.5 15
9 (far right) 4 6 15



til the Custom box is highlighted.

ove between fields in the GPS 
te Data entry field appears.

• Elevation mask

 box is selected, use the GPS 
the parameters that affect the 
PS positions.

More...
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Custom option

To display the Custom option of the GPS slider bar, press � un

These fields are available in the GPS form:

When the Custom check box is selected, press 	 or � to m
form. To edit a field, select it, and press �. The appropria
Press � to close the Advanced/Custom GPS form.

• PDOP mask • SNR mask 

• Minimum satellites • 2D altitude

When the Custom
form to configure 
precision of the G

Custom
check box

GPS
 form



cannot change the mode when 

ask, the change is reflected on 
m level mark on the position 
um level mark on the signal 

e inner circle on the skyplot.

More...
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NOTE The custom option is only available in Advanced mode. You 
the Custom box is selected. 

NOTE When you adjust the PDOP mask, SNR mask, or elevation m
The GPS tab. The PDOP mask is represented by the minimu
quality indicator. The SNR mask is represented by the minim
strength bar graph. The elevation mask is represented by th



Default 
value

ses this value as an 
program a desired 
hat any positions 
DOP goes above 

g GPS positions and 
his is a Numeric 

ou log more 
ay be seriously 
 mask and use 

ify the brief times of 
 and compromise the 
le other activities 
not set the PDOP 
 significantly 

ions, without 

4.0

More...
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Use this 
field …

To …

PDOP mask Specify a PDOP mask. The GeoExplorer 3 u
upper limit to the PDOP value. This lets you 
level of positional accuracy, and make sure t
logged are of a certain precision. When the P
this mask, the GeoExplorer 3 stops computin
the satellite icon appears in the Status bar. T
entry field.

CAUTION Increasing the PDOP mask lets y
positions, but the quality of these positions m
degraded. It is better to retain a lower PDOP
Trimble’s mission planning software to ident
high PDOP, than to continue collecting data
accuracy of the positions collected. Schedu
during these times. Conversely, you should 
mask too far below the default. A low setting
decreases the number of GPS feature posit
significantly increasing the precision.



R mask). This value 
gth of each satellite 
 GPS receiver. If a 

R mask, it is not 
 entry field. 
tio see SNR.

eoExplorer 3 data 
r signals. This may 
ere the GPS signal is 
duce GPS precision.

6.0

Default 
value

More...
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SNR mask Specify the signal-to-noise ratio mask (or SN
is used to determine whether the signal stren
is sufficient for that satellite to be used by the
satellite’s SNR is beneath the configured SN
used to compute positions. This is a Numeric
For more information about signal-to-noise ra

CAUTION If you lower the SNR mask, the G
collection system uses satellites with weake
increase GPS coverage in environments wh
weakened (such as in forests), but it may re

Use this 
field …

To …



r 3 can only use 
 sky to compute 

er than 15° , given 
lower the elevation 
ric noise associated 
 any improvement in 
e effects of 
 are used.

sk for a rover is set 
 the base station 
ible to each rover. As 
ence between the 
comes more critical 
f thumb, the 

km between the base 

15°

Default 
value

More...
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Elevation 
mask

Specify the elevation mask. The GeoExplore
satellites above the specified elevation in the
GPS positions. This is a Numeric entry field.
You rarely need to use an elevation mask low
the number of satellites in service. If you do 
mask, be aware that the increased ionosphe
with satellites low on the horizon will counter
PDOP given by the lower elevation mask. Th
ionospheric noise increase as lower satellites

CAUTION Make sure that the elevation ma
higher than that for the base station, so that
always tracks the same satellites that are vis
a rover gets further from the base, the differ
elevation mask of the rover and the base be
due to the curvature of the earth. As a rule o
difference must be at least 1° for every 100 
and the rover.

Use this 
field …

To …



d to compute 

y is poor and you can 
 ellipsoid very 
ata collection system 
ns when it is able to, 
ls to three, it 
omputed when there 
o-dimensional 
al positions is 

tude. You can 
ude of the last 
u have entered in the 

atellites to 3, and 
ificant impact on the 
 collection system. 
 altitude you supply is 
n the horizontal 
 collection system.

4

Default 
value

More...
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Minimum 
satellites

Specify the minimum number of satellites use
positions. The items in the Pop-up list are:

• 3 – Use this configuration if satellite visibilit
determine your altitude above the WGS-84
accurately at all times. The GeoExplorer 3 d
uses four satellites to compute GPS positio
but when the number of visible satellites fal
continues to compute positions. A position c
are only three usable satellites is called a tw
position, and the accuracy of two dimension
crucially affected by the accuracy of the alti
configure the GeoExplorer 3 to use the altit
available 3D position, or the altitude that yo
2D altitude field.

CAUTION If you set the minimum number of s
specify an inaccurate altitude, this has a sign
position computed by the GeoExplorer 3 data
As a rule of thumb, every meter of error in the
likely to cause at least three meters of error i
position computed by the GeoExplorer 3 data

Use this 
field …

To …



 level of accuracy for 
ollection system uses 
r) to compute 
the most accurate 
re than four satellites 

 GPS positions with 

ier phase data 
ny satellites as it can 
 positions are logged 

ble. This ensures that 
d solution. This 
 positions.

amentally affects the 
 when you fully 
ed changes.

Default 
value

More...
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• 4 – Use this configuration to achieve a high
logged positions. The GeoExplorer 3 data c
as many satellites as it can (but at least fou
positions. This configuration usually yields 
GPS positions and is the most flexible. If mo
are available, the GeoExplorer 3 computes
an overdetermined solution.

• 5 – Use this configuration when doing Carr
collection. The GeoExplorer 3 uses as ma
to compute positions. With this setting, GPS
only if there are at least five satellites availa
all logged positions have an overdetermine
configuration yields the most accurate GPS

CAUTION The Minimum satellites field fund
operation of the GPS receiver. Only modify it
understand the consequences of any propos

Use this 
field …

To …



plorer 3 automatically uses 12 

s. You can manually 
try field, or select 
ude recorded is 

tude relative to the 

Use 
last 3D 
GPS

Default 
value

only available when 
 number of satellites 
 to 3. When the 
mber of satellites is 
, the 2D altitude is 
y set at N/A.
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

NOTE If the elevation mask is configured to 4°  or below, the GeoEx
channels to receive GPS signals.

2D altitude Specify the altitude to be used for 2D position
enter the altitude value using the Numeric en
the Use last 3D GPS option. The last 3D altit
shown at the bottom of the screen.

NOTE It is important to specify the 2D alti
configured Altitude reference.

Use this 
field …

To …

This field is 
the minimum
is configured
minimum nu
set at 4 or 5
automaticall



The Real-time form appears:

•  Station ID

e parameters for collecting data 

eal-time form.
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Real-time

� / Setup / Configurations / Real-time

Select the Real-time button from the Edit configuration screen. 

These fields are available in the Real-time form:

• Mode • RTCM age limit

Use the this form to configur
using RTCM.
Press � to close the R



Default 
value

ecorded. The 

 positions if 
 will be displayed 

e been 
recorded. The 
.

Best 
available

More...
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Use this 
field …

To …

Mode Indicate which positions are displayed and r
items in the
Pop-up list are:

• Best available – this uses RTCM corrected
available, otherwise uncorrected positions
and recorded.

• RTCM only – only GPS positions that hav
corrected in real time are displayed and 
real-time icon appears in the Status bar



 for which the 
ction (based on 
 new GPS 
 corrections are 
nt correction is 

ected positions. 
sing the 
l-time link is 

20 s

Default 
value

More...
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RTCM age 
limit

Specify the RTCM age limit. This is the time
receiver continues to apply a projected corre
the most recent correction received) to each
position that it computes. If no new real-time
received in the specified time, the most rece
considered too old to provide accurate, corr
When this occurs, the GPS receiver stops u
corrections, and you are warned that the rea
lost. Items in the Pop-up list are:

Use this 
field …

To …

•  5 s

• 10 s

• 20 s

• 50 s

• 100 s



 must be a 
r identifies the 
ta collection 

tion. By default, 
TCM station 
 station). This is 

Any

Default 
value
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Station ID Enter a specific RTCM base station ID. This
number between 0 and 1023. The ID numbe
RTCM station and lets the GeoExplorer 3 da
system locate and use a particular base sta
the receiver attempts to choose the “best” R
(based typically on the distance to the base
a Numeric entry field or you can select Any.

Use this 
field …

To …



. The Coordinates form appears:

• Datum

• Coordinate units

re parameters that affect how 
ed. Specify a datum 

rojection to see the GPS 
 the features that you collect 
dinate system. This makes it 
 or navigate using a map 

oordinates form.
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Coordinates

� / Setup / Configurations / Coordinates

Select the Coordinates button from the Edit configuration screen

These fields are available in the Coordinates form:

• System • Zone

• Altitude reference • Geoid

• Altitude units

Use the this form to configu
data is collected and display
transformation and a map p
position, and the position of
displayed, in your local coor
easy to check your position
produced by your GIS.
Press � to close the C



Default 
value

n entering and 
lay a list of 

eoExplorer 3 

s to the 
System Manager 
r to the Pathfinder 
fer coordinate 
e GeoExplorer 3c 

te systems, press 
 information see 

Latitude/
Longitude

More...
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Use this 
field …

To …

System Specify the coordinate system to be used whe
displaying coordinates. Select this field to disp
coordinate systems currently loaded on the G
handheld. Items in the Pop-up list are:

• Latitude/Longitude

• Universal Transverse Mercator (UTM)

NOTE To transfer other Coordinate system
GeoExplorer 3, use the Coordinate 
software. For more information, refe
Office online Help. You cannot trans
systems from Pathfinder Office to th
edition.

NOTE To reset the list of available coordina
� and select Reset. For more
Resetting coordinate systems.



en calculating 
nes that apply to 
s field. If only one 
ystem, this field is 

MSL

o be used when 
ected system and 

WGS 
1984

 entering and 
 list are:

MSL

Default 
value

More...
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Zone Specify the zone (if applicable) to be used wh
coordinates. Select this field to display the zo
the coordinate system selected in the previou
zone is available for the selected coordinate s
read-only.

Datum View (and in some cases specify) the datum t
calculating coordinates. Depending on the sel
zone, this field may be read-only.

Altitude 
reference

Specify the altitude reference to be used when
displaying altitude values. Items in the Pop-up

• MSL (Mean sea level)

• HAE (Height above ellipsoid)

Use this 
field …

To …



ting the height 
ble when the 
ed geoid is the 
r Office software 

andheld.
ighlight the geoid 
he Delete option. 
figurations using 
id.

Global) geoid or a 

DMA 
10x10 
(Global)

isplaying 
ther than 
e:

N/A

Default 
value

y Ft (sf)

 Meters (NAm)

More...
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Geoid Specify the geoid model to be used for calcula
above mean sea level. This field is only availa
selected altitude reference is MSL. The suppli
DMA 10x10 (Global) model. Use the Pathfinde
to upload other geoids to the GeoExplorer 3 h
To delete a geoid, select the Geoid field and h
you want to delete. Press � and select t
You are prompted to confirm the deletion. Con
this geoid default back to the DMA 10x10 geo

NOTE You cannot delete the DMA 10x10 (
geoid that is currently in use.

Coordinate 
units

Specify the units to be used for entering and d
coordinates when using a coordinate system o
Latitude/Longitude. Items in the Pop-up list ar

Use this 
field …

To …

• Meters (m)

• Feet (ft)

• Yards (yd)

• US Surve

• Namibian



s are configured.

 and a coordinate system is 
ou do not transfer the 

isplaying altitude Meters

Default 
value
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NOTE Some fields will display N/A, depending on how related field

NOTE When you transfer a configuration file from Pathfinder Office
specified, that coordinate system is displayed by default. If y
appropriate files, system defaults are displayed.

Altitude 
units

Specify the units to be used for entering and d
units. Items in the Pop-up list are:

• Meters (m)

• Feet (ft)

Use this 
field …

To …



Units form appears:

• Velocity

• Declination

 units are to be entered and 

its form.
GeoExplorer 3 Operation Guide Reference
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Units

� / Setup / Configurations / Units

Select the Units button from the Edit configuration screen. The 

These fields are available in the Units form:

• Distance • Area

• Angle • North reference

Use this form to configure how
displayed. 
Press � to close the Un



Default value

nd 
t are:

Meters

nd Square meters

es (nm)

eters (km2)

s (mi2)

More...
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Use this 
field …

To …

Distance Specify the units to be used when entering a
displaying distances. Items in the Pop-up lis

Area Specify the units to be used when entering a
displaying area. Items in the pop-up list are:

• Meters (m)

• Feet (ft)

• Kilometers (km)

• Miles (mi)

• Nautical Mil

• Square meters (m2)

• Square feet (ft2)

• Hectares (Ha)

• Acres (A)

• Square kilom

• Square mile



nd 
are:

Km/Hour

Default value

mph)

More...
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Velocity Specify the units to be used when entering a
displaying velocity. Items in the Pop-up list 

Use this 
field …

To …

• Meters/Second (m/s)

• Feet/Second (ft/s)

• Km/Hour (kph)

• Miles/Hour (

• Knots (kt)



nd 
p list are:

yed when 
y do not 

d Mode 

 longitudes 
layed in 

/or 

Degrees

Default value

)

More...
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Angle Specify the units to be used when entering a
displaying bearing angles. Items in the Pop-u

NOTE Angle units only affect angles displa
navigating and entering offsets. The
affect:

• the bearings shown in the Advance
screen of the GPS tab. 

• the entry or display of latitudes and
(which are always entered and disp
degrees with optional minutes and
seconds).

Use this 
field …

To …

• Degrees (°)

• Gradians (gon)

• Rhumbs (rh

• Mils (mil)



ive to
op-up list 

background 

ompass to 

True

ea. (This is 
meric entry 

 significant 
 

lination, or 
oExplorer 3 
 declination 

Auto

Default value
GeoExplorer 3 Operation Guide Reference
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North 
reference

Specify whether bearings are displayed relat
true north or magnetic north. Items in the P
are:

• True – useful when navigating relative to a 
map.

• Magnetic – useful when using a magnetic c
navigate.

Declination Specify the magnetic declination for your ar
printed on most accurate maps.) This is a nu
field or you can select Auto.
Items in the pop-up list are:

• Value – enter the declination. If you move a
distance, it may be necessary to update the
declination.

• Auto – if you do not know the magnetic dec
prefer not to update it as you move, the Ge
uses an internal database to determine the
based on your current position.

Use this 
field …

To …



he Formats form appears:

• Degrees

• Time zone

 parameters that affect the 
play data. 
rmats form.
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Formats

� / Setup / Configurations / Formats

Select the Formats button from the Edit configuration screen. T

These fields are available in the Formats form:

• Language • Offset

• Date • Time

• Coordinate order

Use this form to configure the
formats used to enter and dis
Press � to close the Fo



Default value

ith. A 
Explorer 3.

English

 offsets. Horz/Vert

 angles that 
es). Items in 

DD°MM'SS.ss"

g the local 
-up list are:

MM/DD/YYYY

D

More...
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Use this 
field …

To …

Language Specify the language that you want to work w
number of languages are loaded on the Geo

Offset Specify the format to be used when entering
Items in the pop-up list are:

• Horz/Vert—horizontal and vertical distance

• Slope/Incl—slope distance and inclination
Degrees Specify the format to be used when entering

use degrees (including latitudes and longitud
the pop-up list are:

Date Specify the format to be used when displayin
date in the Time zone field. Items in the Pop

• DD°MM'SS.ss"

• DD°MM.mmm

• DD°.ddd

• DD/MM/YYYY

• MM/DD/YYYY

• YYYY/MM/D



g the local 
-up list are:

12 hour

Explorer 3 
try field.

00:00

Default value

one by 
alue to 

rrect local 

More...
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Time Specify the format to be used when displayin
time in the Time zone field. Items in the Pop

• 12 hour

• 24 hour
Time zone Specify the time zone to be used by the Geo

data collection system. This is a Numeric en

Use this 
field …

To …

Set the time z
adjusting the v
display the co
time and date.



 a position’s Lat/Long
(North/East)

Default value
GeoExplorer 3 Operation Guide Reference
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Coordinate 
order

Specify the order to be used when displaying
coordinates. Items in the Pop-up list are:

Use this 
field …

To …

• Lat/Long

• Long/Lat

• North/East

• East/North



he COMMS form appears:

• NMEA output

• Data bits

eters for communication with 
 data transfer to and from an 
cation with radios when 
 or NMEA Output Messages.
MMS form.
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

COMMS
� / Setup / Configurations / COMMS
Select the COMMS button from the Edit configuration screen. T

These fields are available in the COMMS form:

• Data transfer • RTCM input

Port settings:

• Input baud rate • Output baud rate

• Stop bits • Parity

Use this form to set the param
external devices. These affect
office computer and communi
receiving real-time corrections
Press � to close the CO



Default value

xplorer 3 to 
e:

be placed in 
office 

 to the rear of 
mputer using 
ur.

 disabled.

et to the 
CM input or 

Support 
module

More...
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Use this 
field …

To …

Data 
transfer 

Specify the device used to connect the GeoE
the office computer. Items in the Pop-up list ar

• Support module – the GeoExplorer 3 must 
the support module for data transfer to the 
computer to occur.

• Serial clip – the serial clip must be attached
the GeoExplorer 3 and connected to the co
a null modem cable for data transfer to occ

• Off – data transfer to the office computer is

NOTE The Data transfer field cannot be s
same value as configured in the RT
NMEA output fields (except Off).



e RTCM 

 

t to the same 
cept Off).

Cable-free 
BoB
or
Serial clip (with 
GeoExplorer 3c 
edition)

Default value

More...
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RTCM input Specify the connection device used to receiv
messages. Items in the Pop-up list are:

• Cable-free BoB

NOTE This option is not available with the
GeoExplorer 3c edition.

• Support module

• Serial clip

• Off

NOTE The RTCM input field cannot be se
value as the Data transfer field (ex

Use this 
field …

To …



t NMEA 

et to the 
ld (except 

Off

. Items in the 9600

Default value

More...
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NMEA 
output

Specify the connection device used to outpu
messages. Items in the Pop-up list are:

• Support module

• Serial clip

• Off

NOTE The NMEA output field cannot be s
same value as the Data transfer fie
Off).

Input baud 
rate

Specify the baud rate for input of RTCM data
pop-up list are:

Use this 
field …

To …

• 110

• 300

• 600

• 1200

• 2400

• 4800

• 9600

• 19200

• 38400



 Items in the 9600

fer data. 
ent in a 
mit or 
g a single 
t and data 

8

Default value

More...
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Output baud 
rate

Specify the baud rate for output NMEA data.
Pop-up list are:

Data bits Specify the number of data bits used to trans
When data is transferred, each character is s
stream of single bits, but many devices trans
receive fewer than eight bits when transferrin
character. This field is the same for data inpu
output. Items in the pop-up list are:

• 7

• 8

Use this 
field …

To …

• 110

• 300

• 600

• 1200

• 2400

• 4800

• 9600

• 19200

• 38400



ate the end 
 transferred. 
ent in a 

a byte and a 
 This field is 
s in the

1

ata is 
he same 
 device. 
 output. 

None

Default value
GeoExplorer 3 Operation Guide Reference
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Stop bits Specify the number of stop bits used to indic
of a byte. Stop bits are part of the data that is
When data is transferred, each character is s
stream of single bits. There are eight bits in 
stop bit is used to indicate the end of a byte.
the same for data input and data output. Item
Pop-up list are:

• 1

• 2
Parity Specify the parity used when binary digital d

transferred. For most data transfers, select t
parity as is set in the external communication
This field is the same for data input and data
Items in the pop-up list are:

Use this 
field …

To …

• None

• Even

• Odd



Other form appears:

ameters for the beep volume, 
plorer 3 data collection system 
s.
Other form.
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Other
� / Setup / Configurations / Other

Select the Other button from the Edit configuration screen. The 

These fields are available in the Other form:

• Beep volume • NMEA output interval

NMEA messages:

• GGA • VTG

Use this form to set the par
and to configure the GeoEx
for NMEA Output Message
Press � to close the 



Default value

 emits a 

es the 

On

essages are 5 s

utput in the 
e pop-up list 

Yes

More...
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Use this 
field …

Use this field to …

Beep 
volume

Specify whether the GeoExplorer 3 handheld
beep. Items in the Pop-up list are:

• On – any warnings or position logging caus
GeoExplorer 3 to beep.

• Off – the GeoExplorer 3 does not beep.
NMEA 
output 
interval

Specify the output interval at which NMEA m
transmitted. This is a Numeric entry field.

GGA Specify if the GGA message string is to be o
NMEA message (see Messages). Items in th
are:

• Yes

• No



tput in the 
:

Yes

Default value
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

VTG Specify if the VTG message string is to be ou
NMEA message. Items in the Pop-up list are

• Yes

• No

Use this 
field …

Use this field to …



ne. You can create new data 
er 3 data collection system in the 
edit a data dictionary.
tionary list appears: 

reated. The most recent 

nary, select it from the list. The 
pears.

elect data dictionary list.
 advanced Data dictionaries 
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Data dictionaries
� / Setup / Data dictionaries

Use this list to edit an existing data dictionary or create a new o
dictionaries that are specific to different jobs. Use the GeoExplor
field, or the Pathfinder Office software in the office, to create or 
Select Data dictionaries from the Setup tab. The Select data dic

NOTE Data dictionaries are listed in the order in which they were c
addition is at the bottom of the list.

To edit an existing data dictio
Edit data dictionary form ap

Press � to close the S
Press � to display the
option list. 



ailable options. 

• Rename
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Data dictionaries option list
� / Setup / Data dictionaries / � 

Press � from the Select data dictionary list to view the av

The options are:

• New • Copy

• Delete



u select this option, the 
displays a Text entry field. 
ary. Press � to save the 
ry form.
ata dictionary to be copied. 
eoExplorer 3 displays a text 
 change it. The default name 

 to save the name and 

ictionary. Highlight the data 
 and select Rename. A text 

 of the data dictionary. Press 

ions do not appear if Generic 
 cannot rename or delete the 

More...
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Use this option … To …
New Create a new data dictionary. When yo

GeoExplorer 3 data collection system 
Enter the name of the new data diction
name and go to the Edit data dictiona

Copy Copy a data dictionary. Highlight the d
Press �  and select Copy. The G
entry field. Accept the default name or
is Copy of <Data dictionary>. Press �
go to the Edit data dictionary form.

Rename Change the name of an existing data d
dictionary to be renamed. Press �
entry field appears. Change the name

� to save the new name.

NOTE The Rename and Delete opt
is highlighted in the list. You
generic data dictionary.



g message appears. You 
.

data dictionary to be deleted. 
are prompted to confirm 

tionary that is in use, or has 
rrently stored on the 
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

NOTE If the dictionary name that you enter already exists, a warnin
cannot create multiple data dictionaries with the same name

Delete Delete a data dictionary. Highlight the 
Press � and select Delete. You 
deletion.

NOTE You cannot delete a data dic
been used by a file that is cu
GeoExplorer 3.

Use this option … To …



name>

 the GeoExplorer 3. The Edit 
 and values contained in the 

ion about adding, or editing the 
s in the selected data dictionary.
it data dictionary form and save 

 to close the Edit data 
any changes.
it data dictionary option list.
ect it. A Text entry field appears. 

ment field is for reference only 

value select it from the list. The 
e changes. 

n edit in the associated data 
y, but not delete or change any 
tionary.
GeoExplorer 3 Operation Guide Reference
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Edit data dictionary
� / Setup / Data dictionaries / <Data dictionary 

Select a data dictionary from the list of available dictionaries on
data dictionary form displays the comment, features, attributes,
selected data dictionary.

Use this form to view informat
features, attributes, and value
Press � to close the Ed
any changes. Press ��
dictionary form and abandon 
Press � to view the Ed
To edit the Comment field, sel
Enter your comment. The Com
and it is optional. 
To edit a feature, attribute, or 

appropriate attribute entry form or Pop-up list appears. Enter th

NOTE If a data file is open, there are restrictions as to what you ca
dictionary. You can add to the end of the associated dictionar
features, attributes, or values. For more information see Dic



name> / � 

ailable options. The options that 
ictionary form.

• Show values

• Add value
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Edit data dictionary option list

� / Setup / Data dictionaries / <Data dictionary 

From the Edit data dictionary form, press � to view the av
appear depend on what is currently displayed in the Edit data d

The options are:

• Show features • Show attributes

• Add feature • Add attribute

• Copy • Delete



ccur in the selected data 
ributes or values are currently 
s and values, and display only 

Show features is the default 

and their
ding type

More...
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Use this 
option …

To …

Show 
features

Display the features and feature types that o
dictionary. This option is only available if att
displayed. Select this option to hide attribute
features and feature types.

NOTE When you open a data dictionary, 
option.

Features 
correspon



s, and attribute types 
indented to show which 

orresponding type

 corresponding type
 feature

More...
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Show 
attributes

Display the features, feature types, attribute
associated with each feature. Attributes are 
feature they belong to.

Use this 
option …

To …

Feature and c

Attributes and
for the above



ibute. Values are indented to 

 When you select this option a 
 When a new feature is 
the suffix is a digit number 
ample, New1, then New2, and 
try field appears. By default, 
e type, select it. A Pop-up list 

orresponding type
corresponding type

 menu attribute

 minimum
umeric attribute

More...
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Show values Display the values associated with each attr
show which attribute they belong to.

Add feature Add a feature to the current data dictionary.
feature is added below the selected feature.
created, the prefix for the name is New and 
(starting at 1 for the first one created), for ex
so on. To edit the name, select it. A Text en
the new feature is a point. To edit the featur
appears.

Use this 
option …

To …

Feature and c
Attribute and 

Values for the

Maximum and
 range for the n



y. This option is only available 
lect this option, an attribute is 
 new attract is created, the 
 digit number (starting at 1 for 
en New2, and so on. To edit 
s. By default, the new attribute 
type, select it. A Pop-up list 

 a list of values. To set a menu 
� . Only one value can be 

More...
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Add attribute Add an attribute to the current data dictionar
when attributes are displayed. When you se
added below the selected attribute. When a
prefix for the name is New and the suffix is a
the first one created), for example, New1, th
the name, select it. A Text entry field appear
is a text entry attribute. To edit the attribute 
appears. The attribute types are:

• Menu – use the Add value option to create
value as the default, highlight it and press 
set as the default.

Use this 
option …

To …



e the numeric attribute. Select 
s:

 form to specify the type of field 
e maximum and minimum 
values, and number of decimal 
or the numeric attribute. 

More...
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Add attribute 
(continued)

• Numeric – use the Definition form to defin
the value field. The Definition form appear

Use this 
option …

To …

Use this
entry, th
default 
places f



 text attribute. Select the <-no.-> 
y the type of field entry, and the 

 Date attribute. Select the DD/
orm appears. Specify the type of 
the format.

e Time attribute. Select the 12 
ppears. Specify the type of field 
erate options.

tate or create a break in the list 
, and you cannot enter a value 

ly available when values are 
lue is added below the 
, the prefix for the name is 
 at 1 for the first one created), 
e value, select it. The 

More...More...
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Add attribute
(continued)

• Text – use the Definition form to define the
value. The Definition form appears. Specif
maximum number of characters allowed. 

• Date – use the Definition form to define the
MM/YYYY (Manual) value. The Definition f
field entry, the auto generate options, and 

• Time – use the Definition form to define th
hour (Manual) value. The Definition form a
entry, the 24 hour option, and the auto gen

• Separator – use this attribute type to anno
of attributes. A separator is not an attribute
for it.

Add value Add a value to an attribute. This option is on
displayed. When you select this option, a va
selected value. When a new value is created
New and the suffix is a digit number (starting
e.g. New1, then New2, and so on. To edit th
appropriate field appears.

Use this 
option …

To …



 the feature, attribute, or value 
lect Copy. The new feature, 
he appropriate list. The default 
.
t the feature, attribute, or 
lete. You are prompted to 

ionary any features, attributes, 
s on the GeoExplorer 3.
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Copy Copy a feature, attribute, or value. Highlight
that you want to copy. Press � and se
attribute, or value appears at the bottom of t
name is Copy of <feature / attribute / value>

Delete Delete a feature, attribute, or value. Highligh
value to delete. Press � and select De
confirm the deletion.

NOTE You cannot delete from a data dict
or values that are used by data file

Use this 
option …

To …



tting or to create a new one. Use 
ical parameters, so configure 
e settings list to configure carrier 

ettings list appears:

ionaries currently stored in the 
ature settings for a data 
ist. The Edit feature settings 

elect feature settings list.
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Feature settings
� / Setup / Feature settings

Use the Select feature settings list to edit an existing feature se
it to set logging intervals and minimum positions. These are crit
them to suit your application. You can also use the Select featur
phase data collection and offsets.

Select Feature settings from the Setup tab. The Select feature s

This list reflects the data dict
GeoExplorer 3. To edit the fe
dictionary, select it from the l
form appears.

Press � to close the S



 name>

logging interval for every feature 

he form that appears depends on 

n about the settings for the 
ictionary.
it feature settings list.
it feature settings option list.
GeoExplorer 3 Operation Guide Reference
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Edit feature settings
� / Setup / Feature settings / <Feature settings

The Edit feature settings list displays the feature name and the 
in the current data dictionary.

To edit the setting for a feature, select the feature from the list. T
what type of feature you select—point, line, or area.

• Editing point features

• Editing line and area features

Use this list to view informatio
features in the current data d
Press � to close the Ed
Press � to view the Ed



st, the <Feature name> settings 
op of the screen.

• Accuracy

e the parameters for the 
arameters affect the GPS 
ature.
Feature name> settings form.
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Editing point features
When you select a point feature from the Edit feature settings li
form appears. The name of the selected point feature is at the t

These fields are available in the Gate settings form:

• Interval • Minimum positions

Use this form to set or chang
selected point feature. The p
positions collected for that fe
Press � to close the <



Default value

sitions when 
le, if you set 
 3 logs GPS 
 you start the 

ry field or you 

5 s

t must be 
ore positions 
point feature 
Explorer 3 
 despite a 

 the feature 
umeric entry 

1

More...
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Use this 
field …

To …

Interval Specify the interval between feature GPS po
you are collecting a point feature. For examp
the interval to five seconds, the GeoExplorer
positions once every five seconds, from when
feature until you end it. This is a Numeric ent
can select Off.

Minimum 
positions

Specify the minimum number of positions tha
logged to achieve the required precision. (M
means higher precision.) If you try to save a 
before enough positions are logged, the Geo
warns you. You can store the feature anyway
possible loss of precision, or you can stay at
until enough positions are logged. This is a n
field.



carrier phase 
ist are:

 collection.

Code

Default value
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Accuracy Specify whether you want to collect code or 
data for point features. Items in the Pop-up l

• Code

• Carrier
For more information see Carrier phase data

Use this 
field …

To …



tings list, the <Feature name> 
e top of the screen.

• Inclination

r area feature parameters for 
arameters affect the GPS 
ture. You can also use this 

eature name> settings form.
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Editing line and area features
When you select a line or area feature from the Edit feature set
settings form appears. The name of the selected feature is at th

These fields are available in the Lake settings form:

• Interval • Accuracy

Offset:

• Direction • Slope distance

Use this form to set the line o
the selected feature. These p
positions collected for that fea
form to configure Offsets. 
Press � to close the <F



Default value
tween feature 
 line or area 
val to five 
ositions once 
 the feature 
 field or you 

5 s

e or carrier 
ems in the 

 data 

Carrier

More...
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Use this field … To …
Interval Specify the interval (time or distance) be

GPS positions when you are collecting a
feature. For example, if you set the inter
seconds, the GeoExplorer 3 logs GPS p
every five seconds, from when you start
until you end it. This is a Numeric entry
can select Off. 

Accuracy Specify whether you want to collect cod
phase data for line and area features. It
Pop-up list are:

• Code

• Carrier
For more information see Carrier phase
collection.



eature. The 
vel at the time 
-up list are:

Right

 line or area 
 to the 

0.00 m

 feature. The 
he horizon. 

0°

Default value
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Direction Specify the direction to the line or area f
direction is relative to the direction of tra
the feature is recorded. Items in the Pop

• Right

• Left
Slope distance Specify the slope distance (range) to the

feature. The range is the actual distance
feature. This is a Numeric entry field. 

Inclination Specify the inclination to the line or area
inclination is the angle above or below t
This is a numeric entry field.

Use this field … To …



 name> / � 

ilable options. Use these options 

et all areas
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Edit feature settings option list

� / Setup / Feature settings / <Feature settings

Press � from the Edit feature settings list to view the ava
to make the same change to all features of a particular type.

The options are:

• Set all points • Set all lines • S



en you select this, the Set all 
 the settings for all point 
 changes and close the form.
and abandon any changes.
en you select this, the Set all 
the settings for all line 
 changes and close the form.
and abandon any changes.
en you select this, the Set all 
 the settings for all area 
 changes and close the form. 
and abandon any changes.
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Use this option … To set the parameters for all …
Set all points Point features in a data dictionary. Wh

points form appears. Use it to change
features. Press � to accept any
Press �� to close the form 

Set all lines Line features in a data dictionary. Wh
lines form appears. Use it to change 
features. Press � to accept any
Press �� to close the form 

Set all areas Area features in a data dictionary. Wh
areas form appears. Use it to change
features. Press � to accept any
Press �� to close the form 



ppears:

ation about the firmware. It 
tion:

• Trimble company name 
and logo

• Serial number
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

About
� / Setup / About

Select the About button from the Setup tab. The About screen a

Use this screen to view inform
displays the following informa

• Product name

• Version number



ts, reset the internal GPS 
ware. Select Reset from the 
GeoExplorer 3 Operation Guide Reference
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Reset
� / Setup / Reset

Use the Reset list to reset the GeoExplorer 3 to factory defaul
receiver, or to prepare the GeoExplorer 3 to upgrade the firm
Setup tab. The reset list appears:

The options are:

• Factory defaults

• Reset receiver

• Upgrade firmware



 appears:

s, data files, languages, 
 GeoExplorer 3 to the default 
ngitude on the WGS-84 

data files will be closed.

irmware to Trimble factory 

the reset. If you select:

 firmware resets to the factory 

 is cancelled.
GeoExplorer 3 Operation Guide Reference
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Factory defaults
� / Setup / Reset / Factory defaults

Select Factory defaults from the Reset list. The following screen

NOTE Resetting to factory defaults does not delete data dictionarie
coordinate systems, or waypoints. However, it does reset the
language (English), the default coordinate system (latitude/lo
datum), and the default data dictionary (Generic). Any open 

Use this screen to reset the f
defaults.
You are prompted to confirm 

• Yes – the GeoExplorer 3
defaults.

• No – the reset operation



et receiver from the Reset list. 

ternal GPS receiver, but, if for 
 the problem.

the receiver.
firm the reset. If you select:

rer 3 receiver is reset.

ation is cancelled.

More...
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Reset receiver
� / Setup / Reset / Reset receiver

Use the Reset receiver option to reset the receiver. Select Res
The reset receiver screen appears:

NOTE Normally it is quite unnecessary to reset the GeoExplorer 3 in
some reason the receiver malfunctions, resetting it can often fix

Use this screen to reset 
You are prompted to con

• Yes – the GeoExplo

• No – the reset oper



lmanac and perform a warm 
e signals from the GPS satellites. 
ithin three minutes, you should 
dvice.

es not affect any other files or 
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

CAUTION Resetting the internal GPS receiver will delete the current a
boot. The receiver may take up to three minutes to reacquir
If the GeoExplorer 3 fails to acquire GPS satellite signals w
contact your nearest Trimble Assistence Center (TAC) for a

NOTE Although resetting the receiver deletes the almanac file, it do
settings on the GeoExplorer 3.



e firmware. Select Upgrade 
ears:

figuration settings, data 
s.

 the firmware installation 

firm the reset. If you select:

rer 3 is placed in upgrade 

e Installing the firmware.

peration is cancelled.
GeoExplorer 3 Operation Guide Reference
SYS section – The Setup tab

Upgrade firmware
� / Setup / Reset / Upgrade firmware

Use the Reset list to prepare the GeoExplorer 3 to upgrade th
firmware from the Reset list. The Upgrade firmware screen app

WARNING Upgrading the firmware deletes all data files, waypoints, con
dictionaries, user-loaded languages, and coordinate system

Use this screen to begin
process.
You are prompted to con

• Yes – the GeoExplo
mode.

For more details se

• No – the upgrade o



GeoExplorer 3 Operation Guide Reference
DATA section – Introduction

�*��%!�!�������&
Use the DATA section to open data files, collect new data, update existing data, and view GPS 
data graphically. 

Press � to move between the tabs in the DATA section.

The DATA section has four tabs:

NOTE The New, Update, and Map tabs are visible only when a data file is open.

NOTE The Map tab is not available with the GeoExplorer 3c edition.

• The File tab • The New tab • The Update tab

• The Map tab



 data file is open. (When a data 
rm appears:

• File 

ata file or open an existing one. 
d select the data dictionary that 

e option list.
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

��	�'��	���+�
� / File

To display the File tab, press � .The File tab appears if no
file is open the File tab is not available.) The Collect new data fo

The Collect new data form contains:

• Create new file • Open selected file 

• Dictionary • Configuration 

Use this tab to create a new d
Use it to change a filename an
you want to use.

Press � to view the Fil



e Create new file button is 
 appears. When all fields in 

his accepts the new File name 
 is created and The New tab 

 the Open selected file button 
ta form appears. Use the File 
ress � . The Update tab 

he file is the data dictionary 
created.

re than seven days ago, the 
n system will not let you 
of data (although you can 
nical limitation relates to the 
 stored. To maintain accurate 
it the time-span of a data file 

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The File tab

Use this button … To …
Create new file Create a new rover data file. When th

highlighted, the Collect new data form
the form are correct, press �. T
and Dictionary. A new rover data file
appears.

Open selected file Open a selected rover data file. When
is highlighted, the Update existing da
field to select the file to be opened. P
appears. 
The data dictionary associated with t
that was selected when that file was 

NOTE If a data file was created mo
GeoExplorer 3 data collectio
reopen it for further logging 
review and edit it). This tech
way in which GPS times are
storage, it is necessary to lim
to seven days.



ile, edit the filename, or select 
w file is highlighted, press 
 selected file is highlighted, 
red in the GeoExplorer 3 

tes a filename for new files. It 
H X

,
ay.

ng at ’A’ for the first file in that 
 on. To edit the filename, 
. Use the Text entry field that 
e.

only a suggestion. You can 
er an entirely different one. 
n 20 characters long.

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The File tab

Use this field … To …
File Accept the default filename for the new f

an existing file to open. When Create ne
� to edit the filename. When Open
press � to see a list of the files sto
handheld. 
The GeoExplorer 3 automatically genera
uses the following formula: R MM DD H
• where R is the Filename prefix,
• MM is the current UTC month,
• DD is the current UTC day of the month
• and HH is the current UTC hour of the d
The X increments within this hour, starti
hour, then ’B’ for the second file, and so
highlight the File field and press �
appears to make changes to the filenam

NOTE The auto-generated filename is 
alter the suggested name or ent
Filenames must be not more tha



ata dictionaries currently 
tion system. When Create 
ictionary is the one most 
ing the Pathfinder Office 
t the Dictionary field and press 
 appears.
the data dictionary is the one 

available. It lets you record 
 a simple descriptive attribute.
nd create Data dictionaries.

en creating a data file is 
t file. It determines what types 
e file, and what attributes the 

er 3, you can only add to the 
cannot make changes to 
om it.

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The File tab

Dictionary Select a data dictionary from the list of d
loaded on the GeoExplorer 3 data collec
new file is highlighted, the default data d
recently loaded to the GeoExplorer 3 us
software. To select a dictionary, highligh
�. The list of available dictionaries
When Open selected file is highlighted, 
associated with the selected file. 
The “Generic” data dictionary is always 
point, line, and area features, each with
You can use the GeoExplorer 3 to edit a

NOTE The data dictionary selected wh
permanently associated with tha
of features can be recorded to th
features have.

NOTE When a file is on the GeoExplor
associated data dictionary. You 
existing items, or delete items fr

Use this field … To …



oaded in the GeoExplorer 3 
n is Default configuration, or 
eoExplorer 3 using the 

llection system to edit the 
 Configurations.
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Configuration View the configuration that is currently l
data collection system. This configuratio
the one most recently uploaded to the G
Pathfinder Office software.
You can use the GeoExplorer 3 data co
configuration. For more information see

Use this field … To …



le options. 

• Base station 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

File option list 
� / File / � 

When the File tab is active, press � to display the availab

The options are:

• File info • Delete file(s) 



s:

ears. Edit the file name.

• Number of positions 

• Stop 

iew information about all data 
e GeoExplorer 3 data collection 

it or change the name of a data 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

File info 
� / File / � / File info

Select File info from the File option list. The File info list appear

The File info list displays the following:

To edit a file name, select it from the list. A Text entry field app

• List of files • Number of features 

• Dictionary • Start 

Use this list to v
files stored on th
system, and ed
file.

Message box



nt information is displayed in 
h the list, the displayed 

eatures that are recorded in 

r of GPS positions that are 

 that is associated with the 

he first GPS position logged to 

he last GPS position logged to 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Information Description
List of files Use the list to select a file. The releva

the message box. As you scroll throug
information changes accordingly.

Number of 
features

This number indicates the number of f
the highlighted file.

Number of 
positions

This number indicates the total numbe
stored in the highlighted file. 

Dictionary This field indicates the data dictionary
highlighted file.

Start This field shows the time and date of t
the highlighted file.

Stop This field shows the time and date of t
the highlighted file. 



st appears: 

• Free space 

delete rover and base data files. 
, highlight it and press � . 
ted to confirm the deletion.

 to display the
ption list.
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Delete file(s) 
� / File / � / Delete file(s)

Select Delete file(s) from the File option list. The Delete file(s) li

The Delete file(s) screen displays the following:

• List of files • File size 

• Status 

Use this list to 
To delete a file
You are promp

Press �
Delete file(s) o

Message box



leted. Information about the 
age box. As you scroll through 
n changes accordingly.
tes (KB).

 the GeoExplorer 3 data 

s been transferred from the 
o an office computer.
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Information Description
List of files Use this list to select the file(s) to be de

highlighted file is displayed in the mess
the list of files, the displayed informatio

File size The size of the highlighted file, in kiloby
Free space The amount of free space remaining in

collection system, in kilobytes (KB).
Status Indicates whether the highlighted file ha

GeoExplorer 3 data collection system t



 options.

om the GeoExplorer 3 handheld. 
isplays a warning when you 
ter.
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Delete file(s) option list

� / File / � / Delete file(s) / � 

Press �  from the Delete file(s) list to display the available

Use the Delete all files option to delete all rover and base files fr
You are prompted to confirm the deletion. The GeoExplorer 3 d
delete files which have not been transferred to the office compu



orm appears:

• File

 base file or open an existing 
o collect base data.

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The File tab

Base station 
� / File / � / Base station

Select Base station from the option list. The Collect base data f

The Collect base data form displays the following:

• Create new file • Open selected file

• Configuration

Use this form to create a new
one. A base station is used t



 files in the GeoExplorer 3 data 

ure the base station is recording 
. The satellites tracked by the 
 station.

ill track a satellite that the base 
ills or buildings that can block a 

tion file, you cannot create a new 

s 12 channels to receive GPS 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

NOTE The Open selected file button only appears if there are base
collection system.

Plan carefully for the roving unit(s) and the base station. Make s
data at the same time that the roving unit is recording positions
rover must be included among the satellites tracked by the base

The further a rover is from the base, the greater the risk that it w
station cannot see. Think about potential obstructions such as h
satellite signal to the base station. 

While the GeoExplorer 3 handheld is logging data to a base sta
rover data file or open an existing one.

NOTE The GeoExplorer 3 data collection system automatically use
signals when you use it as a base station.



e field, select the Create new file 

ase station reference position 
 that controls how the 
tation data.

ging base file data.

Base station option list.

• Altitude (MSL) 

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The File tab

Create new file 

� / File / � / Base station

To create a new base data file with the name indicated in the Fil
button. The Base station form appears:

Use this form to enter the b
and the logging information
GeoExplorer 3 logs base s

Press 
 to start Log

Press � to view the 

The following fields are available in the Base station form:

• Lat • Lon 

• Antenna height • Measurements 



 automatically uses the last 
 Lon, and Altitude values appear 

t enter values for all position 

sults of a previously conducted 

val for each GPS rover is an 
tation. If you set the position 
e station’s measurement logging 
polated differential corrections. 
 intervals of the base station and 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

When you create a new base file the GeoExplorer 3, by default,
reference position entered. If no position has been entered, Lat,
as “?”.

If you provide a reference position for the base station, you mus
fields (Lat, Lon, and Altitude).

You can enter the reference position from a map, or from the re
control survey.

TIP For greatest accuracy, make sure that the position logging inter
exact multiple of the measurement logging interval at the base s
logging interval to a value that is not an exact multiple of the bas
interval, the differential correction program has to compute inter
These are less accurate than those computed when the logging
rover(s) are synchronized.



Default value
s is a Last value entered

his is a Last value entered

n. This is Last value entered

ric entry 

 antenna 
er Office 

nsform 
round) 
eiver’s 

This APC 
ection 

0.0 m

More...
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DATA section – The File tab

Use this field... To...
Lat Enter the latitude of the base station. Thi

Numeric entry field.
Lon Enter the longitude of the base station. T

numeric entry field.
Altitude (MSL) Enter the altitude (MSL) of the base statio

a numeric entry field.
Antenna height Enter the antenna height. This is a Nume

field.

NOTE It is important that you enter the
height correctly, as the Pathfind
software uses this height to tra
the reference position (on the g
into the position of the GPS rec
Antenna Phase Center (APC). 
is used by the Differential Corr
utility in Pathfinder Office.



f the 

s to log 
or use 
To 
raw 
bly often. 
gging 
e interval 
 result in 
d by the 
s 
e quality 
ge space 

15 s
Default value
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Measurements Enter the measurement logging interval o
base station. 
The primary task of a GPS base station i
raw GPS measurements from satellites f
when differentially correcting rover files. 
provide accurate differential corrections, 
measurements should be logged reasona
The maximum permitted measurement lo
interval is 30 seconds. You can reduce th
to a minimum of one second, but this will
up to 30 times as much data being logge
GeoExplorer 3. The default setting of 15
provides a good compromise between th
of postprocessed positions and the stora
and processing time required.

Use this field... To...



on is displayed in the message 

ssage box at the bottom of the 
displays information about the 
e. The logging icon appears in 
tus bar. It indicates how many 
sitions have successfully been 
to the file.

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The File tab

Logging base file data 
To start logging base file data, press 
. Logging informati
box.

The message box displays the following:

• Started at • Last • Memory full in 

The me
screen 
base fil
the Sta
GPS po
logged 

Message
box Logging

icon



. You are prompted to confirm 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

To stop using the GeoExplorer 3 as a base station, press �
whether you want to stop logging base station data.



arted logging to the data file.
pped logging to the data file.
ta storage space is full. This 

 measurements logged.
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Information Description
Started at The time that the base station st
Last The time that the base station sto
Memory full in The time remaining before the da

value is computed after every 10



tton in the Collect base data 
 file to be opened. Highlight the 

form appears. Use this form to 
easurement logging interval. For 

file.

omatically uses the reference 

l overwrite the previously 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Open selected file 

� / File / � / Base station

To open an existing base file, highlight the Open selected file bu
form. Select the File field. A list of base files appears. Select the
Open selected file button and press � . The Base station 
enter the base station reference position, antenna height, and m
more information about the Base station form see Create new 

NOTE When you open an existing base file, the GeoExplorer 3 aut
position that was entered when the file was created.

NOTE Changing the reference position while logging a base file wil
entered reference position.



r to view the list of base data files 

r 3 automatically generates a file 
 HH X

in that hour, then ’B’ for the 
signed to the third file (’C’) 

nge it or enter an entirely 
 press � . Use the

 list of base files appears. Use 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

File 

� / File / � / Base station

Use the File field to edit (change) the name of a base data file, o
currently loaded on the GeoExplorer 3 data collection system.

When the Create new file button is highlighted, the GeoExplore
name for a new base data file. It is uses the formula: B MM DD

• Where the B is the Filename prefix,

• MM is the current UTC month,

• DD is the current UTC day of the month, and

• HH is the current UTC hour of the day.

The X increments within this hour, starting at ’A’ for the first file 
second file, and so on. For example, B052523C is the name as
created on May 25th, between 23 00 and 24 00 hours. 

The auto-generated file name is only a suggestion. You can cha
different name. To edit the file name, highlight the File field and
Text entry field that appears to change the filename.

When the Open selected file button is highlighted, select File. A
this list to select the file to be opened.



le that is used with the base data 
be edited.

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The File tab

Configuration 

� / File / � / Base station

Use the Configuration field to view the name of a configuration fi
file. This field cannot be changed and the configuration cannot 



le options.

• Here 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Base station option list 

� / File / � / Base station / ��
Press � from the Base station form to display the availab

 The options are:

• Waypoint • Unknown 



fields with the location of a 
ption to display a list of 
int that you want to assign as 

rence position fields. 

nce position in the field, but a 
e Differential Correction utility 
.
fields with the current GPS 
GeoExplorer 3 Operation Guide Reference
DATA section – The File tab

Use this 
option...

To...

Waypoint Automatically fill in the reference position 
previously recorded waypoint. Select this o
waypoints. Use the list to select the waypo
the base station reference position.

Unknown Assign null values to the base station refe

NOTE You do not have to enter a refere
reference has to be entered in th
in the Pathfinder Office software

Here Automatically fill in the reference position 
position (if any).



e. If no data file is open,
 appears:

 	 or � to highlight it in the 
ighlight the Now or Later button, 
t the GeoExplorer 3 to start 

at feature. Press � . An 

ttribute values.

g GPS positions before selecting 
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

��	�&	,���+
� / New

To display the New tab, press � until the New tab is activ
The File tab appears. If a data file is open, the New feature list

To start a new feature, press
list. Then press 
 or � to h
depending on when you wan
logging GPS positions for th
attribute entry form appears.

Use this form for Entering a

TIP Use the Advanced datalogging options function to start loggin
a feature.



 feature. The selected feature 
aneously. The logging icon 
plorer 3 is logging GPS 
itions is Now.
. The selected feature is 
ed later and assigned to that 

shes to indicate that the 
 positions for the selected 
r more information see

ter the attributes for a feature, 
ple, if you see a tree feature 

 enter the attributes for the 
h the tree, press 
 to 
ed, press � to store the 
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

Use this 
option …

To …

Now Start logging GPS positions for the selected
and GPS data collection are started simult
appears in the Status bar when the GeoEx
positions. The default for logging GPS pos

Later Log GPS positions for the selected feature
started first. The GPS positions are collect
feature. 
The pause logging icon in the status bar fla
GeoExplorer 3 is not currently storing GPS
feature. To start logging, press 
 . Fo
Pause and resume logging.
The Later option is useful if you want to en
but you are not yet at the feature. For exam
in the distance, select the Later option and
tree as you walk towards it. When you reac
start logging positions. When you are finish
attributes and positions.



riate attribute entry form appears:

riate data entry field appears—
er the value. When you have 
ss � . The feature is stored 

 confirm that you want to 
ositions.

 to enter attribute values for the 

ribute entry form option list.
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

Entering attribute values
� / New / <Feature>

When you select a feature from the New feature list, an approp

To enter a value for an attribute, select the attribute. The approp
Pop-up list, Numeric entry, or Text entry. Use this field to ent
entered attribute data and collected positions for the feature, pre
and the New feature list reappears. (See Storing features.)

To discard a feature, press � � . You are prompted to
abandon changes. This will discard the feature attributes and p

Use the <feature name> form
feature.

Press � to view the Att



try form.

end on the type of feature 
ea feature is selected the only 
 feature is selected, Offset and 
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

Attribute entry form option list

� / New / <Feature> / � 

Press � to display the options available in the attribute en

The options are:

• Offset • Segment

The options that appear dep
selected. When a point or ar
option is Offset. When a line
Segment are both available.



 � and select Offset. 
nter the offset information. 
ollection.
 select Segment. For more 
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

Use this 
option …

To …

Offset Create an offset for this feature only. Press
The Offset form appears. Use this form to e
For more information see Advanced data c

Segment Segment a line feature. Press � and
information see Advanced data collection.



sitions for the feature, press 
he bottom of the New feature list. 
.

� .

More...
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DATA section – The New tab

Storing features
To save the contents of an attribute entry form and store the po
� . A message is displayed briefly in the message bar, at t
The message indicates that the feature was stored successfully

To abandon a feature and return to the New feature list, press �

Message box



d attributes for a feature. While 
any GPS positions that are 
ure, remain stationary at the 
 before pressing � . If 
the feature or around the 
e pressing � . 

 minimum number of positions 
ether you want to store the 

lorer 3 stores the current 
ou select No, the attribute form 
rer 3 continues to record GPS 
ure.
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

You may not want to press � as soon as you have entere
the feature is ‘active’ (while you are in the attribute entry form), 
logged are associated with that feature. If recording a point feat
feature until the minimum number of positions has been logged
recording a line or area feature, continue to walk or drive along 
perimeter until you have traversed the feature completely befor

If you are collecting a feature and you press � before the
has been logged, the GeoExplorer 3 prompts you to confirm wh
feature.

If you select Yes, the GeoExp
number of GPS positions. If y
reappears, and the GeoExplo
positions for the selected feat



e logging icon appears in the 
 GeoExplorer 3 stops logging 
 in the status bar.

rd GPS positions, or velocities. It 
configured for high Accuracy) 
. 

nction to stop briefly or if you 
ine or area feature and have to 
me obstacle before picking up 
erimeter again.

More...
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DATA section – The New tab

Pause and resume logging
When the GeoExplorer 3 handheld is logging GPS positions, th
Status bar. Press 
 to pause logging. While paused, the
GPS positions and the pause icon flashes over the logging icon

When GPS logging is paused, the GeoExplorer 3 does not reco
does continue to record carrier measurements (if the feature is 
and certain critical GPS information required for postprocessing

Pause

Use the pause fu
are collecting a l
travel around so
the line or area p



ops flashing and the logging icon 
 line or area feature, the 
rdless of the logging interval that 

ogging to a rover data file. You 
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

To resume logging GPS, press 
 again. The pause icon st
appears again. Each time you resume logging while collecting a
GeoExplorer 3 data collection system logs a GPS position (rega
you have set for line/area features).

NOTE Pause and resume logging can only be used when you are l
cannot do this when logging GPS data to a base station file.



ions.
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New feature option list
� / New / � 

Press �  from New feature list to display the available opt

The options are:

• Repeat • Continue <feature>



d select Repeat. A ✓  appears 
Repeat option. For more 
.
ss � and select 
ntry form reappears.

area feature you can collect 
ontinue option. For more 
g line and area features.
GeoExplorer 3 Operation Guide Reference
DATA section – The New tab

Use this option … To …
Repeat Repeat a feature. Press � an

in the check box to the right of the 
information see Repeating features

Continue <feature> Continue a line or area feature. Pre
Continue <feature>. The attribute e

NOTE While traversing a line or 
point features using the C
information see Continuin



b

 the GeoExplorer 3c edition.

 active. If a data file is not 
 the Update feature list appears:  

ure, select it from the list. An 
rm appears.

x at the bottom of the screen 

ime

 point

Length / Area
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta
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NOTE Data update, using transferred .ssf files, is not available with

� / Update

To display the Update tab, press � until the Update tab is
currently open, The File tab appears. When a data file is open,

To update a feat
attribute entry fo

The message bo
displays:

• Date and T

• Distance to

• Positions /Message
 box



b

ted feature was collected or 

ion to the highlighted feature.
he highlighted point feature.
ed line feature.
d area feature.
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Information Description
Date and Time The date and time when the highligh

last updated.
Distance to point The distance from your current posit
Positions / Length /
Area

The number of positions logged for t
The computed length of the highlight
The computed area of the highlighte



b

check box appears to the right of 

st is empty. A message 

c edition. The GeoExplorer 3c 
r Office.

the feature is not updated.

 a ✓ , the feature is updated.

More...
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DATA section – The Update ta

Updating attribute values
� / Update / <Feature>

When a file is transferred from the Pathfinder Office software a 
each feature.

NOTE When no features are stored in the file, the Update feature li
indicates that there are no features.

NOTE The ✓  and � symbols will not appear on the GeoExplorer 3
edition does not support transferred .ssf files from Pathfinde

If a check box is empty, 

If the check box contains



b

ibute entry form appears:

ntry field appears—Pop-up list, 

dated information is stored and 
e has been updated.

o confirm this cancellation.

lies to files transferred from 
lected during a current data 

te values for the feature. 

pdate attribute option list. 
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

To update a feature select it from the Update feature list. An attr

To edit the value for an attribute, select it. The appropriate data e
Numeric entry, or Text entry.

When you have edited the attribute data, press �. The up
the Update feature list reappears. A ✓  indicates that the featur

To abandon a feature, press �� . You are prompted t

NOTE The ✓  that indicates that a feature has been updated only app
Pathfinder Office. No ✓  appears when you update features col
collection/update session.

Use the form to edit the attribu

Press � to display the U



b

 list. 

n transferred from Pathfinder 
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Update attribute option list

� / Update / <Feature> / �
Press �  from the attribute entry form to display the option

The options are:

NOTE The Mark option only appears when the updated file has bee
Office.

• Offset • Mark



b

ure in the update feature list 

e selected feature. When you 
r a feature, a ✓  automatically 
tion to manually insert a ✓  to 
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Use this option … To …
Offset Create an offset for the selected feat

(see Offsets).
Mark Place a ✓ in the check box next to th

update the attributes or GPS data fo
appears in the check box. Use this op
mark the feature as updated.



b

 attribute entry form appears. 
 logging GPS positions. 
ce fields are configured, the 
e Data form in the Setup tab to 

 � . The updated 
 new GPS positions replace the 
to the feature to indicate that it is 

plorer 3 starts logging GPS data 
S data. If you select No, it does 
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Updating GPS data
To update the GPS data for a feature, select it from the list. The
Press 
 . The GeoExplorer 3 data collection system starts
Depending on how the Allow GPS update and Warning distan
GeoExplorer 3 prompts you to confirm the GPS update. (Use th
configure these fields.)

When you have finished collecting positions for a feature, press
information is stored and the Update feature list reappears. The
existing position for the selected feature and a ✓ appears next 
updated. 

If you select Yes, the GeoEx
and replaces the existing GP
not log new GPS data. 



b

t

 list. 

• Filter
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Update feature option lis
� / Update / � 

Press �  from the Update feature list to display the option

The options are:

• Delete / Undelete • Sort

• Position / Summary



b

ht it. Press � and then 

ht it. Press � and select 

the office computer, but it does 

d 4 are deleted. This is indicated 
 name.
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DATA section – The Update ta

Delete / Undelete
To delete a feature from the Update feature option list, highlig
select Delete. A line appears through the deleted feature.

To restore a deleted feature from the Update feature list, highlig
Undelete. The line disappears from the feature name.

NOTE Deleted features do not appear on the Map or the Chart.

NOTE The Pathfinder Office software transfers deleted features to 
not export them to the GIS.

In this example, features 1 an
by the line through the feature



b

ct Sort. A sublist appears (see 

 at the end of the list regardless 

• Distance
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Sort
To sort the Update feature option list, press � and sele
Sublists). The options are:

NOTE Sort is applied at the time you select it. New features appear
of the sorting order.

• Feature • Time



b

to last.
rom closest to furthest away.
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Use this option … To …
Feature Sort by feature name.
Time Sort by the time recorded, from first 
Distance Sort by distance to start of feature, f



b

g features based on a set of 

ct Filter. A sublist appears (see 

ay not appear in the update 

• Status
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Filter
Filtering on the GeoExplorer 3 is a method of selectively viewin
criteria set out below.

To filter the Update feature option list, press � and sele
Sublists). The options are:

NOTE A filter remains in effect until a file is closed. New features m
feature list, depending on how the list is filtered.

NOTE Each new filter replaces the previous one.

• Feature • Time

• None



b

n feature type. Select the 
(see Checklists). Select the 
 If you select the Gate feature, 
s filtered and only Gate 

n the time or date that a 
u can display only those 
een 9:00 am and 12:00 pm.
rs with the four fields: Start 
ate. Filter the list using one or 
elect it and use the

 

More...
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DATA section – The Update ta

Use this option … To …
Feature Filter the Update feature list based o

Feature option. A checklist appears 
feature type(s) that you want to filter.
for example, the Update feature list i
features are displayed.

Time Filter the Update feature list based o
feature was started. For example, yo
features collected on May 26th, betw
Select the Time option. A form appea
time, Start date, End time, and End d
more of these fields. To edit a field, s
Numeric entry field to enter a value.



b

n the current status of the 
this option to display only 
d during the current session).
 appears with the options:

er. The Update list is filtered 
pear. 
ature list.

• Imported

• Updated
GeoExplorer 3 Operation Guide Reference
DATA section – The Update ta

Status Filter the Update feature list based o
features. For example, you can use 
those features that are new (collecte
Select the Status option. A checklist

Select the status that you want to filt
and only features with that status ap

None Remove all filters from the Update fe

Use this option … To …

• Deleted

• Not deleted

• New



b

te feature option list, press 
 feature appear in the message 
 displayed is the average GPS 
 start point of the feature.

age box display to show 
mary.
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DATA section – The Update ta

Position / Summary
To view the GPS position of the feature highlighted in the Upda
� and select Position. The coordinates of the highlighted
box at the bottom of the screen. For point features, the position
position. For line and area features, the position displayed is the

When the Position option is selected, you can change the mess
summary information. To do this, press � and select Sum



.

. If no data file is open, the The 

e this tab to view and select 
tures for update. It is a 

aphical view of the Update 
ture list that you access from 
e Update tab. 

ess � to view the
p option list.

More...
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DATA section – The Map tab

��	�������+
NOTE The Map tab is not available with the GeoExplorer 3c edition

� / Map

To display the Map tab, press � until the Map tab is active
File tab appears. If a data file is open, the Map tab appears:

Us
fea
gr
fea
Th

Pr
Ma

Scale 

Current position

North 
indicator

Updated Line feature

Filename

Area feature

Waypoint

GPS trail

point feature

Between
feature GPS



 the DATA Map and the NAV 
, and update features. Use the 
ypoints.

e • Waypoint

n feature • Scale
GeoExplorer 3 Operation Guide Reference
DATA section – The Map tab

The Map screen displays:

NOTE There are two map screens available on the GeoExplorer 3,
Chart. Use the Map tab, in the DATA section, to view, select
Chart tab, in the NAV section, to navigate to features and wa

• North indicator (N) • Features • Filenam

• Current position • GPS trail • Betwee
GPS



ature type appears as a 
 a feature indicates that the 

 in/out, the scale changes 

ntly open.

ave taken.
itions logged between features.
GeoExplorer 3 Operation Guide Reference
DATA section – The Map tab

Item Description
North indicator (N) North direction.
Current position Your current GPS position.
Features Point, line, and area features. Each fe

different symbol on the map. The ✓ on
feature is updated.

Scale The scale of the screen. As you zoom
accordingly.

Filename The name of the data file that is curre
Waypoint Waypoints on the GeoExplorer 3.
GPS trail A trail of dots that shows the path you h
Between feature 
GPS

A trail of small crosses that show all pos



e same tasks using it as you can 
st are related. When you select a 
feature list, and vice versa. If you 
.

, press two arrow keys at the 

 is visible, the cursor initially 
 selected feature is not visible, 
 the last location on the screen 
rwise, the cursor appears in the 

More...
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DATA section – The Map tab

Using the Map tab
The Map tab is similar to The Update tab. You can perform all th
using the Update feature list. The Map tab and Update feature li
feature on the map, the same feature is selected in the Update 
delete a feature on the map, that feature is deleted from the list

TIP To move between these two tabs, press �.

To display the cursor, press an arrow key.

To move the cursor, press the arrow keys. To move it diagonally
same time. 

Cursor

If the selected feature
appears over it. If the
the cursor appears at
(if that is visible). Othe
center of the screen.



 is close to a feature, the symbol 
yed. The feature is selected. As 
appears. However, the feature 

tically pans (half a screen width) 
the same geographic position. In 
le.

 to pan the screen (half a screen 
isible.

n is not visible, the screen 
e center of the screen.

ple, the Gate feature is 
ected.
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Use the cursor to select a feature on the map. When the cursor
for that feature is highlighted and the name of the feature displa
the cursor moves away from a highlighted feature, the name dis
remains selected (highlighted) until another feature is selected.

When the cursor moves to the edge of the map, the map automa
in the direction of the cursor movement. The cursor remains in 
these circumstances, the current GPS position may not be visib

Alternatively, press �
, ��, �	, or ��
width). You cannot pan across the screen unless the cursor is v

To remove the cursor, press � . If the current GPS positio
automatically pans until the current GPS position symbol is in th

In this exam
currently sel

Selected feature



• Zoom extents

• Filter
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DATA section – The Map tab

Map option list
� / Map / ��
Press � to display the available options for the Map.

The options are:

• Zoom in • Zoom out

• Pan/select • Delete

• Layers



is magnifies the display (by 
he bottom of the screen 
is active, the screen zooms in 
 active, the screen zooms in 

his lets you see a greater 
ale on the bottom of the 
 cursor is active, the screen 
n the cursor is not active, the 
nt GPS position.

layers are visible on the map 
es. What it shows depends on 
 the features are filtered. 
the Zoom extents option does 

More...
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DATA section – The Map tab

Use this option … To...
Zoom in zoom in to the map screen.

Press � and select Zoom in. Th
decreasing the scale). The scale on t
adjusts accordingly. When the cursor 
on the cursor. When the cursor is not
on the current GPS position.

Zoom out zoom out of the map screen. 
Press � and select Zoom out. T
area (by increasing the scale). The sc
screen adjusts accordingly. When the
zooms out relative to the cursor. Whe
screen zooms out relative to the curre

Zoom extents change the scale so that all selected 
screen. The Zoom extents option vari
what layers are selected and whether
If nothing is displayed on the screen, 
not affect the map scale.



creen in the direction of the 
he cursor to select features 

his, highlight it, press � 
ugh the deleted feature in the 
deleted from the map.

use the

More...

GeoExplorer 3 Operation Guide Reference

DATA section – The Map tab

Pan/select activate the on-screen cursor.
Use the on-screen cursor to pan the s
cursor movement. You can also use t
on-screen.

Delete Delete a feature from the map. To do t
and select Delete. A line appears thro
Update feature list and the feature is 

NOTE To restore deleted features 
Update feature option list.

Use this option … To...



map screen. Select the Filter 
ions:

on the feature names. 

 the time or date a feature was 
ded. 

on the current status of the 

More...
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DATA section – The Map tab

Filter Filter the features that appear on the 
option. A sublist appears with the opt

• Feature – Filters the feature based 

• Time – Filters the features based on
started, or the time or date it was en

• Status – Filters the features based 
features.

• None – Removes all filters.

For more information see Filter.

Use this option … To...



ap screen. Select the Layers 
yers:

red in the current data file. 
displayed on the map screen.

stored on the GeoExplorer 3. 
e displayed on the map screen.

at shows the path you have 
of dots is displayed on the map 
of 60 positions. Old positions 
d.

trail of small crosses that show 
s (see Log between features).

 that are updated. For line and 
start point. For more 

t GPS trail.
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Layers Specify the layers displayed on the m
option. A checklist appears with the la

• Feature – Displays the features sto
When this is selected, features are 

• Waypoint – Displays the waypoints 
When this is selected, waypoints ar

• GPS trail – Displays a trail of dots th
taken. When this is selected, a trail 
screen. This trail grows to a length 
then drop off as new ones are adde

• Between feature GPS – Displays a 
all positions logged between feature

• Updated – Displays a ✓ on features
area features the ✓ appears at the 
information see The Update tab.

By default, all layers are selected excep

Use this option … To...



GeoExplorer 3 Operation Guide Reference
NAV section – Introduction

�*��&!��������&
Use the NAV section to navigate to features and waypoints. Each tab in the NAV section provides 
a different way of navigating. With the Road tab, you navigate using a road screen; with the 
Compass tab, a compass; and with the Chart tab, you use a map to navigate to a feature or 
waypoint. Choose the navigation method that suits your current situation or personal preference.

Press � to move between the tabs in the NAV section.

The NAV section has three tabs:

NOTE The Chart tab is not available with the GeoExplorer 3c edition.

• The Road tab • The Compass tab • The Chart tab



ive. The road navigation screen 

 yourself and the target.
isplayed on this screen.

• Info windows

 navigate to targets and to 
tion about your location relative 
of the target.

 to view the Road option list.
GeoExplorer 3 Operation Guide Reference
NAV section – The Road tab

��	��������+
� / Road

To display the Road tab, press � until the Road tab is act
appears:

The Road screen contains:

WARNING The Road tab represents a direct line-of-sight path between
Do not attempt to navigate a vehicle using the information d

• Current position • Target name

Use this tab to
display informa
to the location 

Press �Current

Info windows

Target name

 position



cation relative to the target. 
ight ahead, towards the top of 

rget you are navigating to. A 
.
t the bottom of the screen) to 
Info window is only displayed 
 more information about 
tion list.
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NAV section – The Road tab

Item Description
Current position The person symbol represents your lo

The person symbol always heads stra
the screen. This is your heading.

Target name The target name is the name of the ta
’?’ appears when no target is selected

Info windows You can configure the Info windows (a
provide navigational information. The 
if one or more items are selected. For
configuring Info windows see Road op



 select a target.

ars:

• None

ature or a waypoint as your 

More...
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NAV section – The Road tab

Using the Road tab
Use the Road tab to navigate to targets. To activate navigation,

To select a target press � . The Select target screen appe

The Select target screen has three buttons:

NOTE You can also select a target using the Road option list.

• New • List

Use this screen to select a fe
target.



e you to it. The graphical display 
 the screen shows what action is 
 navigational information that you 

op of the screen. To understand 
e view on the screen is from a 

creen. When you are off course, 
kwise or counter-clockwise) that 

mation displayed in this screen 
 the selected target.

More...

GeoExplorer 3 Operation Guide Reference

NAV section – The Road tab

When you select a target, the Road screen animates to navigat
shows where you are and where the target is. The animation of
required. The Info windows, at the bottom of the screen, display
can use to navigate to the target.

The heading, or direction you are going, is always towards the t
this perspective, imagine you are the person symbol and that th
camera balanced on your shoulder. 

When you are on course, the road is displayed vertically in the s
the road is skewed (at an angle) on the screen. The angle (cloc
the road is turned depends on how far off course you are.

Road centerline

Target

Use the infor
to navigate to

Target name

Info windows

Current position



.

son symbol will be ahead of the 

ventually the target moves away 
ou have reached the target by 
een you and the target.

gn, and Velocity. To change 

More...
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NAV section – The Road tab

If you are seriously off course, the screen will look similar to this

If you are moving in the opposite direction to the target, the per
target symbol.

As you move closer to the target the road width increases and e
from the edge towards the center of the screen. You know that y
using the Distance in the Info windows. This is the distance betw

NOTE The default setting for the Info windows is Distance, Road si
this, see Info windows.



d the road screen will display the 
ff the road this means that you 
ance between the start point and 
GeoExplorer 3 Operation Guide Reference
NAV section – The Road tab

In situations where a start waypoint or feature has been specifie
cross-track error graphically. When the person symbol moves o
have moved away from the line that represents the shortest dist
the target. The following screen appears:



his button, the New waypoint 
 information, and press 
igates you to the target. For 

 tab.
 and features on the 

waypoint, and press � . 
ou to the target. For more 

 are those stored in the open 
s open, no features are 
GeoExplorer 3 Operation Guide Reference
NAV section – The Road tab

Use this button … To …
New Enter a new target. When you select t

form appears. Enter the new waypoint
� . The screen animates and nav
more information see Using the Road

List Select a target from a list of waypoints
GeoExplorer 3. Highlight a feature or 
The screen animates and navigates y
information see Using the Road tab.

NOTE Features available in the list
data file. When no data file i
available in this list.

None Indicates that no target is selected.



• New waypoint

• Select start
GeoExplorer 3 Operation Guide Reference
NAV section – The Road tab

Road option list
� / Road / � 

Press � to view the available options. 

The options are:

• Info windows • Select target

• Edit waypoints • Delete waypoints

• Road scale



tion screen, select the Info 
 A checklist appears:

• Heading

• Current time

tes • Altitude

More...
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NAV section – The Road tab

Info windows
To configure the Info windows display at the bottom of a naviga
windows option from the option list (Road, Compass, or Chart).

 The items are:

• Distance • Road sign • Bearing

• Turn • Cross track • Velocity

• Arrive in • ETA • Coordina

• Go N/E • Go up



it. To add an item to the display, 
 To remove an item from the 

e items display, first remove 
n is displayed at the bottom of 

you can only display one other 

roll up and down to see them 

urrent GPS position and the 
 distance to the target, 
rget is selected, the value 

n. If no target is selected, the 

ngle that you should follow to 
rrent GPS position and the 
e displayed is N/A.

More...
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NAV section – The Road tab

When an item is selected there is a ✓  in the check box beside 
highlight it, and press � . A ✓  appears in that check box.
display, highlight it, and press � . The ✓  disappears.

NOTE You can display zero, one, two, or three items. To change th
those currently selected. If you select no items, no informatio
the navigation screen. If you select Coordinates or Go N/E, 
item.

NOTE Not all items in the checklist fit on the screen at one time. Sc
all. Checklists scroll in a cyclical fashion.

Checklist item This item displays …
Distance The distance remaining between the c

target. This is the shortest great-circle
computed on your local datum. If no ta
displayed is N/A.

Road sign The direction in which you need to tur
value displayed is N/A.

Bearing The bearing to the target. This is the a
take the shortest path between the cu
target. If no target is selected, the valu



g or, if you are stationary, the 
 GeoExplorer 3 handheld to. 
give an accurate heading so 
eading can be displayed 
 selected.
d the heading. The direction 

just your heading (left or right) 
lected, the value displayed is 

test line between the start 
t or right) is indicated by ’←’ 
e distance you need to travel 
hen you are on track, you are 

en you are off track, the person 
 centerline. The distance away 
s how far off track you are. 
ay the cross track. When no 
lue displayed is N/A.

More...
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NAV section – The Road tab

Heading The direction in which you are travelin
direction in which you are pointing the
When you are stationary GPS cannot 
the internal digital compass is used. H
whether or not a target or start point is

Turn The difference between the bearing an
you need to turn to face the target. Ad
by the amount shown. If no target is se
N/A.

Cross track The direction and distance of the shor
point and the target. The direction (lef
or ’→’. The numeric value indicates th
in that direction to get back on track. W
traveling straight towards the target. Wh
symbol appears some distance from the
from the centerline (left or right) indicate
Select a start point and target to displ
start point or target is selected, the va

Checklist item This item displays …



 into account change in 
The velocity can be displayed 
 selected.
oExplorer 3 data collection 

ing the Formats form. The 
 or not a target or start point is 

 target. This value takes your 
s a larger value if you are not 
o target is selected, the value 

get. This is based on the 
o target is selected, the value 

ate system that is displayed 
igure the coordinate system, 
s can be displayed whether or 

hen the GeoExplorer 3 is 
 value displayed is N/A.

More...
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NAV section – The Road tab

Velocity Your current velocity. This value takes
altitude as well as horizontal velocity. 
whether or not a target or start point is

Current time The current time configured on the Ge
system. Configure the current time us
current time can be displayed whether
selected.

Arrive in The time remaining until you reach the
current heading into account and show
heading directly towards the target. If n
displayed is N/A.

ETA The expected time of arrival at the tar
Arrive in time and the Current time. If n
displayed is N/A.

Coordinates The current GPS position. The coordin
depends on the configuration. To conf
use the Coordinates form. Coordinate
not a target or start point is selected. W
unable to compute GPS positions, the

Checklist item This item displays …



et. If no target is selected, the 

nd east component. If no 
 is N/A.
he target. If no target is 
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Altitude The altitude between you and the targ
value displayed is N/A.

Go N/E The direction to the target as a north a
target is selected, the value displayed

Go up The vertical distance (up or down) to t
selected, the value displayed is N/A.

Checklist item This item displays …



 the option list (Road, Compass, 

• None

ature or a waypoint as your 
GeoExplorer 3 Operation Guide Reference
NAV section – The Road tab

Select target
To select a target waypoint, choose the Select target option from
or Chart). The Select target screen appears: 

The Select target screen has three buttons:

• New • List

Use this screen to select a fe
target.



ffix is a three-digit number 
 When a new waypoint is created 
 is a three-digit number (starting 

 changes. 

s.
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New waypoint
To create a new waypoint, select the New waypoint option 
from the option list (Road, Compass, or Chart). The New 
waypoint form appears:

Use this form to enter new waypoint information. The New 
waypoint form requires Text entry and Numeric entry.

Press � to display the Here option. Use the Here 
option to automatically update the Lat, Lon, and Altitude fields 
with the current GPS position.

The GeoExplorer 3 automatically generates a name for the 
new waypoint. When a new waypoint is created using the 
current GPS position, the prefix for the name is GPS and the su
(starting at 000 for the first one created). For example, GPS004.
using the cursor, the prefix for the name is Cursor and the suffix
at 000 for the first one created). For example, Cursor017. 

When you have completed data entry, press � to save the

Press �� to close the form and abandon any change

NOTE The GeoExplorer 3 handheld can store 1000 waypoints.



ypoint information. The Edit 
t entry and Numeric entry.

 Here option. Use the Here 
te the Lat, Lon, and Altitude 

position.

data entry, press � to save 
 to close the form and 
GeoExplorer 3 Operation Guide Reference
NAV section – The Road tab

Edit waypoints
To edit a waypoint, select the Edit waypoints option from the 
option list (Road, Compass, or Chart). An Edit waypoints list 
appears:

This list shows all waypoints on the GeoExplorer 3 data 
collection system. Select the one to be edited. The Edit 
waypoints form appears.

Use this form to edit the wa
waypoint form requires Tex

Press � to display the
option to automatically upda
fields with the current GPS 

When you have completed 
the changes. Press ��
abandon any changes.



s on the GeoExplorer 3 data 
e one to be deleted. You are 
letion.

ypoint indicated.

 Delete waypoints list.
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NAV section – The Road tab

Delete waypoints
To delete a waypoint, select the Delete waypoints option from 
the options list (Road, Compass, or Chart). A Delete 
waypoints list appears:

Press � to display the Delete all option. Use the Delete 
all option to delete all waypoints stored on the GeoExplorer 3.

This list shows all waypoint
collection system. Select th
prompted to confirm the de

Select Yes to delete the wa

Select No to go back to the



tion list (Road, Compass, or 

 target. If no start point is 
 is displayed as N/A.

• None

aypoint or feature that you want 
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NAV section – The Road tab

Select start
To select a start point choose the Select start option from the op
Chart). The Select start screen appears:

The Select start screen has three buttons:

NOTE You do not have to select a start point before navigating to a
specified, some navigational information in the Info windows

• New • List

Use this screen to select the w
to start navigating from.



ct this button, the

vailable waypoints and 
ld.

t are those stored in the open 
is open, no features are 
GeoExplorer 3 Operation Guide Reference
NAV section – The Road tab

Use this button … To …
New Enter a new waypoint. When you sele

New waypoint form appears.
List Select the start point from the list of a

features on the GeoExplorer 3 handhe

NOTE Features available in the lis
data file. When no data file 
available.

None Indicate that there is no start point.



e the Road scale option from the 
 you want to follow a path. For 
th you are traveling, set a small 
ld, and staying on track is less 
GeoExplorer 3 Operation Guide Reference
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Road scale
To change the scale of the Road screen that is displayed, choos
Road option list. Set the road scale according to how accurately
example, if you are walking and you want to stay close to the pa
road scale, for example, 10. If traveling by vehicle in an open fie
important, set a larger road scale, for example, 90.



tab

ab is active. The Compass tab 

• Compass rose

combined internal and GPS 
e it to orient yourself, and to 
 target.

 to view the
tion list.

hen you receive your 
oExplorer 3 the internal 

mpass may require Calibration.
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NAV section – The Compass 

��	��� �������+
� / Compass

To display the Compass tab, press � until the Compass t
appears:

The Compass screen contains:

• Your heading • Current position

• Target name • Info windows

This tab is a 
compass. Us
navigate to a

Press �
Compass op

NOTE W
Ge
co

Current

Target name

Info windows

Your
heading

position

Compass rose



tab

 direction or heading.
 relative to the target. Your 

ards the top of the screen). 
irection in which you are 

f the target you are navigating 
ears.
 the bottom of the screen to 
Info window is only displayed 
 more information about 
s option list.
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Item Description
Your heading The top of the compass indicates your
Current position The + symbol represents your location

heading is always straight ahead (tow
Compass rose The compass rotates to indicate the d

heading. 
Target name The target name indicates the name o

to. When no target is selected a ? app
Info windows You can configure the Info windows at

provide navigational information. The 
if one or more items are selected. For
configuring Info windows see Compas



tab

ts. The bearings are calculated 
 automatically switches between 

at all times, whether you are 

ence.

compass the GeoExplorer 3 is 

More...

GeoExplorer 3 Operation Guide Reference

NAV section – The Compass 

Using the Compass tab
Use the Compass tab to orient yourself and to navigate to targe
by a internal compass and GPS information. The GeoExplorer 3
these at a certain velocity. This provides an accurate heading 
moving or stationary.

The compass always points towards the configured North refer

The type of compass that is displayed indicates which mode of 
using. The GPS compass is the more detailed one.

GPS compass

Internal
compass



tab

xplorer 3 data collector is held 
 accuracy of 1 in 8, that is, it can 
ill accurately display all compass 

ct a target press � . The 

• None

target. 

More...
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When the internal compass is being used, make sure the GeoE
level to give an accurate reading. The internal compass has an
display the eight main compass headings. The GPS compass w
headings.

To navigate to a target, first select a feature or waypoint. To sele
Select target screen appears:

The Select target screen has three buttons:

NOTE You can also select a target using the Compass option list.

• New • List

Use this screen to select the 



tab

de of the compass diagram.

u selected appears as a crossed-
ithin the compass diagram 
aring to the target to navigate to 
ents the direction to the target 

urrent direction (heading).

 Heading.

reen to navigate to the target.

indows at the bottom of the 
lay information that you can use 
to the target.
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NAV section – The Compass 

When a target is selected the target symbol appears on the insi

The top of the compass shows your heading. The target that yo
flag symbol on the inside of the compass diagram. Its position w
indicates the bearing to the target. Use your heading and the be
the target. Navigate by lining up the target symbol, which repres
(bearing), with the top of the compass, which represents your c

NOTE By default, the Info window shows Distance, Road sign, and

To change this, see Info windows.

Target

Target name

Current position

Info windows

Use this sc

The Info w
screen, disp
to navigate 



tab

t this button, the
the new target information, 
ates and you can use it to 

ist of available waypoints and 
ight a waypoint or feature, and 
ure becomes the new target. 
avigate to the target. 

ist are those stored in the 
ata file is open, no features 

ected.
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Use this button … To …
New Enter a new target. When you selec

New waypoint form appears. Enter 
and press � . The screen anim
navigate to the target.

List Select the target waypoint from the l
features in the GeoExplorer 3. Highl
press � . The waypoint or feat
The screen animates and you can n

NOTE Features available in the l
open data file. When no d
are available.

None Indicate that there is no target is sel



tab

 screen. 

• New waypoint

• Select start
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NAV section – The Compass 

Compass option list
� / Compass / �
Press � to display the available options for the Compass

The options are:

• Info windows • Select target

• Edit waypoints • Delete waypoints

• Calibration



tab

GeoExplorer 3 compass at low 
librate the internal compass. To 

you started from. A message will 
GeoExplorer 3 Operation Guide Reference
NAV section – The Compass 

Calibration
Local changes in magnetic fields can effect the accuracy of the 
speeds. In order to take account of local conditions you must ca
do this:

1. Highlight calibration in the compass options list and press 
�. The following screen appears:

2. Follow the instructions and make sure that the antenna of 
the GeoExplorer 3 is level. The antenna is located in the 
top portion of the unit under the Trimble logo.

3. Press �, and as the countdown takes place, rotate 
smoothly through a full circle.

For best results you should finish facing in the direction that 
be displayed indicating if calibration is successful.



rt tab is active. The Chart screen 

is tab to navigate to waypoints 
atures.

� to display the
option list.

More...
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NAV section – The Chart tab

���	���������+
NOTE The Chart tab is not available with the GeoExplorer 3c edition.

� / Chart

To display the navigation Chart tab, press � until the Cha
appears:

Use th
and fe

Press 
Chart 

North

Scale

Current

Target

GPS trail
indicator

position

name

Waypoint

Info windows



 DATA Map and the NAV Chart. 
te features. Use the Chart tab, in 

me • Info windows

osition
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NAV section – The Chart tab

The Chart screen contains:

NOTE There are two map screens available on the GeoExplorer 3: the
Use the Map tab, in the DATA section, to view, select, and upda
the NAV section, to navigate to features and waypoints.

• North indicator • Waypoint • Target na

• Scale • GPS trail • Current p



osition of the waypoints 

f the target you are navigating 
pears.
 screen provide navigational 
tab is Current time and 
ws configuration use the 
nly displayed if one or more 

reen. As you zoom in/out the 

t shows the path you have 

ur current GPS position. The 
ou are heading.
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Item Description
North indicator The ’N’ arrow indicates north.
Waypoint The waypoint symbol represents the p

stored on the GeoExplorer 3.
Target name The Target name indicates the name o

to. When no target is selected, a ? ap
Info windows The Info windows at the bottom of the

information. The default for the Chart 
Coordinates. To change the Info windo
Chart option list. The Info window is o
items are selected.

Scale The scale indicates the scale of the sc
scale changes accordingly.

GPS trail The GPS trail displays a trail of dots tha
taken.

Current position The current position cross indicates yo
arrow points to the direction in which y



). To activate navigation, select a 

rs:

rsor.

• None

get that you want to navigate to.

More...
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NAV section – The Chart tab

Using the Chart tab
Use the Chart tab to navigate to targets (waypoints and features
target.

To select a target, press � . The Select target form appea

The Select target form has three buttons:

NOTE You can also select a target using the Chart option list or a cu
For more information see Using the cursor.

• New • List

Use this form to select the tar



t you to navigate to it. The chart 
S trail positions, the target, the 
ta collection system. The Info 
y relevant information, or 
n display also indicates the 

e cross and arrow symbol) to 
e current position arrow is 

se the information displayed on 
is screen to navigate to the 
lected target.

ordinates

More...
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NAV section – The Chart tab

When you select a target, the chart displays information to assis
graphically displays your current position, your heading, the GP
bearing to the target, and all waypoints on the GeoExplorer 3 da
windows at the bottom of the screen can be configured to displa
removed completely to increase the chart size. The Chart scree
actions required.

In this example, you are navigating from the current position (th
target GPS000 (the cross-flag symbol). The direction in which th
pointing indicates your current heading.

U
th
seTarget

Current position

Current position co

 and direction
Target

Waypoint

 of travel
name



en, a bearing to the target arrow 
e to the target, line up your 
 to the target, the current position 
target when the current position 

ale of the chart. In the example 
 and select Zoom in, Zoom 
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When the scale is set so that the target is not visible on the scre
is displayed from your current position, to the target. To navigat
current heading with the bearing to the target. As you get closer
symbol gets closer to the target symbol. You have reached the 
symbol is over the top of the target symbol.

The scale bar at the bottom of the chart screen, indicates the sc
above, the scale of the screen is 500 m. To change this, press �
out, or Zoom extents.

For more information see Chart option list.



ove the cursor diagonally, press 
lose to the edge of the chart, the 
. The cursor remains in the same 

tially appears over the target. If 
lected, the cursor appears in the 
creen.

More...
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NAV section – The Chart tab

Using the cursor
Use the cursor to select targets and create new waypoints.

To activate the cursor, press an arrow key. The cursor appears:

To move the cursor around the screen, press an arrow key. To m
two arrow keys at the same time. When the cursor moves too c
chart automatically pans in the direction of the cursor movement
geographic position.

Cursor

The cursor ini
no target is se
center of the s

Cursor coordinates

Cursor symbol



Info windows, these coordinates 
oordinate indicates whether the 
ent position of the cursor. In the 
tted line cross. It represents the 
ur current GPS position.

e displayed), the symbol for that 
 of the waypoint is displayed 
ame and highlight disappear. 

waypoint (or feature) is 
arget form appears, with the 

 to accept the waypoint or 

 will pan the map one screen 
remains in the same position on 
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When the cursor is visible and coordinates are displayed in the 
reflect the current cursor position. The symbol to the left of the c
coordinates shown are for your current GPS position or the curr
example above, the symbol to the left of the coordinates is a do
current GPS position of the cursor. An ‘X’ symbol represents yo

NOTE You cannot pan across the screen if the cursor is not visible.

When the cursor is close to a waypoint or feature (if features ar
waypoint is highlighted (in reverse video). In addition, the name
beside it. As you move the cursor away from the waypoint, the n

To select a target using the cursor, press an arrow key until the 
highlighted and the name appears. Press � . The Select t
selected waypoint or feature highlighted in the list. Press �
feature that is highlighted. It becomes the new target.

To remove the cursor, press � .

TIP To pan the screen, press � and one of the arrow keys. This
width in the direction of the arrow key you pressed. The cursor 
the screen, not in the same geographic position.



ew waypoint
here you want to create a new 
t the New button. The New 
 waypoint. For more information 
GeoExplorer 3 Operation Guide Reference
NAV section – The Chart tab

Using the cursor to create a n
Use the arrow keys to move the cursor to a place on the chart w
waypoint. Press � . The Select target form appears. Selec
waypoint form appears. Use it to enter information about the new
about the Select target form see Using the Chart tab.



ents • Info windows

oint • Edit waypoints
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Chart option list
� / Chart / � 

Press � to display the Chart options.

 The options are:

• Zoom in • Zoom out • Zoom ext

• Pan/select • Select target • New wayp

• Delete waypoints • Select start • Layers



his magnifies the display by 
e bottom of the screen 

r is active, the screen zooms 
 not active, the screen zooms 

 This lets you see a greater 
ale at the bottom of the screen 
r is active, the screen zooms 
ursor is not active, the screen 
S position.
splays all selected layers. The 
g to the layers selected and 

, the Zoom extents option 

ttom of the screen.

More...
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NAV section – The Chart tab

Use this option … To …
Zoom in zoom in to the chart screen.

Press � and select Zoom in. T
decreasing the scale. The scale at th
adjusts accordingly. When the curso
in on the cursor. When the cursor is
in on the current GPS position.

Zoom out zoom out of the chart screen. 
Press � and select Zoom out.
area by increasing the scale. The sc
adjusts accordingly. When the curso
out relative to the cursor. When the c
zooms out relative to the current GP

Zoom extents change the scale so that the chart di
Zoom extents option varies accordin
whether the features are filtered. 
If nothing is displayed on the screen
does not affect the chart scale.

Info windows configure the Info windows at the bo



 screen in the direction of the 
 the cursor to select features 

ect a waypoint or a feature as 

can select a waypoint or a 

More...
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NAV section – The Chart tab

Pan/select activate the on-screen cursor.
Use the on-screen cursor to pan the
cursor movement. You can also use
and waypoints on-screen.

Select target access the Select target screen. Sel
the target.

New waypoint create a New waypoint.
Edit waypoints access the Edit waypoints screen.
Delete waypoints access the Delete waypoints list.
Select start access the Select start screen. You 

feature as the start point.

Use this option … To …



hart. Select the Layers option. 
g layers:

tored in the open data file. 
 displayed on the chart.

ts stored on the GeoExplorer 3. 
re displayed on the chart.

which shows the path you have 
il of dots is displayed on the 
f 60 positions. Old positions 

 trail of small crosses that show 
res. 

s that are updated. For line and 
 start point. For more 

s in the data file that is currently 

fault except Updated.
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Layers specify the layers displayed on the c
A checklist appears with the followin

• Features – Displays the features s
When this is selected, features are

• Waypoints – Displays the waypoin
When this is selected, waypoints a

• GPS trail – Displays a trail of dots 
taken. When this is selected, a tra
chart. The trail grows to a length o
drop off as new ones are added.

• Between feature GPS – Displays a
all positions logged between featu

• Updated – Displays a ✓ on feature
area features the ✓ appears at the
information see The Update tab.

NOTE You can only display feature
open.

NOTE All layers are selected by de

Use this option … To …



 them. It then lists the messages 
ach list is arranged in 
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This section lists potential problems and describes how to solve
that can appear on the screen of the GeoExplorer 3 handheld. E
alphabetical order.

• Potential problems

• GeoExplorer 3 messages



the GeoExplorer 3 data collector. 
s.

en postprocessing

e incorrect

e minute of being turned on

tes of being turned on

fter being turned on

s expected

eceiver with the GeoExplorer 3
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Potential problems
Listed here are problems that you could encounter when using 
Select one from the list to view its possible causes and solution

• Automatically generated Time attributes are incorrect

• Cannot differentially correct the rover GPS positions wh

• Coordinates displayed by the GeoExplorer 3 appear to b

• GeoExplorer 3 is not displaying a GPS position within on

• GeoExplorer 3 is not tracking satellites within three minu

• GeoExplorer 3 will not turn on, or turns off immediately a

• The GeoExplorer 3 screen is hard to read

• The internal compass does not appear to be working

• The precision of recorded GPS positions is less than wa

• The real-time differential correction link is not working

• You are having problems using Beacon-on-a-Belt (BoB) r



rect  

e Time zone field (in the 
menu).

 generated file names are 
 UTC time, not local time.

 outside and check that it can 
lite.
r 3 is not tracking satellites 
f being turned on.
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Automatically generated Time attributes are incor

Possible cause Fix
The internal clock of the 
GeoExplorer 3 is set incorrectly.

Reset it by adjusting th
Formats configuration 

NOTE Automatically
derived from

The GeoExplorer 3 has not 
received GPS time yet.

Take the GeoExplorer 3
track at least one satel
If not, see GeoExplore
within three minutes o



ons when postprocessing

t the Elevation mask on the 
h. The rover must only use 
visible to the Base station.

re other Base files collected 
t base file.

 use Base station data from 

e Base file is started before 
d stopped after the rover file 
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Cannot differentially correct the rover GPS positi

Possible cause Fix
The rover unit used satellites that 
were not visible to the base 
station.

In future make sure tha
rover is set high enoug
satellites that are also 

The Base station file started too 
late or too soon.

Check to see if there a
adjacent to your curren
or
Check to see if you can
another provider.
or
In future, make sure th
the rover is started, an
has been closed.



ar to be incorrect

e sure that the correct datum 

ify the correct zone and 

mmonly used in the USA: 
3.

ify the correct coordinate 
e units.
ordinate systems.

More...
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Coordinates displayed by the GeoExplorer 3 appe

Possible cause Fix
You are using the Latitude/
Longitude coordinate 
system and have selected 
the wrong datum.

Check Coordinates and mak
is selected.

You are using the UTM 
coordinate system and have 
selected the wrong UTM 
zone or datum.

Check Coordinates and spec
datum. 

NOTE Two datums are co
NAD-27 and NAD-8

You have selected the 
wrong coordinate system, 
zone, or coordinate units.

Check Coordinates and spec
system, zone, and coordinat
For more information see Co



ordinate system, datum, and/
 that values such as the scale 
 (as a parts-per-million value), 
 the correct sense (a positive 
), and that Latitudes and 
he correct hemisphere (North/
vely).
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You have defined a custom 
coordinate system, datum, 
and/or zone incorrectly 
using the Coordinate 
System Manager in the 
Pathfinder Office software.

Check the definition of the co
or zone carefully. Make sure
factor are specified correctly
that rotations are specified in
rotation is counter-clockwise
Longitudes are specified in t
South or East/West, respecti

Possible cause Fix



ithin one minute of being 

o check that there are 
his time.

 to adjust the configured GPS 

o check that the current PDOP 
igured mask.

 to adjust the configured GPS 

 to check if the Mode field is 
nly. When the GeoExplorer 3 
 only and there is no real-time 
are displayed or recorded.
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GeoExplorer 3 is not displaying a GPS position w
turned on

Possible cause Fix
Not enough satellites are 
available. A minimum of four is 
required to compute GPS 
positions.

Use mission planning t
sufficient satellites at t
or
Use the GPS slider bar
precision.

The current PDOP value is too 
high. (The geometry of the 
satellite constellation is poor)

Use mission planning t
value is below the conf
or
Use the GPS slider bar
precision.

There is no real-time link. Use the Real-time form
configured for RTCM o
is configured for RTCM
link, no GPS positions 



ee minutes of being 

tion and move away from it. 
y be a building, tree, or 

 not work indoors.

ab or Status bar to make sure 
tenna is connected and 
the GeoExplorer 3 still fails to 
tenna and/or antenna cable 

viced.

rnal antenna is not working 
eoExplorer 3 reverts to the 

ntenna.

More...
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GeoExplorer 3 is not tracking satellites within thr
turned on

Possible cause Fix
Satellites are being obstructed. Identify the obstruc

The obstruction ma
vehicle. 

NOTE GPS does

The external antenna (or antenna 
cable) has not been connected, has 
been connected incorrectly, or is 
faulty.

Check The Status t
that the external an
working properly. If 
track signals, the an
may need to be ser

NOTE If the exte
properly G
internal a



inutes) until the
rds an Almanac.
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The almanac is too old. The 
GeoExplorer 3 has not recorded and 
stored a current almanac.

Wait (for up to 15 m
GeoExplorer 3 reco

Possible cause Fix



iately after being turned 

ower source or use an 

of the system. 
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GeoExplorer 3 will not turn on, or turns off immed
on

Possible cause

Possible cause Fix
The internal power source is not 
charged.

Recharge the internal p
external power source.

The GeoExplorer 3 firmware has 
locked up and is not responding to 
any keys.

Perform a Warm boot 



 direct sunlight and wait until 
al.

vel. Use the The Status tab or 
al power is low, recharge the 
ower source with the 

. 

ness.
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The GeoExplorer 3 screen is hard to read

Possible cause Fix
The screen has been left in 
direct sunlight.

Remove the handheld from
the screen returns to norm

The GeoExplorer 3 internal 
power source is low.

Check the internal power le
the Status bar. If the intern
battery or use an external p
GeoExplorer 3 handheld.

The screen display contrast 
needs adjusting.

Adjust the Screen contrast

The screen backlight needs 
adjusting

Adjust the Backlight bright



ing

from the Compass option list 

o be held level for the 
te readings.
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The internal compass does not appear to be work

Possible cause Fix
The compass has not been 
calibrated, or needs to be
re-calibrated.

Use the Calibration option 
to calibrate the compass.

The GeoExplorer 3 is not 
being held in a level position.

The GeoExplorer 3 needs t
compass to display accura



han was expected

o increase the minimum 
quired (for a point feature).

ctions, such as buildings, and 
eatures.

ar.

 or move the GPS slider to the 

k and/or Elevation mask or 
 the right.

More...
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The precision of recorded GPS positions is less t

Possible cause Fix
You did not record sufficient 
positions to achieve the required 
precision (for a point feature).

Use Feature settings t
number of positions re

You are operating in an area of 
high multipath interference.

Move away from obstru
use Offsets to record f

The GPS slider bar is set too low. Adjust the GPS slider b

The PDOP mask is too high. Lower the PDOP mask
right.

The SNR mask and/or Elevation 
mask is too low.

Increase the SNR mas
move the GPS slider to



.
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The GeoExplorer 3 is configured 
to use a minimum of three 
satellites and the 2D altitude 
specified is not accurate.

Change the 2D altitude
Possible cause Fix



rking

the Status bar to check if real-
ing received. Make sure that 
 properly. 

to change the RTCM 
e documentation for your 
rameters.

setting.

ake sure the RTCM input field 
B. Also, check that the BoB 
bled for cable-free 
 information refer to the 
) Receiver Manual.
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The real-time differential correction link is not wo

Possible cause Fix
The RTCM connection is not 
connected, has been connected 
incorrectly, or is faulty.

Use The Status tab or 
time corrections are be
the cable is connected

The RTCM communication 
parameters are configured 
incorrectly.

Use the COMMS form 
parameters. Consult th
radio for the correct pa

The Station ID is incorrect. Change the Station ID 

The GeoExplorer 3 is not 
receiving corrections from the 
BoB receiver via the cable-free 
link.

In the COMMS form m
is set to Cable-free Bo
receiver has been ena
transmission. For more
Beacon-on-a-Belt (BoB



 (BoB) receiver with the 

sing the BoB receiver with the

eacon-on-a-Belt (BoB) Receiver 

o change the frequency being 
e corrections.

 3 closer to the BoB receiver.
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You are having problems using Beacon-on-a-Belt
GeoExplorer 3

NOTE There may be other reasons why you are having problems u
GeoExplorer 3.

For more information refer to the troubleshooting section in the B
Manual.

Possible cause Fix
The BoB receiver is set to the 
wrong frequency.

Use the BoB receiver t
used to receive real-tim

The BoB receiver is too far away 
when operating using the cable-
free link.

Move the GeoExplorer



 that can be displayed by the 
ssage is(are) described and, 
.
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GeoExplorer 3 messages
This section lists error, confirmation, and information messages
GeoExplorer 3 data collection system. The cause(s) of each me
where relevant, suggestions are made how you should proceed

• Error!

• Please confirm...

• Other messages



gs

 change the mode. You cannot 
om mode. To change mode, use 
nd select Standard.

oints stored on the
waypoints using the option list in 
 want to save any waypoints first, 

a data file is open 

ta file is open or data transfer is 
 is completed, then attempt the 

More...
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Error!
Cannot change mode with custom settin

You are in the custom mode of the GPS slider bar and you try to
view the Standard mode of the GPS slider bar if you are in Cust
the arrow keys to highlight the slider bar. Then press � a

Cannot exceed 1000 waypoints

You attempted to create a waypoint when the limit of 1000 wayp
GeoExplorer 3 has been reached. You can delete unnecessary 
the The Road tab, The Compass tab, or The Chart tab. If you
you can transfer them to your office computer.

Compass calibration cannot proceed if 
or data transfer is occurring

You are attempting to calibrate the internal compass while a da
occurring. Close any open data files and wait until data transfer
calibration. 



cannot be deleted

 GeoExplorer 3 uses it. Delete 

ntly open for edit in
t complete any changes, then 

ory than is available on the 
ry Editor in the Utilities menu of 

nary Editor refer to the Pathfinder 

 file. All file names and identifiers 
r lower) is not significant when 

More...
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<Dictionary file name> is in use and 

If a data dictionary cannot be deleted because a data file on the
the data file before deleting the dictionary.

Data dictionary currently in use

You have tried to open a file using a data dictionary that is curre
The Setup tab. To open a file using this dictionary you must firs
close the dictionary, before proceeding to open your file.

Data dictionary too large to edit

You have tried to open a data dictionary that requires more mem
GeoExplorer 3. To edit the data dictionary use the Data Dictiona
Pathfinder Office. For more information on using the Data Dictio
Office online Help.

Duplicate file names are not allowed

You have attempted to give a file the same name as an existing
on the GeoExplorer 3 must have a unique name. Case (upper o
comparing two names.



ithin the specified range.

d

e not entered a value.

successful. Make sure that the 
e is enough memory on 

r was unsuccessful. Make sure 
nd that there is enough memory 

g transferred to your office 
computer. Either cancel the data 
ete before opening/deleting the 

More...

GeoExplorer 3 Operation Guide Troubleshooting

<field>: out of range “min” to “max”

The number entered is too large or too small. Enter a number w

<field/attribute name>: Entry require

You are editing a field or attribute that requires a value, but hav

Failed to load configuration file

The transfer of a configuration file to the office computer was un
configuration file is valid and it contains no errors, and that ther
GeoExplorer 3.

Failed to load coordinate system

The transfer of a coordinate system file from the office compute
that the coordinate system file is valid and contains no errors, a
on the GeoExplorer 3.

File in use by data transfer

You have attempted to open or delete a file that is currently bein
computer or is being overwritten by an transfer from your office 
transfer from your office computer or wait until transfer is compl
data file.



tion

ounds of the configured 
ve selected the appropriate 
the coordinate correctly (pay 
 custom coordinate system and/
um, and/or zone correctly.

 in the correct format as 

 in the correct format as 
 hour format. If using the 12 hour 

 when less than 10 KB of data 
emory is left. To create memory 

More...
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Inappropriate location for map projec

You have entered a coordinate (North/East) that is outside the b
coordinate system zone. Use Coordinates to check that you ha
coordinate system and zone. Make sure that you have entered 
particular attention to the hemisphere—N, S, E, or W). If using a
or zone, make sure that you defined the coordinate system, dat

Invalid date

The date entered is invalid. Make sure that you entered the date
configured in Formats.

Invalid time

The time entered is invalid. Make sure that you entered the time
configured in Formats. You can enter time in either the 12 or 24
clock, remember to specify pm if the time is after midday. 

Memory nearly full

This warning message appears if you try to create or open a file
storage space remains. Use The Status tab to see how much m
space, use The File tab to delete data files.



arge

displayed on the GeoExplorer 3.

 If this message appears, you 
 coordinate system.

fore upgrading

 low power supply. To proceed 
ower connected. The upgrade 

res based on logging time, and 
rect Start and End times.

ed.  Typically three windows can 
hecked you can only display one 
sing the list.

More...
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<number>: Floating point number too l

The numeric value entered in a field is too large to be stored or 

The GeoExplorer 3 can store and display large numeric values.
have probably entered a wrong value or coordinate in the wrong

Please charge the internal battery be

You are attempting to upgrade the firmware while the unit has a
with the upgrade place the unit in the support module with the p
can take place when the power level has reached 10%.

Start time is later than end time

This message appears when the GeoExplorer 3 is filtering featu
the specified End time is not later than the Start time. Enter cor

Too many info windows selected

You have checked more Info window options than can be display
be displayed at once.  However, if Coordinates or Go N/E are c
other Info window.  Uncheck the excess Info windows before clo



eek old

 ago. Create a new data file to 

a file is open

ata file is open. Before entering 
 key in the Data section to close 
 file is closed, to place the 

t coordinate system 

 the boundaries of the current 
 appropriate coordinate system 
Pay particular attention to the 
 and/or zone, make sure that 

rrectly.

te system transferred from the 
ordinate systems have a global 
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Unable to append to a file over one w

You attempted to log data to a file created more than one week
collect data.

Unable to go to standby mode if a dat

You have attempted to place the unit in standby mode while a d
standby mode all data files must first be closed. Use the �
any open features and then the file itself. Press �, once the
GeoExplorer 3 in standby mode.

Warning! Position is out of the curren
boundaries

You attempted to enter or display a geographic position outside
coordinate system. Use Coordinates to see if you selected the
and zone. Make sure that you entered the coordinate correctly. 
hemisphere—N, S, E, or W. If using a custom coordinate system
you have defined the coordinate system, datum, and/or zone co

This message is most likely to appear when you use a coordina
Pathfinder Office software, as the default Lat/Long and UTM co
scope. 

For more information refer to the Pathfinder Office online Help.



d. Operation not 

y the office software. The 
e password check the password 

n that can be displayed by the 
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You have entered an incorrect passwor
allowed.

The field you have tried to change has been password locked b
password you have entered is incorrect. If you have forgotten th
settings for your Configuration file in Configuration Manager.

Zoom limit reached

You have reached the maximum or minimum zoom magnificatio
map or chart.



r form. Select No to cancel the 

en. Select No to cancel the close 

lts?

factory default values. Select No 

ase or rover) is open. If you 
the values.

plorer 3. Select No to cancel the 

More...
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Please confirm...
Abandon changes?

Select Yes to discard any changes made to the open attribute o
operation and return to the form without losing your changes.

Close rover file?

Select Yes to close and save the rover file you currently have op
and continue with the file open.

Close file and reset to factory defau

Select Yes to reset the GeoExplorer 3 data collection system to 
to cancel the operation.

GeoExplorer 3 cannot be reset to factory defaults if a data file (b
select Yes, GeoExplorer 3 will close the file first and then reset 

Delete all?

Select Yes to delete all waypoints that are stored on the GeoEx
operation. 



d on the GeoExplorer 3. Select 

the operation.

the operation.

e>?

ancel the operation.

e operation.

 operation.

l the operation.

More...
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Delete all files?

Select Yes to delete all data files (rover and base) that are store
No to cancel the operation. 

Delete attribute <attribute name>?

Select Yes to delete the selected attribute. Select No to cancel 

Delete base file <filename>?

Select Yes to delete the selected base file. Select No to cancel 

Delete dictionary <dictionary filenam

Select Yes to delete the selected data dictionary. Select No to c

Delete feature <feature name>?

Select Yes to delete the selected feature. Select No to cancel th

Delete geoid?

Select Yes to delete the specified geoid. Select No to cancel the

Delete rover file <filename>?

Select Yes to delete the selected Rover file. Select No to cance



 operation.

 the operation.

stance: Replace GPS 

t position is further than the 
orded position. Select Yes to 
elect No to cancel the operation.

 will delete all 

 in upgrade mode for installation 
alling new firmware will delete all 
upgrade and return to

More...
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Delete value <value name>?

Select Yes to delete the selected value. Select No to cancel the

Delete waypoint <waypoint name>?

Select Yes to delete the selected waypoint. Select No to cancel

Distance to feature exceeds warning di
data anyway?

You are updating the GPS position of a feature and your curren
configured Warning distance from the feature’s previously rec
overwrite the previous position with the current GPS position. S

Enter upgrade mode? (Firmware upgrade
data files)

Select Yes to enter upgrade mode. The GeoExplorer 3 must be
of different firmware versions using the WinFlash software. Inst
files on the GeoExplorer 3. Select No to abandon the firmware 
The Setup tab.



red to the PC: 

puter. If you delete it from the 
e selected file. Select No to 

ase data, and the amount of data 
e the file. Select No to continue 

nt to store this 

 GeoExplorer 3 could record the 
ature anyway. Select No to 

except Latitude/Longitude and 
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File <filename> has not been transfer
Delete anyway?

The selected data file has not been transferred to the office com
GeoExplorer 3, it will not be recoverable. Select Yes to delete th
cancel the operation.

Insufficient carrier: Close anyway?

You have attempted to close a data file that is logging carrier ph
required (10 minutes) has not been collected. Select Yes to clos
collecting carrier-phase data.

Insufficient GPS positions: Do you wa
feature now?

You have attempted to close the current point feature before the
configured Minimum positions. Select Yes to store the point fe
continue collecting positions for the selected feature.

Reset coordinate systems?

Select Yes to remove all coordinates loaded on GeoExplorer 3, 
UTM. Select No to cancel the operation.



 file. Select No to continue 

ame>?

t GPS position. Select No to 
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Stop base station?

Select Yes to stop logging base station data and close the base
logging data.

Update GPS data in feature <feature n

Select Yes to replace the previous GPS position with the curren
cancel the operation.



e compass screen without 

heading under local conditions. 
ptions list. The internal compass 
ns at low velocities. For more 

 close the message. For more 

 menu using this combination of 

More...
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Other messages
Calibration failed, Try again?

Select Yes to attempt calibration again. Select No to return to th
calibrating the compass.

Calibrate digital compass

The internal compass requires calibration to return an accurate 
To calibrate the compass select Calibration from the Compass o
effects the use of the Skyplot, Road, Chart, and Compass scree
information see Using the Compass tab.

Calibration successful

You have successfully calibrated the compass. Press � to
information see Using the Compass tab.

� + � to display the main menu

For an overview of the GeoExplorer 3 system, access the main
keys. 



osition is available. (This occurs, 
or.)

ified parameters.

 further operation is suspended 
els the current task.

ere not closed properly because 

 parameters.

igured on the GPS slider bar.

More...
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OLD position

This message flashes over the GPS position if no current GPS p
for example, if there are too few satellites or the geometry is po

Please wait... Filtering

The GeoExplorer 3 is filtering the features according to the spec

Please wait... Processing

The GeoExplorer 3 has a large amount of processing to do and
until the current task is completed. Pressing � � canc

Please wait... Rebuilding file

The GeoExplorer 3 is checking and repairing files. These files w
of a sudden power failure or similar event.

Please wait... Sorting

GeoExplorer 3 is sorting the features according to the specified

Poor geometry

The current satellite geometry does not meet the precision conf

The current PDOP is higher than the configured PDOP mask.



o the PC: Continue?

on the GeoExplorer 3 will be 
ware upgrade. You may transfer 

ion configured on the GPS slider 

n the configured SNR mask. 

son. If this message persists 
 serviced.

 down power key to 

f you have not done so already, 
Flash to upgrade the firmware to 
wn the power key � for 
 

More...
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Some files have not been transferred t

Select Yes to continue with the firmware upgrade. All data files 
permanently deleted. Select No if you want to abandon the firm
the necessary files and then upgrade your firmware.

Too few satellites

The number of satellites being tracked does not meet the precis
bar.

There are too few satellites with an SNR value that is higher tha

Undefined GPS error

The GeoExplorer 3 is not tracking satellites for an unknown rea
please contact your Trimble dealer to have the GPS equipment

Upgrading firmware from WinFlash (Hold
abort)

The GeoExplorer 3 is now able to communicate with Winflash. I
connect the GeoExplorer 3 to your office computer and run Win
a different version. If you want to abandon the upgrade hold do
approximately 10 seconds. Restart using the power key �.



een entered for the current 

on form and then press �.
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Validating

The GeoExplorer 3 is validating the attribute values that have b
feature.

This message also appears if you change fields in a configurati



�	
r 3c data collection system, then 

u can disregard this chapter.

to:

irmware or vice versa

are

ware
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�������������	�$�� ,�
If you have received the complete GeoExplorer 3 or GeoExplore
it already contains the GeoExplorer 3 firmware. In this case, yo

Please read and follow these instructions carefully, if you need 

• change your GeoExplorer 3c firmware to the GeoExplorer 3 f

• update the GeoExplorer 3 or GeoExplorer 3c firmware

• install or reinstall the GeoExplorer 3 or GeoExplorer 3c firmw

These instructions cover:

• Equipment required for installation

• Changing to a different edition of the GeoExplorer 3 firm

• Installing the GeoExplorer 3 or GeoExplorer 3c firmware



nstallation
ware, which is used to install the 
, must be installed on your office 
, from the World Wide Web
 Wide Web, contact your local 

ctor you need the following 

Windows 98, or Windows NT, 
B of free hard disk space. 

ter has a 25-pin serial port 

installation process, rather than 
, you can upgrade the firmware 
ke sure that the internal battery 

More...
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Equipment required for i
For the upgrades and installation to proceed, the WinFlash soft
GeoExplorer 3 firmware onto your GeoExplorer 3 data collector
computer. It is available, along with the GeoExplorer 3 firmware
(http://www.trimble.com). If you do not have access to the World
Trimble dealer to receive the GeoExplorer 3 installation disks. 

To use the WinFlash software with the GeoExplorer 3 data colle
equipment:

• an IBM-compatible personal computer running Windows 95, 
with at least one available serial RS232 port and at least 10 M

• your GeoExplorer 3 data collector

• a 9-pin to 25-pin converter (this is only required if your compu
connector on its COM1: or COM2: ports)

• a Trimble GeoExplorer 3 Support Module

This is used to provide an external source of power for the 
using the internal battery of the GeoExplorer 3. Alternatively
using the GeoExplorer 3 serial clip, however, you should ma
is at least 50% charged.



Web)

efore you start to perform the 
 substitute other equipment. By 
ctions provided in this section 

. If you use inappropriate 
ou will be unable to install the 
e risk of erasing the current 

tly increased. If this occurs, you 
ing.

rade can be accomplished by 
 3, it is recommended that you 
ource of power. This prevents 
ff a discharged battery.

ve transferred any data files and 
be deleted.
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• CD-ROM drive (if you do not have access to the World Wide 

CAUTION It is crucial that you have all of the equipment listed above b
option upgrade or to install the firmware. Do not attempt to
using the recommended equipment and following the instru
you will be able to quickly and reliably perform the process
equipment, or fail to follow the instructions, it is likely that y
firmware or upgrade the options successfully. In addition, th
firmware in your GeoExplorer 3 without replacing it, is grea
will need to return your GeoExplorer 3 to Trimble for servic

Although the GeoExplorer 3 firmware installation and option upg
using power from the internal lithium battery of the GeoExplorer
use the Trimble GeoExplorer 3 Support Module as an external s
accidental termination of the installation process while running o

Before you start the installation process, make sure that you ha
waypoints to your office computer. If you do not, these files will 



dition of the 

 3 or GeoExplorer 3c) onto the 
d’. To enable the GeoExplorer 3 
.

n the data collector. Once the 
e new firmware edition.

ort Module as an external 

ry of the GeoExplorer 3 as the 
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Changing to a different e
GeoExplorer 3 firmware
Before you load a different edition of the firmware (GeoExplorer
data collector, the GeoExplorer 3 data collector must be ‘enable
data collector to install either edition requires an option upgrade

The option upgrade program simply changes internal settings o
internal settings have been changed, you then need to install th

To perform an option install using the GeoExplorer 3 Supp
power source

To perform an option install using the internal lithium batte
power source



odule as an external power 

nstallation:

t (mains).

CLOSE

CANCEL
MENU

OPTION

ENTER

LOG

r

Fn

SYS NAV

DATA

More...
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To perform an option install using the GeoExplorer 3 Support M
source:

1.  Connect the equipment listed in Equipment required for i

2. Plug the GeoExplorer 3 Support Module into the wall curren



r COM2 serial port of your 
r 18532).

er 3 Support Module.

ot already on. Check the Status 
 powered externally:
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3. Connect the GeoExplorer 3 Support Module to the COM1 o
computer using the supplied null modem cable (part numbe

4. Place your GeoExplorer 3 data collector into the GeoExplor

5. Turn on the GeoExplorer 3 and office computer, if they are n
screen on the GeoExplorer 3 to make sure the unit is being

You are now ready to option upgrade the firmware.

See To proceed with the option upgrade.



he GeoExplorer 3 as the power 

 the rear of the GeoExplorer 3 

32) to the serial clip. Connect the 
erial port of your computer.

t

GeoExplorer 3 Operation Guide Installing the firmware

To perform an option install using the internal lithium battery of t
source:

1. Connect the serial clip (part number 38595-00) to swipes on
data collector.

2. Connect one end of the null modem cable (part number 185
other end of the null modem cable to the COM1 or COM2 s

You are now ready to option upgrade the firmware.

See To proceed with the option upgrade.



Reset. The following menu 

More...
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To proceed with the option upgrade

1. Turn on the GeoExplorer 3. Go to the Setup tab and select 
appears:



ction. You can begin the option 

, which is used to install the 
ctor, must be installed on your 
 want to install. The WinFlash 
the World Wide Web or from the 

tart menu select Programs / 

More...
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2. Select Upgrade firmware. You will be asked to confirm this a
upgrade when the following screen appears:

3. Turn to your office computer.

For the firmware upgrade to proceed, the WinFlash program
GeoExplorer 3 firmware onto your GeoExplorer 3 data colle
office computer, along with the GeoExplorer 3 firmware you
program and GeoExplorer 3 firmware can be installed from 
installation disk (if you do not have Internet access). 

4. Start the WinFlash software. To do this, from the Windows S
WinFlash / WinFlash.



More...
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A dialog similar to the following appears:



nd specify the personal computer 

More...

GeoExplorer 3 Operation Guide Installing the firmware

5. Select the GeoExplorer 3 data collector as the device type a
serial port that your GeoExplorer 3 is connected to.

6. Click Next.



More...

GeoExplorer 3 Operation Guide Installing the firmware

The Operation Selection dialog appears:



More...
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7. Select the Option upgrade option and click Next.



More...
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The following dialog appears:



ption password. Enter the 
Trimble and click Next.

3 and the option installation 

on the GeoExplorer 3 once it has 
ou may need to return your 

e.
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8. At this point, the WinFlash software asks you to enter your o
password exactly (including matching case) as provided by 

The program initiates communication with the GeoExplorer 
completes automatically.

WARNING Do not stop the option upgrade process on the computer or 
started. Doing so may corrupt the firmware. If this occurs, y
GeoExplorer 3 to Trimble for servicing.

You are now ready to install the firmware.

See Installing the GeoExplorer 3 or GeoExplorer 3c firmwar



r 3 or 

to the GeoExplorer 3 data 
er 3c edition.

t previously installed, you must 
scribed in
re. When you have completed 
mware installation.

r 3 firmware onto the 

tents of the GeoExplorer 3’s 
 transferred to your computer 
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Installing the GeoExplore
GeoExplorer 3c firmware
This section describes installing the GeoExplorer 3 firmware on
collector. The instructions are identical those for the GeoExplor

If you are installing an edition of the GeoExplorer 3 firmware no
upgrade the GeoExplorer 3 option onto the data collector as de
Changing to a different edition of the GeoExplorer 3 firmwa
the option upgrade, you can proceed with the GeoExplorer 3 fir

The following instructions enable you to install the GeoExplore
GeoExplorer 3 data collector.

CAUTION The firmware installation process completely erases the con
memory. Make sure that all data files and waypoints are
before installing the firmware.



upport Module as an external 

nstallation:

nt (mains).

CLOSE

CANCEL
MENU

OPTION

ENTER

LOG

r

Fn

SYS NAV

DATA
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To install the GeoExplorer 3 firmware using the GeoExplorer 3 S
source of power:

1.  Connect the equipment listed in Equipment required for i

2. Plug the GeoExplorer 3 Support Module in to the wall curre



r COM2 serial port of the 
r 18532).

er 3 Support Module.

ady on. Check the Status screen 
d externally:
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3. Connect the GeoExplorer 3 Support Module to the COM1 o
computer using the supplied null modem cable (part numbe

4. Place your GeoExplorer 3 data collector into the GeoExplor

5. Turn on the GeoExplorer 3 and computer, if they are not alre
on the GeoExplorer 3 to make sure the unit is being powere



attery of the GeoExplorer 3 as 

stallation as shown in the 

32) to the serial clip. Connect the 
erial port of your computer.

t

More...
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To install the GeoExplorer 3 firmware using the internal lithium b
the power source:

1. Connect the equipment listed in Equipment required for in
following diagram:

2. Connect one end of the null modem cable (part number 185
other end of the null modem cable to the COM1 or COM2 s

3. Turn on the GeoExplorer 3.



Reset. The following menu 

More...
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4. Turn on the GeoExplorer 3. Go to the Setup tab and select 
appears:



on. Begin the option upgrade 

are, which is used to install the 
ctor, must be installed onto your 
 want to install. The WinFlash 
the World Wide Web or from the 

tart menu select Programs / 
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5. Select Upgrade firmware. You are asked to confirm this acti
when the following screen appears:

6. Turn to your office computer.

For the firmware installation to proceed, the WinFlash softw
GeoExplorer 3 firmware onto your GeoExplorer 3 data colle
office computer, along with the GeoExplorer 3 firmware you
program and GeoExplorer 3 firmware can be installed from 
installation CD (if you do not have Internet access).

7. Start the WinFlash software. To do this, from the Windows S
WinFlash / WinFlash.



More...
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A dialog similar to the following appears:



nd specify the personal computer 

More...
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8. Select the GeoExplorer 3 data collector as the device type a
serial port that your GeoExplorer 3 is connected to.

9. Click Next.
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The Operation Selection dialog appears:



More...
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10. Select the Firmware upgrade option and click Next.



ar to the following:

More...
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The GeoExplorer 3 Software Selection dialog appears simil



oExplorer 3 and click Next.

More...
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11. Select the firmware version you want to install onto your Ge



:

More...
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The Settings Review dialog appears similar to the following



nitiates communication with the 

ress status of the software 

More...
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12. Review the current settings and click Finish. The program i
GeoExplorer 3.

A dialog similar to the following appears, indicating the prog
installation:



sfer of the GeoExplorer 3 
 the installation has completed, 

wly installed firmware.

fying the new GeoExplorer 3 

omputer or the GeoExplorer 3 
is occurs you may need to return 
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The installation takes about five minutes. Typically, the tran
firmware to the data collector proceeds automatically. When
the following dialog appears on your computer:

13. Click Exit to close the WinFlash program.

14. Your GeoExplorer 3 reboots and automatically starts the ne

The Trimble logo screen appears just after rebooting, identi
firmware and also showing the software version number.

WARNING Do not stop the firmware installation process on the office c
once it has started. Doing so may corrupt the firmware. If th
your GeoExplorer 3 to Trimble for servicing.



selective availability
.SSF file
true north
UTC
UTM
velocity
VTG message

ber waypoint
l GPS WGS-84
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Select a word from the following list to view its definition.

almanac feature MSL
attributes geoid multipath
base station GGA message NAD-27
baud great-circle distance NAD-83
bearing HAE NMEA
carrier phase heading parity
code phase (C/A code) horizon postprocessing
data dictionary ionospheric noise pseudorandom num
datum latitude real-time differentia
declination longitude rover
differential correction magnetic declination RTCM
ellipsoid magnetic north S/A



es orbit information on all the 
. The almanac is stored on the 
ignals when you turn the 
 are trying to regain GPS signals.
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almanac
An almanac is data, transmitted by a GPS satellite, which includ
satellites, clock corrections, and atmospheric delay parameters
GeoExplorer 3. It is used to facilitate rapid acquisition of GPS s
GeoExplorer 3 on, or when you have lost track of satellites and



formation System (GIS). For 
ce type, width, or a number of 
d could have a range of possible 

tribute value. In our example of a 
e of the attribute and ASPHALT 
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attributes
Attributes are the characteristics of a feature in a Geographic In
example a road may have a name or designation number, surfa
lanes. Each of these factors are attributes of the road feature, an
values.

The value chosen to describe a particular feature is called the at
road feature. For example, PINE ROAD could be the name valu
could be the surface type attribute.



nown location specifically to 
ollected at the same time as you 
tions that collect base data for 

own coordinates for the duration 
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base station
A base station is a GPS antenna and receiver positioned on a k
collect data for differential correction. Base data needs to be c
collect data on a rover unit. Base stations can be permanent sta
provision to multiple users, or a rover unit that you locate on kn
of your datalogging session.



nsmissions, generally one bit per 
. However, both the input and 

a to be successfully transferred.
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baud
Baud is a unit used to measure the speed of electronic code tra
second. The higher the baud rate, the faster the transfer of data
output device must be configured to the same baud rate for dat



sured clockwise from north. On 
r current position to the target 
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bearing
A bearing is the direction from one point to another, usually mea
the GeoExplorer 3, the bearing indicates the direction from you
waypoint or feature.



enerated by your GeoExplorer 3 
r phase is used to very 

the accuracy of your position. 
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carrier phase
Carrier phase is the difference between the radio wave signal g
and the radio wave signal coming in from the satellite.The carrie
accurately compute the distance to a satellite, which increases 

GPS satellites transmit on a frequency of 1575.42 MHz.



erated by your GeoExplorer 3 
e. The code phase data is used 
ulate your position.
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code phase (C/A code)
(also known as Course Acquisition code)

The difference between the pseudorandom number code gen
and the pseudorandom number code coming in from the satellit
to quickly compute the distance to a satellite and therefore calc



or a particular project or job. It is 
ute information about these 
, line, and area feature.
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data dictionary
A data dictionary is a description of the objects to be collected f
used in the field to control the collection of the spatial and attrib
objects. The elements of a data dictionary could include a point



eodetic datums are typically 
hip between the center of the 

ll provide a better model in some 
blished to suit particular regions. 

 datum of 1950 (ED-50).

More...
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datum
A datum is a mathematical model of the earths surface. World g
defined by the size and shape of an ellipsoid and the relations
ellipsoid and the center of the earth.

Because the earth is not a perfect ellipsoid any single datum wi
locations than others. Therefore, various datums have been esta
For example, maps in Europe are often based on the european



an datum of 1927 or 1983 (NAD-
atum surface.

al Reference or see

Datum fitting
North America

rface
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Maps in the United States are often based on the North Americ
27, NAD-83). All GPS coordinates are based on the WGS-84 d

For more information refer to the GPS Mapping Systems Gener
Coordinate systems.

Earth’s su

Datum fitting
Europe

EuropeNort
h

Ameri
ca
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declination
See magnetic declination.



lected on a rover with data 
nown location any errors in data 
ry corrections applied to the 

S or after the data has been 
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differential correction
Differential correction is the process of correcting GPS data col
collected simultaneously at a base station. Because it is on a k
collected at the base station can be measured, and the necessa
rover data.

Differential correction can be done in real-time differential GP
collected by postprocessing.



matically modeling the earths 
 major axes. The earths minor 

al Reference or see
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ellipsoid
An ellipsoid is the 3D shape that is used as the basis for mathe
surface. The ellipsoid is defined by the lengths of the minor and
axis is the polar axis and the major axis is the equatorial axis. 

For more information refer to the GPS Mapping Systems Gener
Coordinate systems.

minor
axis

major axis



real world, and which we want to 
an be divided into points, lines 
 is a line feature and a lake is an 
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feature
A feature is a physical object or event that has a location in the 
collect position and/or descriptive information about. Features c
and areas. For example, a water faucet is a point feature, a road
area feature.

Features are defined in a data dictionary.



was projected to extend through 
metrical surface, the geoid 

al Reference or see

Ellipsoid
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geoid
A geoid is a 3D surface representing mean sea level (MSL) if it 
the continents. Unlike an ellipsoid or datum, which have a sym
undulates perpendicular to the force of gravity.

For more information refer to the GPS Mapping Systems Gener
Coordinate systems.

Geoid

Datum



sition, and ’fix’ (type of position) 
s from a GPS datalogger to 
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GGA message
A GGA message is a NMEA message containing GPS time, po
information. GGA messages can be used to pass GPS position
marine navigation equipment.



oints on the surface of a sphere.
GeoExplorer 3 Operation Guide Glossary

great-circle distance
The great-circle distance is the shortest distance between two p



 HAE are actually giving the 
eights are collected in relation to 
ring altitudes in HAE.
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HAE
Height Above Ellipsoid

HAE is a method for referencing altitude. Altitudes expressed in
height above the datum. GPS uses the WGS-84 datum and all h
this surface. It is important to use the same datum when compa



measured clockwise from north.
GeoExplorer 3 Operation Guide Glossary

heading
The heading is the direction you are facing or traveling, usually 
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horizon
The line at which the earth and sky seem to meet.



here is the band of charged 
 above the surface of the earth.
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ionospheric noise
The effects that the ionosphere has on GPS signals. The ionosp
particles 100 to 200 kilometers (60 to 125 miles approximately)



e earth to north or south of the 
longitude coordinate system, 

ed negative. 
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latitude
Latitude is an angular measurement made from the center of th
equator. It comprises the north/south component of the latitude/
which is used in GPS data collection.

Traditionally, north is considered positive, and south is consider



the earth to the East or west of 
st/west component of the 
 collection.

 negative.
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longitude
Longitude is an angular measurement made from the center of 
the Greenwich meridian (London, England). It comprises the ea
latitude/longitude coordinate system, which is used in GPS data

Traditionally, east is considered positive, and west is considered
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magnetic declination
Magnetic declination is the difference between magnetic north a
expressed as an angle and differs between locations.
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magnetic north
Uses the north magnetic pole as the reference to north.
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MSL
Mean Sea Level

MSL is a method of altitude reference. Altitudes expressed in re
height above the geoid.

It is important to use the same geoid when comparing altitudes 
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multipath
Multipath occurs when GPS signals arrive at the datalogger hav
example, this may happen if some signals are reflected off a bu
datalogger. If a signal takes a longer path it will show a larger d
therefore decrease position accuracy.

For more information refer to the GPS Mapping Systems Gener
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NAD-27
North American Datum of 1927. A horizontal datum employing t
values of this era are expressed in NGVD (National Geodetic V



the GRS-80 ellipsoid. Its 
 purposes, the NAD-83 and 
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NAD-83
North American Datum of 1983. A horizontal datum employing 
geometric definition is almost identical to the WGS-84. For GPS
WGS-84 datums are identical.



nics Association (NMEA). The 
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NMEA
NMEA is a standard, established by the National Marine Electro
standard defines electrical signals, data transmission protocol, 
communicating navigation data between marine navigation inst

The GeoExplorer 3 uses these standards to communicate to ma



 error checking that sums the 0’s 
f the bits is changed so that the 

s at message transmission. 

xplorer 3 as on the external 
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parity
A digital message is composed of 0’s and 1’s. Parity is a form of
and 1’s of the digital message. A parity error results when one o
parity calculated at message reception is not the same as it wa
Options for parity checking include even, odd, and none.

Typically you should have the same parity setting on your GeoE
device you are communicating with.



n collected, in order to eliminate 
 rover to data collected at the 

 be determined and removed 
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postprocessing
Postprocessing is the processing of satellite data after it has bee
error. This involves using PC software to compare data from the
base station.

Because the base station is on a known location any errors can
from the rover data.
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that can be exactly reproduced.

 used by the GeoExplorer 3 to 
GeoExplorer 3 Operation Guide Glossary

pseudorandom number
The pseudorandom number (PRN) is the code of 0’s and 1’s tran
appears to be random ’noise’, but is actually a complex pattern 

Each satellite has its own unique PRN code, which together are
calculate code phase (C/A code) positions.



a as you collect it. This is 
 to the datalogger a few seconds 
pplies the corrections to give you 

e (C/A code) positions.
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real-time differential GPS
(also known as real-time differential correction, DGPS)

Real-time differential GPS is the process of correcting GPS dat
achieved by having corrections calculated at a base station sent
in advance via a radio link. As the rover receives the position it a
a very accurate position in the field.

Real-time differential correction is usually applied to code phas



ta in the field, typically at an 
y corrected relative to base 
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rover
A rover is any mobile GPS datalogger collecting or updating da
unknown location. Data collected on a rover can be differentiall
station data.
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RTCM
Radio Technical Commission for Maritime Services (RTCM)

A commission established to define a differential data link for th
of roving GPS receivers. There are two types of RTCM differenti
all Trimble GPS receivers use the newer version 2 RTCM proto
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S/A
See selective availability.
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selective availability
(also known as S/A)

Selective availability is the artificial degradation of the GPS sate
Department of Defense (DoD) to control the accuracy of positio
causes the user to receive a false measurement with up to 100

differential correction techniques can reduce these effects on



PS data from a mapping 
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.SSF file
A Trimble Standard Storage Format (SSF) data file that stores G
receiver.
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true north
Uses the north celestial pole as the reference to north.
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GeoExplorer 3 Operation Guide Glossary

UTC
Universal Time Coordinated.

UTC is a time standard based closely on local solar meantime a
GPS time is directly related to UTC.



ed as UTM, it consists of 60 
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UTM
Universal Transverse Mercator Map Projection.

A special case of the Transverse Mercator projection. Abbreviat
north/south zones, each 6 degrees wide in longitude.



nt direction of travel as well as 
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velocity
Velocity is essentially a measure of speed, that takes into accou
the distance traveled over a period of time.



ed over ground.
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VTG message
An NMEA message containing actual track made good and spe



o attribute information beyond a 
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waypoint
A waypoint is a geographical point that, unlike a feature, holds n
name and location. Typically waypoints are used to denote obje
primary interest, such as a survey mark. Waypoints are most of
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WGS-84
WGS-84 is an abbreviation for World Geodetic System 1984. W
as the datum used by GPS since January 1987.

The WGS-84 datum is based on the ellipsoid of the same nam
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Function keys

Troubleshooting

If GPS positions are not being logged, move 
away from obstructions, wait until more satellites 
are in view, or change the GPS settings to 
include more satellites.

Rebooting
WARNING – A Cold boot will erase all data and 
reset all configurations  to factory defaults!
Warm boot
If the GeoExplorer 3 will not respond: Hold down 
� to turn GeoExplorer 3 off. Turn GeoExplorer 
3 on again.
Cold boot
If still no response repeat warm boot. At the
start-up screen, hold down � and � until 
Formatting Flash Sys appears.

D

C

�� Cancel—close screen and 
abandon changes

�� Menu—display the Main menu

�� Lighten screen display

�� Backlight mode (On/Bright/Off)

�	 Darken screen display

�
 Page up / Pan up

�� Page down / Pan down

�� Home / Pan left

�
 End / Pan right
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Status bar icons

Number of satellites in use.
If number flashes—too few satellites.
If satellite flashes—poor geometry.

GPS positions are real-time corrected. 
Flashes if RTCM signal is lost.

External antenna is connected and in use.

 Some configuration settings are password 
locked.

Memory is low.

The backlight is on.

The bright backlight is on.

Internal power level indicator. “Fills up” 
when charging. Flashes when power level 
is low.

Code precision data logging—the number 
shows how many positions have been 
logged. Flashes when GPS unavailable.

Carrier precision data logging.

Logging is paused. Press � to 
resume.

GPS tab

NOTE – When the skyplot is fixed to North
calibrate the digital compass.

Satellite legend
Black boxes: Satellite used to compute G

positions.
Clear boxes: Satellite tracked but not use
No boxes: Satellite available but not tra
A  Signal strength: Satellites with signal 
strengths below the configured SNR mask
not used.
B  Skyplot: Outer circle shows the horizon.
circle shows the configured elevation mask
Satellites below the elevation mask are no
C  Satellite geometry: GPS quality depen
the geometry (PDOP) of the satellites. If th
quality falls below the cutoff level then GPS
positions will not be computed. 
D  Current position: Displays the current 
position.
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GeoExplorer 3 QuickStart

Part Number: 38598-00-ENG

P tab

Reset

Other

um
/Offset

 tab

e

 tab

ints

Keys

CLOSE Close the current screen
(and save changes)

ENTER Select highlighted item
OPTION Display more functions
SYS Go to / cycle SYS tabs
DATA Go to / cycle DATA tabs
NAV Go to / cycle NAV tabs
Fn Use second key function (blue)

(see Function keys)
LOG Pause/Resume logging
� Power On/Off

CLOSE

CANCEL MENU

OPTION

ENTER

LOG

Fn

SYS NAV

DATA

Next
Moving around the system Section / Tab layout

Tabs

SYS DATA NAV

Sections

� � 	
Press these keys to move between
sections. Multiple presses move to 

the next tab in that section.

�
Press this key to access all functions

for the current screen.

��+��
Press this key combination to display

the Main menu, an overview of all
sections and tabs.

Accessing options

Main menu

�
GPS tab SETUSTATUS tab

Configuration Data
dictionary

Feature
settings

About

Data
GPS

Real-time
Coordinates

Units COMMS

Logging
interval

Accuracy Minim
positions

Formats

NEW tab MAPUPDATE tab

FILE tab

�
Delete filBase station

UPDATE tab

ROAD tab CHARTCOMPASS tab
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